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บทคัดย่อ 

 
  โปรแกรม OpenOffice.org นั้นเป็นซอฟต์แวร์ส าหรับใช้ในการสร้างและแก้ไขงานเอกสาร
แบบโอเพนซอร์ส (Open Source) สามารถใช้ในงานต่างๆ ลักษณะเดียวกันกับโปรแกรมส าหรับงาน
เอกสารเชิงพาณิชย์ยอดนิยมอย่าง Microsoft Office ของไมโครซอฟท์ มีความสามารถในการสร้างไฟล์
เอกสารได้หลายฟอร์แมตและยังสามารถท าการเปิดไฟล์ เอกสารที่สร้างข้ึนจาก Microsoft Office  
เพ่ือท าการแก้ไขและบันทึกกลับได้อย่างไม่มีปัญหาเรื่องความเข้ากันได้ (Compatible) เหมาะส าหรับ
ผู้ใช้งานตามบ้าน และกลุ่มองค์กรหรือบริษัทที่แสวงหาก าไรที่กลัวว่าจะโดนจับเรื่องละเมิดลิขสิทธิ์
ซอฟต์แวร์  การศึกษาค้นคว้าครั้งนี้มีความมุ่งหมาย 1) เพ่ือพัฒนาโปรแกรมบทเรียนออนไลน์   
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร  
คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม ที่มีประสิทธิภาพตามเกณฑ์ 80/80 2) เพ่ือศึกษา
ค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์ 3) เพ่ือศึกษาความพึงพอใจของนิสิตที่มีต่อโปรแกรม
บทเรียนออนไลน์  ที่สร้างขึ้นกลุ่มตัวอย่างที่ใช้ในการศึกษาค้นคว้าครั้งนี้  เป็นนิสิตที่ก าลังศึกษาอยู่ใน
ระดับ ชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัย
มหาสารคาม ภาคเรียนที่ 3 ปีการศึกษา 2556 จ านวน 30 คน ได้มาโดยการเลือกแบบเจาะจง 
(Purposive Sampling) เครื่องมือที่ใช้ในการศึกษาค้นคว้าครั้งนี้ ได้แก่ โปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร 
คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม แบบวัดผลสัมฤทธิ์ทางการเรียน แบบปรนัย 4 
ตัวเลือก จ านวน 30 ข้อ  มีค่าอ านาจจ าแนก (B) ตั้งแต่ 0.13 ถึง 0.80 ค่าความเชื่อม่ัน ทั้งฉบับเท่ากับ 
0.868 และแบบวัดความพึงพอใจ จ านวน 15 ข้อ สถิติท่ีใช้ในการวิเคราะห์ข้อมูลได้แก่ ร้อยละ  
ค่าเฉลี่ยและส่วนเบี่ยงเบนมาตรฐาน 
 ผลการศึกษาค้นคว้าปรากฏดังนี้ 
  1. โปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม  
ที่ผู้ศึกษาค้นคว้าได้สร้างขึ้นมีประสิทธิภาพ 84.14/81.22 
  2. โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม  
ที่ผู้ศึกษาค้นคว้าได้สร้างขึ้น มีค่าดัชนีประสิทธิ เท่ากับ 0.574 
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  3. นิสิตมีความพึงพอใจต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org  นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ 
มหาวิทยาลัยมหาสารคาม มีความพึงพอใจอยู่ในระดับมาก 
 โดยสรุป โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม  
มีประสิทธิภาพและประสิทธิผลเหมาะสม สามารถน าไปใช้ในการเรียนการสอนหรือการฝึกอบรมได้เป็น
อย่างดี จึงควรส่งเสริมให้มีการพัฒนาโปรแกรมบทเรียนออนไลน์ให้หลากหลาย รูปแบบ  
เพ่ือให้เหมาะสมกับการเรียนสอนหรือการฝึกอบรมในวิชาต่างๆ ให้มากขึ้น 
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บทที่ 1 
 

บทน า 
 

ภูมิหลัง 
 

 การศึกษาของประเทศไทยในปัจจุบันก าลังก้าวเข้าสู่การน าเทคโนโลยีมาใช้เพ่ือการเรียน  
การสอนกันมากขึ้น เพ่ือให้สอดรับกับการเป็นยุคเทคโนโลยีสารสนเทศ แต่ก็ต้องไม่ลืมว่าสิ่งเหล่านั้น 
เป็นเพียงแค่เครื่องมือที่จะตอบสนองความต้องการในการเรียนรู้ของมนุษย์  เป็นเพียงแค่เครื่องมือที่จะท า
ให้มนุษย์เข้าถึงแหล่งการเรียนรู้ต่างๆ ได้ง่าย และรวดเร็วขึ้นเท่านั้น สิ่งส าคัญท่ีสุดที่ควรค านึงถึงก็คือ  
การบรรลุเป้าหมายของการศึกษา ซึ่งก็คือการพัฒนาทรัพยากรมนุษย์ให้เป็นบุคคลที่มีคุณภาพของ
ประเทศนั่นเอง ระบบการศึกษาของประเทศไทย ก็ก าลังเปลี่ยนแปลงไปตามการเปลี่ยนแปลงของ
เทคโนโลยี และการเปลี่ยนแปลงระบบการจัดการศึกษาของโลก ซึ่งก าลังมุ่งสู่การศึกษาท่ีอาศัย
เทคโนโลยีใหม่ ๆ นี้เป็นสื่อกลาง เช่น เทคโนโลยีคอมพิวเตอร์ เทคโนโลยีการสื่อสาร เทคโนโลยีดิจิตอล 
เป็นต้น สถานศึกษาต่าง ๆ ในประเทศท้ังในระดับโรงเรียน วิทยาลัย และมหาวิทยาลัย ต่างก็มีการเข้าไป
เกี่ยวข้องกับการจัดการศึกษารูปแบบใหม่โดยเกี่ยวข้องกับเทคโนโลยีใหม่นี้ด้วย เช่น การใช้คอมพิวเตอร์
เข้ามาท าหน้าที่สนับสนุนการเรียนการสอน หรือ ให้ศึกษาจากคอมพิวเตอร์ และจากอินเทอร์เน็ต  
(ส านักเทคโนโลยีการศึกษา.    2550  :  45) 
 จากแผนแม่บทเทคโนโลยีสารสนเทศและการสื่อสารเพ่ือการศึกษาของกระทรวงศึกษาธิการ  
พ.ศ. 2550 – 2554 ได้ก าหนดวิสัยทัศน์ให้ผู้เรียน ผู้สอน บุคลากรทางการศึกษาและประชาชน 
ใช้ประโยชน์จากเทคโนโลยีสารสนเทศและการสื่อสาร(Information and Communication 
Technology: ICT) ในการเข้าถึงบริการทางการศึกษาได้เต็มศักยภาพอย่างมีจริยธรรมและมีสมรรถนะ
ทาง ICT ตามมาตรฐานสากลโดยก าหนดยุทธศาสตร์ที่ส าคัญในการขับเคลื่อนได้แก่ การสร้างโอกาส 
เพ่ิมขีดความสามารถและยกระดับมาตรฐานการเรียนรู้ด้วยสื่ออิเล็กทรอนิกส์  (e-Learning)  
การเป็นผู้น าในการใช้ ICT เพ่ิมประสิทธิภาพการบริหารจัดการและการให้บริการทางการศึกษา  
(e-Management) และการผลิตและเสริมสร้างศักยภาพทรัพยากรบุคคลด้าน ICT (e-Manpower) 
ดังนั้นการบริหารและพัฒนาก าลังคนภาครัฐเพื่อให้สามารถตอบสนองต่อปรากฏการณ์ของ 
การเปลี่ยนแปลงและสอดคล้องกับนโยบายและแผนแม่บทดังกล่าวได้นั้น ปัจจัยส าคัญในการขับเคลื่อน 
ก็คือท าอย่างไรจึงจะท าให้นิสิต นักศึกษา สามารถใช้เทคโนโลยีได้อย่างรู้เท่าทัน และใช้อย่าง 
มีวิจารณ์ญาณ (กระทรวงศึกษาธิการ.    2550  :  1-6) 
 นอกจากนั้นในแผนแม่บทเทคโนโลยีสารสนเทศและการสื่อสาร (ฉบับที่ 2) ได้มีการก าหนด
วิสัยทัศน์ “ประเทศไทยเป็นสังคมอุดมปัญญา (Smart Thailand) ด้วย ICT” สังคมท่ีมีการพัฒนาและ 
ใช้เทคโนโลยีสารสนเทศและการสื่อสารอย่างชาญฉลาด โดยใช้แนวปฏิบัติของปรัชญาเศรษฐกิจพอเพียง 
ประชาชนทุกระดับมีความเฉลียวฉลาด (Smart) และรอบรู้สารสนเทศ (Information literacy) 
สามารถเข้าถึง และใช้สารสนเทศอย่างมีคุณธรรม จริยธรรม มีวิจารณญาณและรู้เท่าทัน ก่อให้เกิด
ประโยชน์แก่ตนและสังคม มีการบริหารจัดการเทคโนโลยีสารสนเทศและการสื่อสารที่มีธรรมาภิบาล 
(Smart Governance) เพ่ือสนับสนุนการพัฒนาสู่เศรษฐกิจและสังคมฐานความรู้และนวัตกรรม 
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อย่างยั่งยืนและมั่นคง นอกจากนั้นยังได้ก าหนด ยุทธศาสตร์ไว้เพื่อการพัฒนาอีก 6 ยุทธศาสตร์  
โดยมียุทธศาสตร์ที่ 1 การพัฒนาก าลังคนด้าน ICT และบุคคลทั่วไปให้มีความสามารถในการสร้างสรรค์ 
ผลิต และใช้สารสนเทศอย่างมีวิจารณญาณและรู้เท่าทัน ในยุทธศาสตร์นี้ได้มีมาตรการส าคัญ 
ในการพัฒนาบุคลากรด้าน ICT คือ การปรับปรุงรูปแบบ/วิธีการในการจัดการเรียนการสอนใน
สถาบันการศึกษาระดับอาชีวะศึกษาและอุดมศึกษา ส่งเสริมการเรียนการสอนซอฟต์แวร์โอเพนซอร์ส 
(open source software) ในหลักสูตรของสถาบันการศึกษาและส่งเสริมการน าซอฟต์แวร์โอเพนซอร์
สมาเป็นเครื่องมือในการเรียน การสอน และการวิจัยต่อยอดในสถาบันการศึกษา เพ่ือพัฒนาทักษะใน
การพัฒนาซอฟต์แวร์ ทักษะในการวิจัยและพัฒนาซอฟต์แวร์โอเพนซอร์ส ส่งเสริมให้เกิดนักพัฒนารุ่น
ใหม่ และการพัฒนาต่อยอด จากความร่วมมือของนักพัฒนาทั่วโลกที่มาร่วมกันท างาน ซ่ึงยุทธศาสตร์นี้
ให้ความส าคัญในการส่งเสริมการเรียนการสอนซอฟต์แวร์โอเพนซอร์ส (open source software)  
ในหลักสูตรของสถาบันการศึกษานอกจากนั้นในหน่วยงานทั้งภาครัฐและเอกชนก็มีการส่งเสริมให้ใช้
ซอฟต์แวร์ที่ถูกกฎหมาย หรือ เป็นซอฟต์แวร์ประเภท Open score เพ่ือขจัดปัญหาเรื่องการละเมิด
ลิขสิทธิ์ ซึ่งหลายหน่วยงานก็มีการส่งเสริมเป็นอย่างมาก เช่น บมจ.กสท. โทรคมนาคม, บมจ.ทีโอที, 
ส านักงานส่งเสริมอุตสาหกรรมซอฟต์แวร์แห่งชาติ (องค์กรมหาชน) หรือซิป้า, บริษัท ไปรษณีย์ไทย 
จ ากัด (กระทรวงเทคโนโลยีสารสนเทศและการสื่อสาร.    2552  :  58-63)  
 ซอฟต์แวร์หรือโปรแกรมคอมพิวเตอร์คือสิ่งที่ได้รับความคุ้มครองภายใต้พระราชบัญญัติ
ลิขสิทธิ์ พ.ศ. 2537 (“พ.ร.บ. ลิขสิทธิ์”) โดยจัดเป็นงานอันมีลิขสิทธิ์ประเภทงานวรรณกรรม (Literary 
work) ตาม พ.ร.บ. ลิขสิทธิ์ ก าหนดว่า โปรแกรมคอมพิวเตอร์ หมายถึง ค าสั่ง ชุดค าสั่ง หรือสิ่งอ่ืนใดที่
น าไปใช้กับคอมพิวเตอร์ เพ่ือให้เครื่องคอมพิวเตอร์ท างานหรือให้ได้ผลอย่างหนึ่งอย่างใด ในกรณีที่ บุคคล
ใด ท าซ้ า ดัดแปลง เผยแพร่ต่อสาธารณชน หรือให้เช่าต้นฉบับหรือส าเนาของโปรแกรมคอมพิวเตอร์ 
บุคคลนั้นจะมีความผิดฐานละเมิดลิขสิทธิ์ซอฟต์แวร์ มีโทษปรับตั้งแต่ 20,000 บาทถึง 200,000 บาท 
และหากเป็นการกระท าเพ่ือการค้า จะต้องโทษจ าคุกตั้งแต่ 6 เดือน ถึง 4 ปี หรือปรับตั้งแต่ 100,000 
ถึง 800,000 บาท หรือทั้งจ าทั้งปรับหากผู้ใดรู้หรือมีเหตุอันควรรู้ว่าโปรแกรมคอมพิวเตอร์นั้นท าข้ึน 
โดยละเมิดลิขสิทธิ์ผู้อื่น แต่ยังน าไปขาย มีไว้เพื่อขาย เสนอขาย ให้เช่า เสนอให้เช่า ให้เช่าซื้อ เผยแพร่ต่อ
สาธารณชน แจกจ่ายในลักษณะที่อาจก่อให้เกิดความเสียหายแก่เจ้าของลิขสิทธิ์ น าเข้าหรือสั่งเข้ามา 
ในประเทศไทย เพื่อหาก าไร ก็มีความผิดฐานละเมิดลิขสิทธิ์ โดยมีโทษปรับตั้งแต่ 10,000 บาท ถึง 
100,000 บาทและหากเป็นการท าเพ่ือการค้าผู้นั้นจะต้องโทษจ าคุกตั้งแต่ 3 เดือน ถึง 2 ปี หรือ 
ปรับตั้งแต่ 50,000 บาทถึง 400,000 บาท หรือทั้งจ าทั้งปรับ นอกเหนือจากการแก้ไขบรรเทาความ
เสียหายในคดีอาญาแล้ว เจ้าของลิขสิทธิ์ยังสามารถฟ้องร้องด าเนินคดีแพ่ง ในกรณีการละเมิดลิขสิทธิ์ใน
ซอฟต์แวร์ภายใต้ พ.ร.บ.ลิขสิทธิ์หากศาลพบว่ามีการกระท าความผิดจริงอาจมีค าห้ามมิให้กระท าละเมิด
อีกต่อไป และมีค าสั่งให้ช าระค่าสินไหมทดแทนส าหรับความเสียหายที่เกิดข้ึนจริงอันเนื่องจากการละเมิด
ดังกล่าว (พระราชบัญญัติลิขสิทธิ์ พ.ศ. 2537.    2537)  
  โปรแกรม OpenOffice.org นั้นเป็นซอฟต์แวร์ส าหรับใช้ในการสร้างและแก้ไขงานเอกสาร
แบบโอเพนซอร์ส (Open Source) สามารถใช้ในงานต่างๆ ลักษณะเดียวกันกับโปรแกรมส าหรับงาน
เอกสารเชิงพาณิชย์ยอดนิยมอย่าง Microsoft Office ของไมโครซอฟท์ มีความสามารถในการสร้างไฟล์
เอกสารได้หลายฟอร์แมตและยังสามารถท าการเปิดไฟล์ เอกสารที่สร้างข้ึนจาก Microsoft Office  
เพ่ือท าการแก้ไขและบันทึกกลับได้อย่างไม่มีปัญหาเรื่องความเข้ากันได้ (Compatible) เหมาะส าหรับ
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ผู้ใช้งานตามบ้าน และกลุ่มองค์กรหรือบริษัทที่แสวงหาก าไรที่กลัวว่าจะโดนจับเรื่องละเมิดลิขสิทธิ์
ซอฟต์แวร์ เพราะตอนนี้ประเทศไทยเราก าลังเข้มงวดตรวจจับกันเป็นที่เข้มงวดซึ่ง OpenOffice ได้ผ่าน
การพัฒนามายาวนานจนปัจจุบันสามารถเข้าไปใช้งานทดแทน  Microsoft Office ได้แทบทุกเวอร์ชัน 
OpenOffice.org ยังสามารถท าการบันทึกไฟล์เอกสารในฟอร์แมต PDF ซึ่งเป็นที่นิยมใช้งานกันอย่าง
กว้างขวางเพ่ือการพิมพ์และเผยแพร่ในอินเทอร์เน็ตได้ทันทีโดยไม่ต้องท าการติดตั้งโปรแกรมเสริมใดๆ   
ที่ส าคัญ OpenOffice.org นั้นเป็นซอฟต์แวร์แบบโอเพนซอร์สสามารถใช้ได้ฟรีภายใต้ไลเซนส์แบบ 
LGPL v3 โดยไม่ต้องเสียค่าใช้จ่ายใดๆ ทั้งสิ้น รองรับการใช้งานได้ตั้งแต่การใช้งานในแบบส่วนบุคคล  
ในบริษัทขนาดเล็ก ในสถานศึกษาตั้งแต่ระดับประถม ระดับมัธยม จนถึงระดับมหาวิทยาลัย หรือแม้ 
แต่การใช้งานในบริษัทขนาดใหญ่ที่ต้องการลดค่าใช้จ่ายในการซื้อ ซอฟต์แวร์ส าหรับใช้ในงานด้าน
เอกสาร  (วิไลภรณ์ ศรีไพศาล.    2553  :  5-7) 
 การเรียนการสอนบนเว็บ (Web – Based Intruction) โดยรวมหมายถึง การใช้โปรแกรมสื่อ
หลายมิติ ที่อาศัยประโยชน์จากคุณลักษณะและทรัพยากรของอินเตอร์เน็ต และเวิลด์ไวด์เว็บมา
ออกแบบเป็นเว็บเพื่อการเรียนการสอน สนับสนุนและส่งเสริมให้เกิดการเรียนรู้อย่างมีความหมาย
เชื่อมโยงเป็นเครือข่ายที่สามารถเรียนได้ทุกที่ทุกเวลา โดยมีลักษณะที่ผู้สอนและผู้เรียนมีปฏิสัมพันธ์กัน
โดยผ่านระบบเครือข่ายคอมพิวเตอร์ที่เชื่อมโยงซึ่งกันและกัน ประโยชน์ของการเรียนการสอนบนเว็บที่
เป็นมิติใหม่ของเครื่องมือและกระบวนการในการเรียนการสอน ที่ส าคัญได้แก่ 1) ผู้เรียนสามารถเรียนได้
ทุกแห่งที่มีอินเทอร์เน็ตติดตั้งอยู่ 2) ผู้เรียนสามารถเรียนได้ โดยไม่ท าให้งานในหน้าที่เสียหาย 3) ไม่ต้อง
เสียค่าใช้จ่ายอื่นเพ่ิมเติม เช่นค่าที่พัก ค่าเดินทาง 4) ผู้เรียนสามารถเรียนได้ตลอด 24 ชั่วโมง  
5) การจัดการเรียนการสอนหรือการฝึกอบรมมีลักษณะที่ผู้เรียนเป็นศูนย์กลางการเรียนรู้เกิดกับตัว
ผู้เรียนโดยตรง 6) การเรียนรู้เป็นไปตามความก้าวหน้าของผู้เรียนเอง 7) ผู้เรียนสามารถทบทวนบทเรียน
และเนื้อหาได้ตลอดเวลา 8) สามารถซักถามหรือเสนอแนะได้ด้วยเครื่องมือบนเว็บไซด์ 9) สามารถ
แลกเปลี่ยนข้อคิดเห็นระหว่างผู้เรียนได้ โดยใช้เครื่องมือสื่อสารในระบบอินเทอร์เน็ต ทั้งไปรษณีย์
อิเล็กทรอนิกส์(E-Mail) หรือห้องสนทนา (Chat Room) หรืออ่ืนๆ 10) ไม่มีพิธีการมาก  
(ไชยยศ  เรืองสุวรรณ.    2554  :  24 - 26) 
 จากเหตุผลและปัญหาดังที่กล่าวมา ผู้วิจัยจึงได้ตระหนักถึงความส าคัญในการที่พัฒนา
ก าลังคนด้าน ICT ให้หันมาใช้ ซอฟต์แวร์ ประเภท Open source และส่งเสริมการเรียนการสอน
ซอฟต์แวร์โอเพนซอร์ส (open source software) ในหลักสูตรของสถาบันการศึกษาให้มากข้ึน ดังนั้น
จึงมีความสนใจในการพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ Openoffice.org 
เพ่ือเป็นการกระตุ้นให้ผู้เรียนเกิดความสนใจในเนื้อหาวิชา และพัฒนาการเรียนการสอนให้เหมาะสมกับ
ผู้เรียนให้เกิดประสิทธิภาพมากที่สุดโดยผู้เรียนสามารถเข้าไปศึกษาผ่านระบบออนไลน์และทบทวน
เนื้อหาที่เรียนได้ตลอดเวลาและสามารถตอบสนองความต้องการในการจัดการเรียนการสอนได้เป็นอย่าง
ดี เพราะผู้เรียนสามารถที่จะศึกษาได้ด้วยตัวเอง และเป็นประโยชน์ต่อการน าไปประยุกต์ใช้ในการศึกษา
ครั้งต่อไป 
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ความมุ่งหมายของการศึกษาค้นคว้า 
 
 1. เพ่ือพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้น 
ปีที่ 1 ให้มีประสิทธิภาพตามเกณฑ์ 80/80 
 2. เพ่ือศึกษาค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org นิสิตชั้นปีที่ 1 ที่ผู้ศึกษาค้นคว้าได้พัฒนาขึ้น 
 3. เพ่ือศึกษาความพึงพอใจของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
 
ความส าคัญของการศึกษาค้นคว้า 
 
 1. ได้โปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1   
ที่มีประสิทธิภาพตามเกณฑ์ 80/80 
 2. เป็นแนวทางในการพัฒนาโปรแกรมบทเรียนออนไลน์ ในรายวิชาอ่ืนๆ ต่อไป 
 
ขอบเขตของการศึกษาค้นคว้า 
 
 1. ประชากรและกลุ่มตัวอย่าง 
  1.1 ประชากรที่ใช้ในการศึกษาครั้งนี้ เป็นนิสิตที่ก าลังศึกษาอยู่ในระดับชั้นปีที่ 1  
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม  
ปีการศึกษา 2556  จ านวน  2  กลุ่ม  60 คน 
  1.2 กลุ่มตัวอย่างท่ีใช้ในการศึกษาค้นคว้าครั้งนี้ เป็นนิสิตที่ก าลังศึกษาอยู่ในระดับชั้นปีที่ 1 
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม  
ปีการศึกษา 2556 กลุ่มท่ี 2 จ านวน 30 คน ได้มาโดยการเลือกแบบเจาะจง (Purposive Sampling) 
เนื่องจากเป็นนักศึกษาที่มีผลสัมฤทธิ์ทางการเรียนไม่แตกต่างกัน 
 2. เนื้อหาที่ใช้ในการศึกษาค้นคว้า 
เนื้อหาที่น ามาใช้ในโปรแกรมบทเรียน ที่ใช้ในการศึกษาค้นคว้าครั้งนี้อยู่ในคู่มือ การใช้งานโปรแกรม 
OpenOffice.org ซึ่งแบ่งเนื้อหาเป็น 5 เรื่อง ประกอบด้วย 
  2.1 หน่วยที่ 1 เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0 
   2.2 หน่วยที่ 2 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer 
   2.3 หน่วยที่ 3 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Impress 
   2.4 หน่วยที่ 4 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc 
   2.5 หน่วยที่ 5 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base 
 3. ระยะเวลาที่ใช้ในการทดลอง คือ ช่วงเดือนเมษายน – พฤษภาคม วันที่ใช้ทดลองจริงกับ
กลุ่มตัวอย่าง คือ วันที่ 21 – 22 พฤษภาคม 2557  ปีการศึกษา 3/2556 
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นิยามศัพท์เฉพาะ 
 
 1. บทเรียนออนไลน์ หมายถึง โปรแกรมบทเรียนที่ใช้เครื่องคอมพิวเตอร์เป็นสื่อในการเรียน 
การสอน ที่ช่วยให้ผู้เรียนได้เรียนรู้เนื้อหาวิชาต่างๆ ทางระบบเครือข่ายอินเตอร์เน็ตได้ด้วยตนเอง 
โดยใช้เป็นสื่อเสริม  
 2. การพัฒนาโปรแกรมบทเรียน หมายถึง คุณภาพของโปรแกรมบทเรียน  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  ที่จะท าให้ผู้เรียนเกิดการเรียนรู้ตามเกณฑ์ 80/80 
  2.1 80 ตัวแรก หมายถึง ประสิทธิภาพของกระบวนการได้มาจากคะแนนเฉลี่ย 
จากแบบทดสอบย่อยท้ายหน่วยการเรียน 
  2.2 80 ตัวหลัง หมายถึง ประสิทธิภาพของผลลัพธ์ ได้มาจาก คะแนนเฉลี่ยจาก
แบบทดสอบหลังเรียน 
 3. ดัชนีประสิทธิผลของโปรแกรมบทเรียน หมายถึง ค่าตัวเลขท่ีเปรียบเทียบคะแนน
ความก้าวหน้าในการเรียนของผู้เรียนด้วยโปรแกรมบทเรียน เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
ที่ผู้ศึกษาค้นคว้าพัฒนา ขึ้นโดยเปรียบเทียบจากค่าความแตกต่างระหว่างคะแนนแบบทดสอบก่อนเรียน
และหลังเรียน 
 4. ความพึงพอใจของผู้เรียน หมายถึง ความรู้สึกในทางบวก ความรู้สึกชอบ หรือ ความรู้สึก 
ที่ดีของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียน เรื่อง การใช้ซอฟต์แวร์ openoffice.org ที่ได้จาก
การวัดด้วยแบบวัดความพึงพอใจ 
 5. โปรแกรม OpenOffice.org หมายถึง ซอฟต์แวร์ส าหรับใช้ในการสร้างและแก้ไขงาน
เอกสารแบบโอเพนซอร์ส (Open Source) สามารถใช้ในงานต่างๆ ลักษณะเดียวกันกับโปรแกรม 
ส าหรับงานเอกสารเชิงพาณิชย์ยอดนิยมอย่าง Microsoft Office ของไมโครซอฟท์ มีความสามารถ 
ในการสร้างไฟล์เอกสารได้หลายฟอร์แมตและยังสามารถท าการเปิดไฟล์ เอกสารที่สร้างข้ึน 
จาก Microsoft Office เพ่ือท าการแก้ไขและบันทึกกลับได้อย่างไม่มีปัญหา 
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บทที่ 2 
 

เอกสารและงานวิจัยที่เกี่ยวข้อง 
 
 ในการศึกษาค้นคว้า การพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org  นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ 
มหาวิทยาลัยมหาสารคาม โดยมีทฤษฎี เอกสาร งานการศึกษาค้นคว้าและงานวิจัยที่เกี่ยวข้องตามล าดับ 
ดังนี้ 
  1. ซอฟต์แวร์ openoffice.org   
  2. การฝึกอบรม 
  3. ทฤษฎีบทเรียนคอมพิวเตอร์ช่วยสอนตามแนวคิดของ กานเย่ 
  4. เครือข่ายอินเทอร์เน็ตและบทเรียนออนไลน์  
  5. การหาประสิทธิภาพ 
  6. การหาดัชนีประสิทธิผล 
  7. ความพึงพอใจในการเรียนรู้ 
  8. งานวิจัยที่เกี่ยวข้อง 
   8.1 งานวิจัยในประเทศ 
   8.2 งานวิจัยต่างประเทศ 
 
ซอฟต์แวร์ openoffice.org  
 
 วิไลภรณ์ ศรีไพศาล  (2553  :  5-9) Openoffice.org เป็นชุดโปรแกรมส าเร็จรูปด้าน
ส านักงานที่มีความสามารถครบถ้วน โดยประกอบไปด้วย Writer โปรแกรมด้านประมวลผลค า, 
Calc โปรแกรมด้านตารางค านวณ, Impress โปรณกรมด้านการน าเสนอ, Base โปรแกรมสร้างและ
จัดการฐานข้อมูล ซึ่งสามารถท างานกับภาษาไทยได้อย่างสมบูรณ์ และใช้งานร่วมกับเอกสาร
ไมโครซอฟท์ออฟฟิศได้เป็นอย่างดี 
 ข้อดีของโปรแกรม openoffice.org อีกประการหนึ่งก็คือเราสามารถดาวน์โหลดมาใช้งานได้
ฟรี และเป็นซอฟท์แวร์ประเภท OpenSource คือมีการแจกซอร์สโค้ดของโปรแกรมออกไปให้พัฒนาได้
อย่างอิสระ 
  1. ผลิตภัณฑ์ในชุด Openoffice.org  
   โปรแกรมหลักในชุด Openoffice.org จะคล้ายกับในชุดส านักงานอ่ืน ๆ  
เช่น โปรแกรมด้านการประมวลผลค า โปรแกรมตารางค านวณ  โปรแกรมน าเสนองาน โปรแกรมสร้าง
และจัดการฐานข้อมูล  โดยมีรายละเอียดเบื้องต้นของแต่ละโปรแกรมดังนี้ 
  2. โปรแกรม Openoffice.org Writer 
   เป็นโปรแกรมประมวลผลค า (Word processing) ส าหรับสร้างงานเอกสาร  
เช่น การท ารายงาน การเขียนจดหมาย การจดบันทึก โบรชัวร ์และจดหมายข่าว ซึ่งมีฟังก์ชั่น 
การประมวลผลค ามากมายพร้อมการตรวจสอบค าสะกด การตัดค าเม่ือสิ้นสุดบรรทัด และแก้ค าผิดให้
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ถูกต้องอย่างอัตโนมัติ สนับสนุนการท างานเอกสารร่วมกันเป็นทีม หรอืสามารถสร้างเว็บไซต์ส่วนตัวได้
โดยที่ไมจ่ าเป็นต้องมีความรู้ภาษา HTML แต่โปรแกรม Openoffice.org Writer ยังสามารถท างาน
ร่วมกับเอกสารที่สร้างขึ้นด้วยไมโครซอฟท์ Word ได้ คือ สามารถเปิดอ่าน แก้ไข เอกสาร และ 
บนัทึกกลับได้ 
  3. โปรแกรม Openoffice.org Impress 
   เป็นโปรแกรมน าเสนองาน (Presentation) ที่ใช้งานง่าย ช่วยให้เราสร้างงานพรีเซน
เตชั่นได้อย่างง่าย ๆ ด้วยเครื่องมอืต่าง ๆ ในการวาดภาพ เขียนแผนผัง รองรับรูปแบบมัลติมีเดีย 
อย่างสมบูรณ์ โปรแกรม Openoffice.org Impress ยังสามารถท างานร่วมกับพรเีซนเตชั่นที่สร้างขึ้น
ด้วยไมโครซอฟท์ PowerPoint ได้ คือ สามารถเปิดอ่านแก้ไขเอกสาร และบันทึกกลับได้ 
  4. โปรแกรม Openoffice.org Calc 
   เป็นโปรแกรมตารางการค านวณและการวิเคราะห์ (Spreadsheet) เราสามารถใช้
แผนภูมิของ Openoffice.org Calc และเครื่องมือในการวิเคราะห์เพื่อใช้ส าหรับการตัดสินใจ รวมไปถึง
ข้อมูลทางธุรกิจด้วยระบบสนับสนุนฐานข้อมูลที่ถูกรวมไว้ด้วยโปรแกรม Openoffice.org Calc  
ยังสามารถท างานร่วมกับตารางงานที่สร้างขึ้นด้วยไมโครซอฟท์ Excel ได้ คือ สามารถเปิดอ่าน  
แก้ไข เอกสาร และบันทึกกลับได้ 
  5. โปรแกรม Openoffice.org Base 
   เป็นโปรแกรมท่ีท าให้เราสามารถสร้างและจัดการฐานข้อมูลได้อย่างง่ายดาย  
เราสามารถเข้าถึงและวิเคราะห์ข้อมูลจ านวนมาก สร้างรายงานที่ซับซ้อนหรือท าจดหมายเวียน 
จากฐานข้อมูลลูกค้า รวมทั้งการเชื่องต่อกับฐานข้อมูลภายนอก  เช่น MySQL ได้ด้วย 
  6. ใช้งาน OpenOffice.org แทน Microsoft Office  

 
ตาราง 1 โปรแกรมต่างในชุด OpenOffice.org เปรียบเทียบกับโปรแกรมในชุด Microsoft Office 

 
ประเภทโปรแกรม OpenOffice.org Microsoft Office 
ประมวลผลค า (word processor) 
น าเสนองาน (Presentation) 
ตารางงาน (Spreadsheet) 
ฐานข้อมูล (Database) 

Openoffice.org Writer 
Openoffice.org Impress 
Openoffice.org Calc 
Openoffice.org Base 

Microsoft word 
Microsoft PowerPoint 
Microsoft Excel 
Microsoft Access 

 
  7. นามสกุลไฟล์ที่ OpenOffice.org ใช้ได้ 
   Openoffice.org จะใช้นามสกุลไฟล์แบบมาตรฐานที่เรียกว่า ODF (OpenDocument 
Format) ที่ถูกสร้างโดยองค์กร OASIS (Organization for the Advancement of Structured 
Information Standards) ซึ่งรองรับมาตรฐาน ISO 26300 
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ตาราง 2 นามสกุลไฟล์ที่ OpenOffice.org ใช้ได ้
  

ประเภทโปรแกรม OpenOffice.org นามสกุลไฟล์ 
ประมวลผลค า 
น าเสนองาน 
ตารางงาน 
ฐานข้อมูล 

Openoffice.org Writer 
Openoffice.org Impress 
Openoffice.org Calc 
Openoffice.org Base 

.odt (Open Document Text) 

.odp (Open Document 
presentation) 
.ods (Open Document Spreadsheet) 
.odb (Open Document Base) 

 
  8. ท างานแทน Microsoft Office ได้ไม่มีปัญหา 
   ทุกโปรแกรมนั้นสามารถเปิดแก้ไข และบันทึกไฟล์เป็นนามสกุลที่ใช้กับโปรแกรม 
Microsoft Office 2003 ได้ โดย Openoffice.org 3.2 รุ่นล่าสุดรองรับการเปิดและแก้ไขเอกสารที่
สร้างจาก Microsoft Office 2007 ด้วย แต่ยังต้องเซฟไฟล์กลับเป็น Microsoft Office รุ่นก่อน  
(รุ่น 2003) หรือเซฟกลับเป็นไฟล์นามสกุลมาตรฐานที่ Openoffice.org ใช้  
 สรุปได้ว่า  การน าซอฟต์แวร์ที่อนุญาตให้ใช้งานได้ฟรีโดยไม่เสียค่าใช้จ่ายอย่าง Open-
Office.org มาใช้ทดแทนซอฟต์แวร์เชิงพาณิชย์ที่เป็นที่นิยมอย่าง Microsoft Office นั้น แม้ว่าการใช้
งานอาจจะยากหรือไม่คุ้นเคยบ้าง แต่ก็ไม่ล าบากนักท่ีจะปรับตัว ผลงานที่ได้ก็ไม่ด้อยกว่า Microsoft 
Office และสามารถใช้งานร่วมกับ Microsoft Office อย่างไม่มีปัญหา นอกจากอาจต้องแก้ไขรูปแบบ
ของเอกสารเพียงเล็กน้อยเท่านั้น   
 
การฝึกอบรม 
 
 การพัฒนาบุคลากรให้มีประสิทธิภาพในการท างาน โดยอาศัยกระบวนการและเทคนิคต่างๆ 
เพ่ือให้เกิดการเปลี่ยนแปลงที่ดีและมีประสิทธิภาพยิ่งขึ้นกับบุคคลนั้น เช่น การฝึกอบรมการปฐมนิเทศ 
การศึกษาต่อ เป็นต้น ซึ่งกระบวนการเหล่านี้จะก่อให้เกิดการพัฒนาคน พัฒนางาน ซึ่งปัจจุบันเป็นที่
ยอมรับกันว่าวิธีการพัฒนาบุคลากรที่ส าคัญท่ีสุดและน ามาใช้อย่างแพร่หลาย คือ การฝึกอบรม  
อันเป็นกระบวนการที่ส าคัญที่สุดที่ก่อให้เกิดประสิทธิภาพสูงสุดต่อหน่วยงาน 
  1. ความหมายของการฝึกอบรม 
   การฝึกอบรม เป็นวิธีการอย่างหนึ่ง เพ่ือปรับปรุงพัฒนาประสิทธิภาพในด้านต่างๆ  
ของบุคคล ซึ่งมีนักวิชาการและนักการศึกษาหลายท่านได้ให้ความหมายของการฝึกอบรมไว้  ดังนี้ 
    วิจิตร  อาวะกุล (2550  :  15) ได้ให้ความหมายว่า การฝึกอบรม หมายถึง 
กระบวนการเพ่ิมความรู้ความช านาญและความสามารถของบุคคลหรือท่ีเรียกอีกอย่างหนึ่งว่า   
เป็นการพัฒนาบุคคลหรืออาจกล่าวได้ว่า การฝึกอบรม ก็คือ กระบวนการที่จะส่งเสริมสมรรถภาพบุคคล 
(พนักงาน ข้าราชการ)  ให้สามารถปฏิบัติหน้าที่ได้อย่างมีประสิทธิภาพอันจะส่งผลโดยตรงไปยังผลงาน
ของสถาบัน สังคม ประชาชน 
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    ศักรินทร์  ชนประชา  (2550  :  73) ได้ให้ความหมายว่า การฝึกอบรม หมายถึง 
กระบวนการที่จัดขึ้นอย่างมีระบบ  เพ่ือเพ่ิมประสิทธิภาพการท างานของบุคคล โดยมุ่งที่จะเพ่ิมพูน
ความรู้ ทักษะ และเจตคติของบุคคล  เพ่ือที่จะสามารถปฏิบัติงานได้ดียิ่งข้ึน  ซึ่งจะน าไปสู่การพัฒนา
และเพ่ิมผลผลิต ท าให้เกิดผลส าเร็จตามเป้าหมายขององค์กรที่ก าหนดไว้  
    ชาญ  สวัสดิ์สาล ี (2552  :  15) ได้ให้ความหมายว่า การฝึกอบรม หมายถึง 
กระบวนการที่เป็นระบบ ที่จะช่วยเพิ่มพูนความรู้ ความสามารถและทักษะในการปฏิบัติงาน รวมถึง 
การเปลี่ยนแปลงทัศนคติ และพฤติกรรมในการปฏิบัติงานของบุคคล (ผู้ปฏิบัติงาน) ให้ดีขึ้น ทั้งนี ้ 
เพ่ือให้บุคคลนั้นสามารถปฏิบัติงาน ที่อยู่ในความรับผิดชอบได้อย่างมีประสิทธิภาพและประสิทธิผลมาก
ยิ่งขึ้น อันจะเป็นประโยชน์ต่อ “งาน” ที่รับผิดชอบในปัจจุบันหรืองานที่ก าลังจะได้รับมอบหมายให้ท าใน
อนาคตโดยตรง 
    สุคนธ์  สินธพานนท์  (2553  :  96) ได้ให้ความหมายว่า ชุดฝึก หมายถึง สื่อที่สร้าง
ขึ้นเพ่ือให้นักเรียนได้ท ากิจกรรม เป็นการทบทวนหรือเสริมเพ่ิมเติมความรู้นักเรียนหรือให้นักเรียนได้ฝึก
ทักษะ การเรียนรู้หลาย ๆ รูปแบบ เพ่ือสรร้างเสริมประสบการณ์การเรียนรู้ให้แก่ผู้เรียนได้มีคุณลักษณะ
ตามท่ีต้องการ 
    ชูชัย  สมิทธิไกร  (2554  :  5) ได้ให้ความหมายว่า การฝึกอบรม (Training) คือ 
กระบวน การจัดการเรียนรู้อย่างเป็นระบบเพื่อสร้างความรู้หรือเพ่ิมพูนความรู้  (Knowledge)  
ทักษะ (Skill) ความสามารถ (Ability) และเจตคติ (Attitude) ของบุคลากรอันจะช่วยปรับปรุงให้ 
การปฏิบัติงานมีประสิทธิภาพสูงขึ้น การฝึกอบรมจึงเป็นโครงการที่ถูกจัดขึ้นมาเพ่ือช่วยให้พนักงาน 
มีคุณสมบัติในการท างานสูงขึ้น เช่น เป็นหัวหน้างานที่สามารถบริหารงานและบริหารผู้ใต้บังคับบัญชาได้
ดีขึ้น หรือเป็นช่างเทคนิคที่มีความสามารถในการซ่อมแซมเครื่องจักรได้ดีขึ้น  เป็นต้น 
    เรย์มอนด์  (Raymond.    2010) ได้ให้ความหมายว่า การฝึกอบรม หมายถึง 
โครงการที่บริษัทจัดขึ้นเพ่ือสร้างสมรรถนะให้กับพนักงาน สมรรถนะดังกล่าวได้แก่ ความรู้ ทักษะ  
และพฤติกรรมที่มีส าคัญและมีความความจ าเป็นต่อการปฏิบัติงานให้ประสบความส าเร็จกล่าว   
  สรุปได้ว่า การฝึกอบรม เป็นกระบวนการขององค์กร ในอันที่จะพัฒนาบุคคล  
เพ่ือเปลี่ยนแปลงพฤติกรรมอย่างมีระเบียบแบบแผน เพ่ือให้บุคคลมีความรู้ ความเข้าใจ มีทัศนคติ  
มีทักษะ ความช านาญประสบการณ์ที่เหมาะสม หรือเข้ากับงานได้อย่างดี เกิดการเปลี่ยนแปลงอย่าง
ถาวร และมีมาตรฐาน เป็นการด าเนินการต่อเนื่อง เป็นภาระท่ีไม่มีสิ้นสุด เพ่ือแก้ปัญหาขององค์กร
ในช่วงระยะเวลาที่เหมาะสม เป็นกิจกรรมที่จะน าไปสู่การแก้ไขปัญหาการท างานขององค์กร 
ให้มีประสิทธิภาพ ก่อให้เกิดความส าเร็จและบรรลุเป้าหมายขององค์กร 
  2. วัตถุประสงค์ของการฝึกอบรม 
   วัตถุประสงค์ของหลักสูตรฝึกอบรม เป็นวัตถุประสงค์ย่อยเฉพาะหลักสูตรนั้นๆ  
ว่าต้องการให้มีผลอย่างไร จะเป็นวัตถุประสงค์รายวิชาที่จัดฝึกอบรมนั้นๆ มีนักวิชาการและนักการศึกษา
หลายท่านได้กล่าวถึงวัตถุประสงค์ของหลักสูตรฝึกอบรมไว้ ดังนี้ 
    สมคิด บางโม  (2553  :  18) ได้อธิบายว่า วัตถุประสงค์ของการฝึกอบรม คือ  
เพ่ือเพ่ิมพูนความรู้เป็นพ้ืนฐานในการน าไปสู่ความเข้าใจ เพ่ือให้มีความสามารถในการปฏิบัติงานอย่างใด
อย่างหนึ่งโดยเฉพาะได้ดี เพ่ิมพูนทักษะ ความช านาญหรือทักษะในการท างานคือ ความคล่องแคล่วใน
การปฏิบัติงานอย่างใดอย่างหนึ่งโดยอัตโนมัติ เช่น เครื่องใช้ต่างๆ การขับรถเป็นต้น และเปลี่ยนทัศนคติ 
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การฝึกอบรมสามารถเปลี่ยนแปลงทัศนคติไป ทางท่ีพึงปรารถนาซึ่งเป็นพื้นฐานท าให้เกิด 
การเปลี่ยนแปลงพฤติกรรมของบุคคล ทัศนคติ คือความรู้สึกในด้านดีหรือไม่ดีต่อสิ่งใดสิ่งหนึ่ง เช่น  
เกิดความจงรักภักดีต่อบริษัท เกิดความสามัคคีในหมู่คณะเกิดความภาคภูมิใจในสถาบัน เป็นต้น 
    ชาญ  สวัสดิ์สาล ี (2552  :  20) ได้อธิบายว่า วัตถุประสงค์ของการอบรมใน 
การฝึกอบรมต้องระบุให้ชัดเจนถึงสิ่งที่ต้องการให้ผู้เข้ารับการฝึกอบรม เกิดการเรียนรู้ มีทักษะ หรือ
เปลี่ยนแปลงพฤติกรรมหรือทัศนคติในด้านใด ลักษณะใด ระดับใด ในการฝึกอบรมครั้งนั้น เพ่ือที่จะได้
แก้ปัญหาที่เป็นความจ าเป็นในการฝึกอบรมได้ 
    นิพนธ์  ศุขปรีดี  (2552  :  160) ได้อธิบายว่า การก าหนดวัตถุประสงค์ 
เพ่ือการออกแบบชุดฝึกอบรมคือ การตั้งเป้าหมายในการฝึกอบรม โดยจะต้องกระท าไปพร้อมๆ กับ 
การออกแบบโครงสร้างชุดฝึกอบรมการสร้างสื่อและวัสดุ อุปกรณ์ต่างๆ ซึ่งอาจไม่มีในสถานที่ฝึกอบรม
จริง และการออกแบบต้องเป็นไปตามวัตถุประสงค์ที่ได้ก าหนดไว้เท่านั้น   
    ชูชัย  สมิทธิไกร  (2554  :  7) ได้อธิบายว่า วัตถุประสงค์ของการฝึกอบรม คือ  
การก าหนดเป้าหมายของการฝึกอบรมว่าจะต้องเปลี่ยนแปลงความรู้  ทัศนคติและพฤติกรรมของผู้รับ 
การอบรม ให้เป็นไปในทางใด ระดับใด และสรุปการก าหนดวัตถุประสงค์ของโครงการฝึกอบรม  
จะต้องมาจากการวิเคราะห์ความต้องการในการฝึกอบรม วัตถุประสงค์โดยทั่วไป จ าแนกได้ 3 ระดับ คือ 
วัตถุประสงค์ของหลักสูตร วัตถุประสงค์ของหมวดวิชา และวัตถุประสงค์ของวิชา 
  สรุปได้ว่า วัตถุประสงค์ของการฝึกอบรม คือ การก าหนดเป้าหมายเพ่ือให้เกิด 
การเปลี่ยนแปลงพฤติกรรมด้านความรู้ ทักษะ และทัศนคติของผู้เข้าฝึกอบรมให้ตรงกับความต้องการ
ขององค์กร 
  3. ประเภทของการฝึกอบรม 
   การฝึกอบรมมีหลายรูปแบบหลายประเภท การฝึกอบรมจะใช้ประเภทใดข้ึนอยู่กับ
วัตถุประสงค์ของการฝึกอบรมนั้นๆ โดยได้มีนักวิชาการและนักการศึกษาหลายท่านได้จ าแนกประเภท
ของการฝึกอบรมไว้ ดังนี้ 
    นิพนธ์  ศุขปรีดี  (2552  :  164) ได้อธิบายว่า ประเภทของชุดการฝึกอบรม 
สามารถแบ่งเป็นประเภทของชุดการฝึกอบรมได้ 2 ประเภทใหญ่ๆ คือ  
     ประเภทที่ 1 ชุดการฝึกอบรมส าหรับเสริมกิจกรรมการฝึกอบรม นั้นผู้ให้ 
การฝึกอบรมอาจจะจัดกิจกรรมการฝึกอบรมได้สองลักษณะ คือ 
      ลักษณะที่ 1 การใช้สื่อของชุดการฝึกอบรม บางส่วนมาประกอบบรรยาย 
หรือ ประกอบกิจกรรมการฝึกอบรม 
      ลักษณะที่ 2 ผู้ให้การฝึกอบรมจะจัดกิจกรรมการฝึกอบรมตามชุดการฝึกนั้น 
โดยมีผู้ให้การฝึกอบรม เป็นผู้อ านวยความสะดวก (Facilitor) หรือ ผู้ด าเนินการ (Oganizer)  
มิใช่เป็นแต่เพียงผู้บรรยายเท่านั้น 
     ประเภทที่ 2 ชุดฝึกอบรมเสริมกิจกรรมการฝึกที่มีใช้กันอยู่โดยทั่วไป ได้แก่  
ชุดการฝึกอบรมที่เป็น เอกสาร สิ่งพิมพ์ ชุดการฝึกอบรมที่เป็นสไลด์ประกอบเสียง ชุดการฝึกอบรม 
วีดิทัศน์ เทปเสียง ชุดฝึกอบรมระยะสั้น เป็นต้น และเนื่องจากชุดการฝึกอบรม เป็นสื่อประเภทหนึ่ง 
ที่มีความสมบูรณ์ในตัว จึงท าให้ผู้ให้การฝึกอบรมสามารถน ามาใช้ประกอบการจัดกิจกรรมการฝึกอบรม  
ให้เป็นที่น่าสนใจ สนุกและไม่น่าเบื่อหน่าย 
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    ไพโรจน์ คะเชนทร์  (2555  :  1) ได้แบ่งชุดฝึกอบรมออกเป็น 3 ประเภท คือ   
     1. ชุดอุปกรณ์ฝึกอบรม (Thinking Kits) หมายถึง การจัดระบบสื่อท่ีจ าเป็น 
ในระบบการฝึกอบรมให้อยู่ในที่เดียวกันเพ่ือง่ายต่อการแสวงหาและใช้สื่ออุปกรณ์ฝึกอบรม  อาจจะแบ่ง 
เป็นสื่อสิ่งพิมพ์เป็นสื่อหลักและสื่อประสมหลัก  
     2. ชุดฝึกอบรม (Training Packages) หมายถึง การจัดระบบการฝึกอบรมที่
สมบูรณ์ที่ผู้เข้ารับการฝึกอบรมสามารถเรียนรู้ได้ด้วยตนเอง หรือชุดฝึกอบรมที่ผู้ให้การฝึกอบรมเป็นผู้ใช้
ในการบรรยายหรือจัดกิจกรรมในการฝึกอบรม ในชุดฝึกอบรมจะประกอบด้วยคู่มือการใช้ชุดฝึกอบรม 
แบบทดสอบก่อนเรียนหลังเรียนสื่อที่ใช้ในกิจกรรมการฝึกอบรมทั้งหมดท่ีจ าเป็นต้องใช้ในระบบ 
การฝึกอบรมมีทั้งชุดฝึกอบรมที่ใช้สื่อสิ่งพิมพ์เป็นสื่อหลัก และชุดฝึกอบรมที่ใช้สื่อประสมเป็นหลัก  
ชุดฝึกอบรมที่ใช้สื่อสิ่งพิมพ์เป็นหลักส่วนใหญ่ เรียกว่า ชุดเอกสารฝึกอบรม ทีใ่ช้สื่อประสมเป็นสื่อหลัก 
เรียกว่า ชุดฝึกอบรม ในด้านวิธีการฝึกอบรมของชุดฝึกอบรมใช้ทฤษฎี การรับสารของ บี เอฟ สกินเนอร์ 
(B.F. Skinner) ตามทฤษฎีบทเรียนโปรแกรม คือ การให้ผู้รับการฝึกอบรมได้เรียนทีละน้อยเป็นขั้นตอน
ด้วยการเรียนรู้ที่ใกล้เคียงกับประสบการณ์ตรงหรือได้มีโอกาสลงมือท าหรือคิดด้วยตนเอง  
     3. โมดุลฝึกอบรม (Modular Training) หมายถึง การจัดระบบการฝึกอบรมที่
จัดเป็นชุดฝึกอบรม (Training Packages) หลายชุดติดต่อกัน โมดุลฝึกอบรมมีทั้งที่เป็นโมดุล ฝึกอบรม
สื่อสิ่งพิมพ์เป็นหลัก และโมดุลฝึกอบรมสื่อประสมเป็นหลัก 
  สรุปได้ว่า การจ าแนกประเภทของการฝึกอบรมมีหลายประเภท ในการท าวิจัยครั้งนี้ผู้วิจัย
เลือกประเภท ฝึกอบรมเพ่ือพัฒนา เพ่ือตอบสนองความต้องการของผู้เข้ารับการฝึกอบรมและให้ผู้เข้ารับ
การฝึกอบรม สามารถน าไปเพ่ิมพูนประสิทธิภาพในการปฏิบัติงานให้สูงขึ้นช่วยให้ผู้ปฏิบัติงานได้  
มีความคิดริเริ่มสร้างสรรค์ สามารถพัฒนางานให้ก้าวหน้าขึ้น 
  4. การวิเคราะห์ความต้องการฝึกอบรม 
   การจัดการฝึกอบรมจะมีการด าเนินการ เมื่อมีความจ าเป็นเกิดข้ึน ซึ่งหมายถึง 
ภาวะไม่พึงปรารถนาที่มีอยู่ในหน่วยงาน อาจมีปัญหา มีจุดอ่อนหรือข้อบกพร่องที่เกิดขึ้นในหน่วยงาน
หรือการปฏิบัติงาน ซึ่งวิธีการแก้ไขวิธีหนึ่ง คือ การฝึกอบรมเพ่ือเพ่ิมประสิทธิภาพในการท างานดังนั้น 
จึงมีความจ าเป็นที่จะต้องท าการวิเคราะห์ความต้องการในการฝึกอบรม 
    ชูชัย  สมิทธิไกร  (2554  :  48-49) ได้อธิบายว่า การวิเคราะห์ความต้องการของ
องค์กรวิเคราะห์งาน และวิเคราะห์บุคคลเพื่อก าหนดความจ าเป็นในการฝึกอบรม  
     1. การวิเคราะห์องค์กร (Organizational Analysis) เป็นการวิเคราะห์ว่า 
งานทุกงานในองค์กรจ าเป็นต้องมีความรู้ ทักษะและมีทัศนคติต่องานใดบ้างจึงจะสามารถตอบสนองต่อ
เป้าหมายเชิงกลยุทธ์ขององค์กรไดท่ี การวิเคราะห์องค์กรคือ การวิเคราะห์องค์ประกอบต่างๆ ของ
องค์กรซึ่งอาจส่งผลกระทบต่อโครงการฝึกอบรม โดยการวิเคราะห์จะครอบคลุมเป้าหมายขององค์กร 
ทรัพยากรบรรยากาศ สภาพแวดล้อมและข้อจ ากัดต่าง ๆ ทั้งภายในและภายนอก ขององค์กรการ
วิเคราะห์องค์กรจะช่วยตรวจสอบว่า ปัญหาแท้จริงคืออะไร องค์กรจะใช้มาตรการใดเพ่ือแก้ไขปัญหานั้น 
และการฝึกอบรมจะให้ประโยชน์อะไรแก่องค์กรบ้างหรือไม่องค์ประกอบต่างๆ   ที่จะต้องวิเคราะห์
ประกอบด้วย 
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      1.1 เป้าหมายขององค์กร คือองค์ประกอบแรกท่ีจะต้องวิเคราะห์ว่า  
องค์กรมีเป้าหมาและทิศทางการด าเนินการอย่างไรและจัดโครงการฝึกอบรมเพ่ือสนับสนุนให้พนักงาน
สามารถปฏิบัติงานตามแนวทางที่ได้ก าหนดไว้และสามารถบรรลุเป้าหมายสูงสุดขององค์กรได้  
      1.2 ทรัพยากรที่มีอยู่ภายในองค์กร การก าหนดวัตถุประสงค์ของ 
การฝึกอบรมจะกระท าได้ยาก หากไม่ทราบข้อมูลเกี่ยวกับทรัพยากรที่องค์กรมีอยู่  ทั้งในด้านบุคลากร 
วัสดุอุปกรณ์และเงิน การวิเคราะห์ทรัพยากรขององค์กรจึงควรคลอบคลุมจ านวนบุคลากร งบประมาณ
และวัสดุอุปกรณ์ต่างๆ ที่มีอยู่ภายในองค์กรและสิ่งที่มีความส าคัญอย่างมากคือ การวิเคราะห์ 
ความต้องการด้านก าลังคน ซึ่งจ าเป็นต่อการท างานขององค์กรในอนาคต 
      1.3 บรรยากาศการท างานภายในองค์กร สภาพแวดล้อมและปัจจัยภายนอก
ที่เก่ียวข้องกับองค์กรบรรยากาศท่ีเอ้ืออ านวยต่อการฝึกอบรมได้แก่  ความยอมรับในนวัตกรรม 
(innovation) และเทคโนโลยีขององค์กร ความเต็มใจในการลงทุนเพื่อการฝึกอบรมของฝ่ายบริหาร  
การสนับสนุนให้ผู้เข้ารับการฝึกอบรมน าความรู้มาประยุกต์ใช้ในองค์กร การให้รางวัลตอบแทนแก่ผู้น า
ความรู้จากการฝึกอบรมมาใช้ให้เกิดประโยชน์ส่วนสภาพแวดล้อมและปัจจัยภายนอกได้แก่ เศรษฐกิจ
สังคม การเมือง กฎหมายมีผลกระทบต่อการด าเนินงานขององค์กรและการจัดฝึกอบรม เช่น  
การเปลี่ยนแปลงด้านเทคโนโลยีอาจส่งผลให้องค์กรต้องก าหนดเป้าหมาย ลักษณะงานใหม่ หรือการออก
กฎหมายเกี่ยวกับการอนุรักษ์สิ่งแวดล้อมและความปลอดภัยในการท างานอาจจะมีผลให้องค์การต้อง
ปรับเปลี่ยนระบบและวิธีการท างานใหม่ เป็นต้น    
     2. การวิเคราะห์งาน (Job or Task Analysis) คือ กระบวนการศึกษาและ
รวบรวมข้อมูลเกี่ยวกับขั้นตอนการปฏิบัติงาน โดยส่วนแรกเป็น การวิเคราะห์ภารกิจ (Task Analysis) 
ซึ่งจะบ่งชี้ส่วนประกอบของงานหนึ่งๆ เกี่ยวกับลักษณะงานที่จะต้องปฏิบัติ ส่วนที่สองคือการวิเคราะห์
คุณสมบัติ เพ่ือค้นหาว่าพนักงานจ าเป็นต้องใช้ความรู้ (Knowledge) ทักษะ (Skills) หรือมีทัศนคติต่อ
งาน (Attitudes) อะไรบ้าง ที่จ าเป็นส าหรับการปฏิบัติงาน ผลที่ได้รับจากการวิเคราะห์ขั้นตอนนี้คือ  
จะท าให้ได้ข้อมูลเกี่ยวกับภารกิจและคุณสมบัติที่มีความส าคัญต่อการปฏิบัติงาน ข้อมูลเหล่านี้จะเป็น
เสมือน แผนที่ซึ่งจะน าทางไปสู่การออกแบบและพัฒนาหลักสูตรการฝึกอบรม เพ่ือให้การฝึกอบรมนั้น
สอดคล้องและตอบสนองต่อความต้องการขององค์การและพนักงานรวมทั้งสมรรถนะ  โดยเฉพาะอย่าง
ยิ่งสมรรถนะในงาน  (Functional Competency) เนื่องจากเป็นความสามารถเฉพาะด้านของ 
แต่ละงานที่แตกต่างกัน 
     3. การวิเคราะห์พนักงานหรือตัวบุคคล (Person Analysis) มีวัตถุประสงค์สอง 
ประการคือประการแรก เพ่ือประเมินว่าพนักงานแต่ละคนมีความรู้ทักษะ และความสามารถท่ีจ าเป็น
ส าหรับการปฏิบัติงานอยู่ในระดับใด มีผลการปฏิบัติงานที่ดีเลิศ (Excellent Performance) หรือไม ่
โดยวิเคราะห์ความแตกต่างระหว่างมาตรฐานการปฏิบัติงานและการปฏิบัติจริง ซึ่งเก่ียวข้องกับ 
การค้นหาว่าพนักงานแต่ละคนมีผลการปฏิบัติงานที่สูงกว่าหรือเท่ากับหรือต่ ากว่ามาตรฐานเพราะเหตุใด 
และจ าเป็นต้องได้รับการพัฒนาในด้านใดบ้างโดยอาศัยเครื่องมือ เช่น แบบประเมิน แบบสอบถามเป็น
เครื่องมือในการประเมินความสามารถของพนักงานผลที่ได้จากการประเมินจะสะท้อนให้เห็นว่าพนักงาน
คนใดท างานดีและมีประสิทธิภาพมากน้อยเพียงใด ผลการปฏิบัติงานด้านใดบ้างที่ต้องปรับปรุง  
เพ่ือให้ผู้จัดการฝ่ายฝึกอบรมขององค์กรน าข้อมูลไปออกแบบหลักสูตรฝึกอบรมที่ เหมาะสมและ
เฉพาะเจาะจงส าหรับพนักงานที่ยังขาดอยู่ในขั้นตอนต่อไป 
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    สุกัญญา รัศมีธรรมโชติ (2550) สรุปได้ว่า ในขั้นตอนนี้เป็นการวิเคราะห์หากรอบ 
ความต้องการขององค์กร งาน และตัวพนักงานเพ่ือน าค าตอบไปก าหนดความจ าเป็นในการฝึกอบรม  
โดยจะเน้นการพัฒนาบุคลากรให้สามารถสร้างผลงานที่ดีเลิศมากกว่าการท าผลงานได้ตามเกณฑ์
มาตรฐานขององค์กรเท่านั้น ซึ่งค าถามที่ต้องตอบมีดังต่อไปนี้ 1) สถานการณ์ใดที่ช่วยส่งเสริมให้
พนักงานสามารถสร้างผลการปฏิบัติงานที่ดีเลิศตามท่ีคาดหวังได้ 2) พนักงานแต่ละคนจ าเป็นต้อง 
มีสมรรถนะอะไรบ้าง จึงจะสร้างผลการปฏิบัติงานที่ดีเลิศดังกล่าวได้ 3) ใครบ้างควรเข้ารับการฝึกอบรม
และบุคคลเหล่านั้นมีคุณลักษณะแตกต่างจากพนักงานที่มีผลการปฏิบัติงานดีเลิศอย่างไร   
  5. กระบวนการฝึกอบรม 
   การฝึกอบรม เป็นกระบวนการที่ต้องมีการด าเนินงานเป็นล าดับอย่างต่อเนื่อง ตั้งแต่ต้น
จนจบในและข้ันตอนจะมีความส าคัญ การฝึกอบรมจะพิจารณาถึงปัจจัยน าเข้า (Input) กระบวนการ 
(Process) และผล (Output) และมีข้อมูลย้อนกลับอย่างต่อเนื่อง การฝึกอบรมจึงเป็นการช่วยให้ผู้เข้า
รับการฝึกอบรมได้เรียนรู้ ได้พัฒนาตนเองในแนวทางที่สอดคล้องกับวัตถุประสงค์ขององค์การ   
การฝึกอบรมจึงต้องท าอย่างต่อเนื่องเป็นระบบ โดยมีขั้นตอนและกระบวนการฝึกอบรมที่ผู้ทรงคุณวุฒิ
หลายท่านได้กล่าวไว้ ดังนี้ 
    สมชาติ กิจยรรยง และอรจรีย์ ณ ตะกั่วทุ่ง  (2551  :  25) ได้เสนอกระบวนการ
ฝึกอบรมไว้ 4 ขั้นตอน ดังนี้  
     ขั้นตอนที่ 1 การหาความต้องการจ าเป็นในการฝึกอบรม ซึ่งเป็นการศึกษา
เอกสารงานวิจัย แนวคิดทฤษฎีต่างๆ และความต้องการจ าเป็นในการพัฒนา  
     ขั้นตอนที่ 2 ออกแบบโครงการและหลักสูตรการฝึกอบรม เป็นการยกร่าง
หลักสูตรฝึกอบรม การตรวจสอบคุณภาพร่างหลักสูตรฝึกอบรมเพ่ือพิจารณาความเป็นไปได้  
และการปรับปรุงร่างหลักสูตรและการเตรียมการก่อนการทดลองใช้  
     ขั้นตอนที่ 3 ด าเนินการจัดฝึกอบรมหรือทดลองใช้หลักสูตรฝึกอบรม   
     ขั้นตอนที่ 4 ประเมินผลการฝึกอบรม ประกอบด้วย การประเมินผล และ 
การติดตามผล  
    คมธัช รัตนคช และดนุพล คลอวุฒินันท์  (2553  :  11) ได้อธิบายว่า ชุดการ
ฝึกอบรมจะสามารถใช้งานได้อย่างเหมาะสมหรือสนับสนุนการเรียนการสอน และการฝึกอบรมเกิด
ประสิทธิผล ได้นั้น ชุดการฝึกอบรมต้องมีการพัฒนาที่ถูกต้องตามหลักวิชาการต้องสอดคล้องกับหลัก
วิชาทางเทคโนโลยีการศึกษาและหลักวิชาการเรียนรู้ของมนุษย์ ซึ่งน าไปสู่ความมีประสิทธิภาพของชุด
การฝึกอบรมนั่นเอง  
     การสร้างชุดการฝึกอบรมโดยทั่วไปแล้ว จะแบ่งออกเป็น 3 ระยะ ได้แก่  
      ระยะแรก การด าเนินงานในการสร้างเครื่องมือหรือบทเรียนโปรแกรม 
การฝึกอบรม  
      ระยะที่สอง การน าชุดการฝึกอบรมที่สร้างขึ้นไปทดลองใช้เพ่ือหาข้อปรับปรุง
แก้ไข  
      ระยะที่สาม การน าไปใช้งานจริง  
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     ในกระบวนการสร้างชุดการฝึกอบรมมีลักษณะและข้ันตอนเช่นเดียวกันกับ 
กระบวนการสร้างชุดการสอน หรือชุดการเรียน ได้แบ่งข้ันตอนในการสร้างชุดการสอนไว้ 10 ประการ 
ดังนี้  
      1. ก าหนดหมวดหมู่ เนื้อหา และประสบการณ์ อาจก าหนดเป็นหมวดวิชา
หรือบูรณาการเป็นแบบสหวิทยาการตามที่เหมาะสม  
      2. ก าหนดเป็นหน่วยการสอน โดยแบ่งเนื้อหาออกเป็นหน่วยการสอน 
ปริมาณเนื้อหาที่ครูสามารถถ่ายทอดความรู้แก่นักเรียนได้ในหนึ่งสัปดาห์หรือสอนได้หน่วยละครั้ง   
      3. ก าหนดหัวเรื่อง ผู้สอนจะต้องถามตัวเองว่าในการเรียนแต่ละหน่วย 
ควรให้ประสบการณ์อะไรแก่ผู้เรียนบ้าง แล้วก าหนดหัวข้อเรื่องออกมาเป็นหน่วยการสอนย่อย  
      4. ก าหนดหลักการ และความคิดรวบยอด หลักการและความคิดรวบยอด  
ที่ก าหนดขึ้นจะต้องสอดคล้องกับหน่วยและหัวข้อเรื่อง โดยสรุปรวมแนวคิด สาระและหลักเกณฑ์ที่
ส าคัญไว้ เพ่ือเป็นแนวทางจัดเนื้อหามาสอนให้สอดคล้องกัน 
      5. ก าหนดวัตถุประสงค์ให้สอดคล้องกับหัวเรื่อง โดยเขียนวัตถุประสงค์ 
เชิงพฤติกรรมที่ต้องมีเกณฑ์เปลี่ยนพฤติกรรมไว้ทุกครั้ง  
      6. ก าหนดกิจกรรมการเรียนให้สอดคล้องกับวัตถุประสงค์เชิงพฤติกรรม  
ซึ่งจะเป็นแนวทางเลือกและผลิตสื่อการสอน กิจกรรมการเรียน หมายถึง กิจกรรมทุกอย่างที่ผู้เรียน
ปฏิบัติ เช่น การอ่านบัตรค าสั่ง การตอบค าถาม การเขียนภาพ การท าการทดลองทางวิทยาศาสตร์  
การเล่นเกม ฯลฯ  
      7. การก าหนดแบบประเมินผล ต้องประเมินให้ตรงกับวัตถุประสงค์ 
เชิงพฤติกรรมโดยใช้แบบสอบถามอิงเกณฑ์ เพ่ือให้ผู้สอนทราบว่าหลังจากชุดการสอนแบบศูนย์การเรียน
แล้ว ผู้เรียนได้เปลี่ยนแปลงพฤติกรรมการเรียนรู้ตามวัตถุประสงค์ที่ตั้งไว้หรือไม่   
      8. เลือกและผลิตสื่อการสอน วัสดุ อุปกรณ ์และวิธีการที่ครูใช้ ถือเป็นสื่อ
การสอนทั้งสิ้น เมื่อผลิตสื่อการสอนแต่ละหัวเรื่องแล้วก็จัดสื่อการสอนเหล่านั้นไว้เป็นหมวดหมู่ในกล่อง  
ที่เตรียมไว้เพ่ือน าไปทดลองหาประสิทธิภาพตามเกณฑ์มาตรฐานที่ตั้งไว้ การก าหนดเกณฑ์ประสิทธิภาพ
ของชุดการฝึก/ชุดการสอน นิยมตั้งไว้ 90/90 ส าหรับเนื้อหาที่เป็นความจ า และไม่ต่ ากว่า 80/80 
ส าหรับวิชาทักษะ เช่น ภาษา เพราะการเปลี่ยนแปลงพฤติกรรมตามระยะเวลา ไม่สามารถเปลี่ยนและ
วัดได้ทันทีท่ีเรียนจบไปแล้ว  
      9. หาประสิทธิภาพของชุดการสอน เพ่ือเป็นประกันว่าชุดการสอนที่สร้างขึ้น
มีประสิทธิภาพในการสอน ผู้สร้างจ าต้องก าหนดเกณฑ์ขึ้นโดยค านึงหลักการที่ว่า การเรียนรู้ 
เป็นกระบวนการเพ่ือช่วยให้การเปลี่ยนแปลงพฤติกรรมของผู้เรียนบรรลุผล  
      10. การใช้ชุดการสอน เป็นขั้นน าชุดการสอนไปใช้ ซึ่งจ าเป็นจะต้อง 
มีการตรวจสอบ และปรับปรุงอยู่ตลอดเวลา  
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    ชูชัย  สมิทธิไกร  (2554  :  30) ได้เสนอกระบวนการฝึกอบรมเป็นขั้นตอน  
การฝึกอบรม แสดงดังภาพประกอบ 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบ  1  ขั้นตอนการฝึกอบรม 
 
  สรุปได้ว่า การฝึกอบรมเป็นวิธีการในการพัฒนาบุคลากรให้มีความรู้ ความสามารถ  
มีความเข้าใจ มีทักษะและทัศนคติที่ดีต่อการปฏิบัติงานเพ่ือเพ่ิมพูนความรู้  ความเข้าใจให้กับบุคลากร
ขององค์การ ให้สามารถปฏิบัติหน้าที่ได้อย่างเต็มประสิทธิภาพ การฝึกอบรมเน้นถึงการมีปฏิสัมพันธ์
ระหว่างองค์ประกอบต่างๆ ซึ่งมีท้ังสิ้น 6 ขั้นตอน ประกอบด้วย การวิเคราะห์ความต้องการใน 
การฝึกอบรม การก าหนดวัตกุประสงค์ของการฝึกอบรม การคัดเลือกและออกแบบโครงการฝึกอบรม 
การสร้างเกณฑ์ส าหรับการประเมินผล การจัดการฝึกอบรม และการประเมินผลการฝึกอบรม 
 
ทฤษฎีบทเรียนคอมพิวเตอร์ช่วยสอนตามแนวคิดของ กานเย่ 
 
 ทิศนา แขมมณี  (2555  :  72-76) ได้กล่าวว่า กานเย ่(Gagne) เป็นนักจิตวิทยาและ 
นักการศึกษาในกลุ่มผสมผสานระหว่างพฤติกรรมนิยมกับพุทธ นิยม (Behavior Cognitivist) เขาอาศัย
ทฤษฎีและหลักการที่หลากหลาย เนื่องจากความรู้มีหลายประเภท บางประเภทสามารถเข้าใจได้อย่าง
รวดเร็วไม่ต้องใช้ความคิดที่ลึกซ้ึงบางประเภท มีความวับซ้อนมาก จ าเป็นต้องใช้ความสามารถในขั้นสูง 
กานเย่ได้จัดขั้นการเรียนรู้ซึ่งเริ่มจากง่ายไปหายาก โดยผสมผสานทฤษฎีการเรียนรู้ของกลุ่มพฤติกรรม
นิยม และพุทธนิยมเข้าด้วยกัน 
 
 

การวิเคราะห์ความต้องการ 
     1. การวิเคราะห์องค์การ 
     2. การวิเคราะห์ภารกิจ 
     3. การวิเคราะห์บุคคล 

ก าหนดวัตถุประสงค์ 
ของการฝึกอบรม 

คัดเลือกและออกแบบ
โครงการฝึกอบรม 

จัดการฝึกอบรม 

ประเมินผล 

ความแม่นตรงของผลที่ได้รับ
จากการฝึกอบรม 

สร้างเกณฑ์ส าหรับ
การประเมินผล 
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  การเรียนรู้ของกานเย่ (Gagne) 
   1. หลักการที่ส าคัญของกานเย่ สรุปดั้งนี้ (Gagne and Briggs.    1974  :  121-136) 
     1.1 ทฤษฎีการเรียนรู้ 
      1.1.1 กานเย ่(Gagne) ได้จัดประเภทของการเรียนรู้ เป็นล าดับขั้นจาก 
ง่ายไปหายากไว้ 8 ประเภท ดังนี้ 
      1.1.1.1 การเรียนรู้สัญญาน (Signal-learning) เป็นการเรียนรู้ที่เกิดจากการ
ตอบสนองต่อสิ่งเร้าที่เป็นไปโดยอัติโนมัติ อยู่นอกเหนืออ านาจจิตใจ ผู้เรียนไม่สามารถบังคับพฤติกรรม
ใหม่ให้เกิดขึ้นได้ การเรียนรู้แบบนี้เกิดจากการที่คนเราน าเอาลักษณะการตอบสนองที่มีอยู่แล้วมา 
สัมพันธ์กับสิ่งเร้าใหม่ที่มีความใกล้ชิดกับสิ่งเร้าเดิม การเรียนรู้สัญญาณ เป็นลักษณะการเรียนรู้แบบ 
การวางเงื่อนไขของพาฟลอฟ 
      1.1.1.2 การเรียนรู้สิ่งเร้า-การตอบสนอง  (Stimulus-response)  
เป็นการเรียนรู่ต่อ เนื่องจากการเชื่อมโยงระหว่างสิ่งเร้าและการตอบสนอง แตกต่างจากการเรียนรู้
สัญญาณ เพราะผู้เรียนสามารถควบคุมพฤติกรรมตนเองได้ ผู้เรียนแสดงพฤติกรรม เนื่องจากได้รับแรง
เสริม การเรียนรู้แบบนี้เป็นการเรียนรู้ตามทฤษฎีการเรียนรู้แบบเชื่อมโยงของ ธอร์นไคด์ และการเรียนรู้
แบบวางเงื่อนไข (Operant Conditioning) ของสกินเนอร์ซึ่งเชื่อว่าการเรียนรู้เป็นสิ่งที่ผู้เรียน 
เป็นผู้กระท าเองมิ ใช่รอให้สิ่งเร้าภายนอกมากระท าพฤติกรรมที่แสดงออกเกิดจากสิ่งเร้าภายในของ 
ผู้เรียนเอง 
       1.1.1.3 การเรียนรู้การเชื่อมโยงแบบต่อเนื่อง (Chaining) เป็นการเรียนรู้ 
ที่เชื่อมโยงระหว่างสิ่งเร้าและกาตอบสนองที่ต่อเนื่องกันตาม ล าดับ เป็นพฤติกรรมที่เก่ียวข้องกับ 
การกระท า การเคลื่อนไหว 
      1.1.1.4 การเชื่อมโยงทางภาษา (Verbal Association) เป็นการเรียนรู้ 
ในลักษณะคล้ายกับการเรียนรู้การเชื่อมโยงแบบต่อเนื่อง แต่เป็นการเรียนรู้เกี่ยวกับการใช้ภาษา  
การเรียนรู้การรับสิ่งเร้าการตอบสนอง เป็นพื้นฐานของกาเรียนรู้แบบต่อเนื่องและการเชื่อมโยงทางภาษา 
       1.1.1.5 การเรียนรู้ความแตกต่าง (Discrimination Learning)  
เป็นการเรียนรู้ทีผสมผสานสามารถมองเห็นความแตกต่างของสิ่งต่างๆ โดยเฉพาะความแตกต่าง 
ตามลักษณะของวัตถุ 
       1.1.1.6 การเรียนรู้ความคิดรวบยอด (Concept Learning) เป็นการเรียนรู้ 
ที่ผู้เรียนสามารถจัดกลุ่มสิ่งเร้าที่มีความเหมือนหรือแตก ต่างกัน โดยสามารถระบุลักษณะที่เหมือนหรือ
แตกต่างกันได้ พร้อมทั้งสามารถขยายความรู้ไปยังสิ่งอื่นที่นอกเหนือจากทีเคยเห็นมาก่อนได้  
       1.1.1.7 การเรียนรู้กฎ (Rule Learning) เป็นการเรียนรู้ที่เกิดจากการรวม
หรือเชื่อมโยงความคิดรวบยอดตั้งแต่สองอย่าง ขึ้นไป และตั้งเป็นกฎเกณฑ์ข้ึน การที่ผู้เรียนสามารถ
เรียนรู้กฎเกณฑ์จะช่วยให้ผู้เรียนสามารถน าการเรียนรู้ นั้นไปใช้ในสถานการณ์ต่างๆ  กันได้ 
       1.1.1.8 การเรียนรู้การแก้ปัญหา (problem solving) เป็นการเรียนรู้ 
ที่จะแก้ปัญหา โดยการน ากฎเกณฑ์ต่างๆ มาใช้ การเรียนรู้แบบนี้เป็นกระบวนการที่เกิดภายในตัวผู้เรียน  
เป็นการใช้กฎเกณฑ์ในขั้นสูงเพื่อการแก้ปัญหาที่ค่อนข้างซับซ้อน และสามารถน ากฎเกณฑ์ใน 
การแก้ปัญหานี้ไปใช้กับสถานการณ์ที่คล้ายคลึงกันได้ 
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     1.1.2 กานเย่ได้แบ่งสมรรถภาพการเรียนรู้ของมนุษย์ไว้ 5 ประการ ดังนี้ 
       1.1.2.1 สมรรถภาพในการเรียนรู้ข้อเท็จจริง (Verbal Information)  
เป็นความสามรถในการเรียนรู้ข้อเท็จจริงต่างๆ  โดยอาศัยความจ าและความสามารถระลึกได้ 
       1.1.2.2 ทักษะเชาว์ปัญญา (Intellectual Skills) หรือทักษะทางสติปัญญา 
เป็นความสามารถในการใช้สมองคิดหาเหตุผล โดยใช้ข้อมูล ประสบการณ ์ความรู้ ความคิดในด้านต่างๆ 
นับตั้งแต่การเรียนรู้ขั้นพื้นฐาน ซึ่งเป็นทักษะง่ายๆไปสู่ทักษะที่ยากสลับซับซ้อนมากขึ้น ทักษะเชาว์
ปัญญาที่ส าคัญที่ควรได้รับการฝึกคือ ความสามรถในการจ าแนก (Discrimination) ความสามารถใน 
การคิดรวบยอกเป็นรูปธรรม (Concrete Concept) ความสามรถในการให้ค าจ ากัดความของความคิด
รวบยอด (Defined Concept) ความสามารถในการเข้าใจกฎและใช้กฎ (Rules) และความสามารถใน
การแก้ปัญหา (Problem Solving)  
       1.1.2.3 ยุทธศาสตร์ในการคิด (Cognitive Strategies) เป็นความสามารถ
ของกระบวนการท างานภายในสมองของมนุษย์ ซึ่งควบคุมการเรียนรู้ การเลือกรับรู้ การแปลความ  
และการดึงความรู้ ความจ า ความเข้าใจ และประสบการณ์เดิมออกมาใช้ ผู้มียุทธศาสตร์ในการคิดสูง  
จะมีเทคนิค มีเคล็ดลับในการดึงความรู้ ความจ า ความเข้าใจ และประสบการณ์เดิมออกมใช้อย่าง 
มีประสิทธิภาพ สามรารถแก้ปัญหาที่มีสถานการณ์ท่ีแตกต่างได้อย่างดี  รวมทั้งสามารถแก้ปัญหาต่างๆ 
ได้อย่างสร้างสรรค์ 
       1.1.2.4 ทักษะการเคลื่อนไหว (Motor Skills) เป็นความสามารถ  
ความช านาญในการปฏิบัติหรือการใช้อวัยวะส่วนต่างๆ ของร่างกายในการท ากิจกรรม ต่างๆ ผู้ที่มีทักษะ
การเคลื่อนไหวที่ดีนั้น พฤติกรรมที่แสดงออกมาจะมีลักษณะรวดเร็ว คล่องแคล่ว และถูกต้องเหมาะสม 
       1.1.2.5 เจตคต ิ(Attitudes) เป็นความรู้สึกนึกคิดของบุคคลที่มีต่อสิ่งต่างๆ 
ซึ่งมีผลต่อการตัดสินใจของบุคคลนั้นในการที่จะเลือกกระท าหรือไม่กระท าสิ่งใด  สิ่งหนึ่ง 
     1.2 วัตถุประสงค์ 
     เพ่ือช่วยให้ผู้เรียนสามารถเรียนรู้เนื้อหาสาระต่าง ๆ  ได้อย่างดี รวดเร็ว และ
สามารถจดจ าสิ่งที่เรียนได้นาน 
    1.3 หลักการจัดการศึกษา/การสอน 
     1.3.1 กานเย ่ได้เสนอรูปแบบการสอนอย่างเป็นระบบโดยพยายามเชื่อมโยง 
การจัดสภาพการเรียนการ สอนอันเป็นสภาวะภายนอกตัวผู้เรียนให้สอดคล้องกับกระบวนการเรียนรู้
ภายใน ซึ่งเป็นกระบวนการที่เกิดขึ้นภายในสมองของคนเรา กานเย ่อธิบายว่าการท างานของสมองคล้าย
กับการท างานของคอมพิวเตอร์ 
     1.3.2 ในระบบการจัดการเรียนการสอน เพ่ือให้สอดคล้องกับกระบวนการ
เรียนรู้นั้น กานเย่ได้เสนอระบบการสอน 9 ขั้น ดังนี้ 
       ขั้นที่ 1 สร้างความสนใจ (gaining attention) เป็นขั้นที่ท าให้ผู้เรียน 
เกิดความสนใจในบทเรียน เป็นแรงจูงใจที่เกิดข้ึนทั้งสิ่งยั่วยุภายนอกและแรงจูงใจที่เกิดจากตัวผู้  เรียน
เองด้วย ครูอาจใช้วิธีการสนทนา ซักถา ทายปัญหา หรือมีวัสดุอุปกรณ์ต่างๆ ที่กระตุ้นให้ผู้เรียนตื่นตัว 
และมีความสนใจที่จะเรียนรู้ 
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       ขั้นที่ 2 แจ้งจุดประสงค ์(Informing the Leaner of the Objective)  
เป็นการบอกให้ผู้เรียนทราบถึงเป้าหมายหรือผลที่จะได้รับจาการเรียนบทเรียน นั้นโดยเฉพาะ  
เพ่ือให้ผู้เรียนเห็นประโยชน์ในการเรียน เห็นแนวทางการจัดกิจกรรมการเรียนท าให้ผู้เรียนวางแผน 
การเรียนของตนเองได้ นอกจากนั้นยังสามารถช่วยให้ครูด าเนินการสอนตามแนวทางที่จะน าไปสู่
จุดหมายได ้เป็นอย่างดี 
       ขั้นที่ 3 กระตุ้นให้ผู้เรียนระลึกถึงความรู้เดิมที่จ าเป็น  (Stimulating Recall 
of Prerequisite Learned Capabilites) เป็นการทบทวนความรู้เดิมท่ีจ าเป็นต่อการเชื่อมโยงให้เกิด 
การเรียนรู้ความรู้ ใหม่ เนื่องจาการเรียนรู้เป็นกระบวนการต่อเนื่อง การเรียนรู้ความรู้ใหม่ต้องอาศัย
ความรู้เก่าเป็นพ้ืนฐาน 
      ขั้นที่ 4 เสนอบทเรียนใหม่ (Presenting the Stimulus) เป็นการเริ่ม
กิจกรรมของบทเรียนใหม่โดยใช้วัสดุ อุปกรณ์ต่างๆ  ที่เหมาะสมมาประกอบการสอน 
       ขั้นที่ 5 ให้แนวทางการเรียนรู้ (Providing Learning Guidance) 
เป็นการช่วยให้ผู้เรียนสามารถท ากิจกรรมด้วยตนเอง ครูอาจแนะน าวิธีกิจการกิจกรรม แนะน าแหล่ง
ค้นคว้าเป็นการน าทาง ให้แนวทางให้ผู้เรียนไปคิดเอง เป็นต้น 
       ขั้นที่ 6 ให้ลงมือปฏิบัติ (Elciting the Performance) เป็นการให้ผู้เรียนลง
มือปฏิบัติ เพ่ือช่วยให้ผู้เรียนสามารถแสดงพฤติกรรมตามจุดประสงค์ 
       ขั้นที่ 7 ให้ข้อมูลแอนกลับ (โeedback) เป็นขั้นที่ครูให้ข้อมูลเกี่ยวกับ 
ผลการปฏิบัติกิจกรรมหรือพฤติกรรมที่ผู้เรียน แสดงออกว่ามีความถูกต้องหรือไม่ อย่างไร และเพียงใด 
       ขั้นที่ 8 ประเมินพฤติกรรมการเรียนรู้ตามจุดประสงค์  (Assessing the 
Perfomance) เป็นขั้นการวัดและประเมินว่าผู้เรียนสามารถเรียนรู้ตามจุดประสงค์การเรียนรู้  
ของบทเรียนเพียงใด ซึ่งอาจวัดโดยการใช้ข้อสอบ แบบสังเกต การตรวจผลงาน หรือการสัมภาษณ์ 
แล้วแต่วาจุดประสงค์นั้นต้องการวัดด้านใด แต่สิ่งส าคัญ คือ เครื่องมือที่ใช้วัดต้องมีคุณภาพ เชื่อถือได้ 
และมีความเที่ยงตรงในการวัด 
      ขั้นที่ 9 ส่งเสริมความแม่นย าและการถ่ายโอนการเรียนรู้ (Enhancing 
Retention and Transfer) เป็นการสรุป การย้ า ทบทวนการเรียนที่ผ่านมา เพ่ือให้มีพฤติกรรม 
การเรียนรู้เพ่ิมข้ึน กิจกรรมในขั้นนี้อาจเป็นแบบฝึกหัด การให้ท ากิจกรรมเพ่ิมพูนความรู้ รวมทั้งการให้
ท าการบ้าน ท ารายงาน หรือหาความรู้เพิ่มเติมจากความรู้ที่ได้ในชั้นเรียน 
      โดยสรุปว่า นักจิตวิทยาและนักการศึกษาแบบพฤติกรรมนิยมกับพุทธินิยม  เขา  
อาศัยทฤษฎีที่หลากหลาย จากความรู้ที่มีหลากหลายประเภท สามารถเข้าใจได้อย่างรวดเร็ว ไม่ต้องใช้
ความคิดท่ีลึกซึ่ง ใช้การเรียนรู้จากง่ายไปหายาก  ในปัจจุบันแม้ว่าจะมีทฤษฎีใหม่ ๆ ขึ้นมามากแต่ก็ได้
ผสมผสานการเรียนรู้ ในการแสวงหาความรู้ของมนุษย์  ไม่ได้ ละทิ้งความรู้เก่า ๆ ไปเสียที่เดียวหลักการ
จัดการเรียนการสอนตามทฤษฏีนี้  คือ การจัดการเรียนรู้อย่างเป็นระบบซึ่งเริ่มจากง่ายไปหายาก 
มีทั้งหมด 9 ขั้น ดังนี้ 
      ขั้นที่ 1 สร้างความสนใจ (Gaining Attention) 
       ขั้นที่ 2 แจ้งจุดประสงค ์(Informing the Learning) 
       ขั้นที่ 3 กระตุ้นให้ผู้เรียนระลึกถึงความรู้เดิมที่จ าเป็น (Stimulating Recall 
of Prerequisite Learned Capabilities)  
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       ขั้นที่ 4 เสนอบทเรียนใหม่ (Presenting the Stimulus) 
       ขั้นที่ 5 ให้แนวทางการเรียนรู้ (Providing Learning Guidance) 
       ขั้นที่ 6 ให้ลงมือปฏิบัติ (Eliciting the Performance) 
       ขั้นที่ 7 ให้ข้อมูลป้อนกลับ (Feedback) 
       ขั้นที่ 8 ประเมินพฤติกรรมการเรียนรู้ตามจุดประสงค์ (Assessing the 
Performance) 
       ขั้นที่ 9 ส่งเสริมความแม่นย าและการถ่ายโอนการเรียนรู้ (Enhancing 
Retention and Transfer) 

    จากหลักการสอนที่กล่าวมาข้างต้นสามารถสรุปเป็นแผนภาพ ดังนี้ 
 

 
 
 
 

 
 
 
  

 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
ภาพประกอบ 2 รูปแบบการสอนของ Gagne 

Eliciting the Performance ให้ลงมือปฏิบัติ 

สร้างความสนใจ 

แจ้งจุดประสงค์ 

กระตุ้นให้ผู้เรียนระลึกถึง 
ความรู้เดิมท่ีจ าเป็น 

เสนอบทเรียนใหม่ 

ให้แนวทางการเรียนรู้ 

ให้ข้อมูลป้อนกลับ 

ประเมินพฤติกรรมการเรียนรู้ 
ตามจุดประสงค์ 

ส่งเสริมความแม่นย าและ 
การถ่ายโอนการเรียนรู้ 

Gaining Attention 

Informing the Learning 

Stimulating Recall of 
Prerequisite Learned 

capabilities 

Presenting the Stimulus 

Providing Learning 
Guidance 

Feedback 

 

Assessing the Performance 

Enhancing Retention  
and Transfer 
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   2. การประยุกต์ใช้แนวคิดของกานเย่ในการสร้างสื่อการเรียนการสอน 
    แนวคิดของกานเย่สามารถน ามาใช้ในระบบการเรียนการสอนได้โดยตรง  
โดยการสร้างสถานการณ์หรือเหตุการณ์เพ่ือสร้างความตั้งใจแก่ผู้เรียน เมื่อผู้เรียนเกิดความสนใจและ
ตั้งใจที่จะเรียนแล้ว ผู้สอนก็แจ้งวัตถุประสงค์ในการเรียนให้แก่ผู้เรียน  โดยพยายามเชื่อมโยงความรู้เดิม
ที่ได้เรียนมาก่อนหน้ากับความรู้ใหม่ให้เข้ากันได้  จากนั้นก็เสนอบทเรียนใหม่ มีการแนะน าชี้แนวทางใน
การเรียนเพื่อจะให้เกิดการเรียนรู้  สร้างกิจกรรมให้ผู้เรียนได้มีกิจกรรมที่ได้ปฏิบัติจริงและแจ้งผลการ
ปฏิบัติงานให้นิสิตทราบเป็นระยะเพ่ือเป็นการประเมินและมีการสรุปเสริมบทเรียนเพื่อสร้าง 
ความแม่นย าและการถ่ายโยงความรู้ไปใช้กับสิ่งอ่ืนๆ  ในโอกาสต่อไป  การน าแนวคิดของกานเย่ไปใช้ 
ในสร้างสื่อการสอน เช่น การสร้างบทเรียนคอมพิวเตอร์ช่วยสอน (CAI) และบทเรียนออนไลน์  
(E-learning) รายละเอียดดังตาราง 

  
ตาราง  3  การสร้างบทเรียนคอมพิวเตอร์ช่วยสอน (CAI) และบทเรียนออนไลน์ (E-learning) 

 
ขั้นการออกแบบของกานเย่ บทเรียนคอมพิวเตอร์ช่วยสอน บทเรียนออนไลน์ 
สร้างความสนใจ 
(Gaining Attention) 

ผู้เรียนพบกับหน้าจอภาพเคลื่อนไหวที่
ประกอบด้วยภาพ เสียง และวีดีโอ และ 
สื่อมัลติมีเดียอ่ืนๆ ที่น่าสนใจ 

การใช้มัลติมีเดียส่วนของการ
ประกาศต่างๆ การอภิปรายใน
เรื่องปัจจุบัน การเสนอแนะ
เว็บไซต์ 

แจ้งจุดประสงค์ 
(Informing the Learning) 

หน้าจอเปลี่ยนเป็นภาพผู้บรรยาย 
ออกมาชี้แนะวิธีการใช้งานและบอก
วัตถุประสงค์ โดยใช้ภาพที่เหมาะสมกับ
ผู้เรียน 

การก าหนดหลักสูตร รายวิชา    
เค้าโครงรายวิชาหลัก 

กระตุ้นให้ผู้เรียนระลึกถึง
ความรู้เดิมที่จ าเป็น 
(Stimulating Recall of 
Prerequisite Learned 
Capabilities) 

บทเรียนแสดงภาพหรือวีดีโอบรรยาย
สรุปความรู้พื้นฐานที่ส าคัญของเนื้อหา
และแนวคิด 

การเริ่มด้วยการทดสอบ 
สนอง การอภิปรายทาง
อิเล็กทรอนิกส์ของหัวข้อเดิม 

เสนอบทเรียนใหม่ 
(Presenting the Stimulus) 

บทเรียนแสดงเมน ูที่ให้ผู้เรียนเลือกได้ว่า 
อยากจะศึกษาเรื่องไดๆ ได้ตามอัธยาศัย 

กิจกรรมต่างๆ สถานการณ์
จ าลอง เสียง/ภาพ โมดูล  และ
ภาพเคลื่อนไหว เป็นต้น 

ให้แนวทางการเรียนรู้ 
(Providing Learning  
Guidance) 

ในบทเรียนมีการออกแบบให้บทเรียนมี
ความสัมพันธ์กันของเนื้อหาความรู้ และ
มีการเรียงล าดับเนื้อหาอย่างเป็นระบบ 

เค้าโครงรายวิชาหลัก  
การมอบหมายงานต่างๆ 
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ตาราง  3 (ต่อ)  
 
ขั้นการออกแบบของกานเย่ บทเรียนคอมพิวเตอร์ช่วยสอน บทเรียนออนไลน์ 
ให้ลงมือปฏิบัติ (Eliciting  
the Performance) 

ส่งเสริมให้ผู้เรียนได้มีโอกาสตอบสนอง
ต่อบทเรียนด้วยวิธีตอบค าถาม  
ท าแบบทดสอบ ร่วมทดลองใน
สถานการณ์จ าลอง หรือให้มีปฏิสัมพันธ์
กับบทเรียนให้มาก ผู้เรียนได้มีโอกาสใน
การพิมพ์ค าตอบหรือเติมข้อความสั้นๆ 
เพ่ือเรียกความสนใจ 

การส ารวจความสามารถของ
ผู้เรียนทาง Web  การอภิปราย
และทดสอบ ผู้เรียนยอมรับการ
ท างานทางอิเล็กทรอนิกส์ 
 

ให้ข้อมูลป้อนกลับ  
(Feedback) 

บทเรียนมีการให้ข้อมูลย้อนกลับอย่าง
เหมาะสมโดยมีการให้ท าแบบฝึกหัดและ 
เฉลยทันที มีการเสริมแรง เพ่ือให้ได้
พฤติกรรมที่ต้องการจะให้เกิด 

การอภิปรายทางอิเล็กทรอนิกส์
และการตอบสนองผ่าน  
E-mail E-Document 
 

ประเมินพฤติกรรมการเรียน 
รู้ตามจุดประสงค์ (Assessing 
the Performance) 

บทเรียนน าเสนอแบบทดสอบหลังเรียน การทดสอบผ่าน Online  
การทบทวนแฟ้มสะสมงานของ
ผู้เรียนส่งผลโดยใช้  
E-mail ตอบกลับไปยังผู้เรียน 

ส่งเสริมความแม่นย าและ 
การถ่ายโอนการเรียนรู้ 
(Enhancing Retention 
and Transfer) 

หลังจากท าแบบทดสอบแล้ว บทเรียน
น าเสนอข้อมูลและบทสรุปของเนื้อหาที่
ได้เรียนให้แก่ผู้เรียนเพื่อเป็นการทบทวน
ความจ า และน าไปใช้งานได้ 

การวิจัยทาง Web ช่วย
สนับสนุนการคิดเชิงวิพากษ์   
การท างานร่วมกันฝึก 
การแก้ปัญหาโดยใช้กรณีศึกษา  
แฟ้มสะสมงานแบบ  
Web-based ใช้เทคโนโลยีใน 
การท างาน 

 
เครือข่ายอินเทอร์เน็ตและบทเรียนออนไลน์  
 
  1. เครือข่ายอินเทอร์เน็ต 
  1.1 ความหมายของเครือข่ายอินเทอร์เน็ต 
   พิศาล  พิทยาธุรวิวัฒน์   (2551  :  29-30) ได้ให้ความหมายว่า อินเทอร์เน็ตเป็นระบบ
เครือข่ายที่เชื่อมโยงคอมพิวเตอร์และใช้โปรโตคอล TCP/IP เช่นเดียวกับอินเทอร์เน็ต แต่เครือข่าย
อินทราเน็ตเป็นระบบเครือข่ายที่อยู่ภายในองค์กร ไม่ได้เผยแพร่ข้อมูลออกสู่โลกภายนอกเหมือน
อินเทอร์เน็ต โดยมีเทคโนโลยีที่คอยให้บริการเหมือนอินเทอร์เน็ต เช่น มี Web Server ให้บริการ
เว็บไซต์ มี Mail Servwer ไว้บริการจดหมายอีเล็กทรอนิกส์ภายในองค์กร ระบบ FTP ส าหรับถ่ายโอน
ไฟล์ระบบ DSN ส าหรับแปลงชื่อโดเมนเป็นหมายเลขไอพีแอดเดรสและอ่ืนๆ ที่อินเทอร์เน็ตท าได้   
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ซึ่งอาจเข้ามาทางอินเทอร์เน็ตหรือเชื่อมต่อตรงเข้ามาโดยใช้โมเด็ม แต่จะถูกควบคุมให้มีสิทธิ์ที่พึงได้รับ
เท่านั้น 
   พิมพวลัญช  นันทัยทวีกุล  (2551) ได้ให้ความหมายว่า บทเรียนบนเครือขาย  
เปนการจัดสภาพการเรียนการสอนที่ไดรับการออกแบบอยางมีระบบโดยอาศัยคุณสมบัติและทรัพยากร
ของเวิลดไวดเว็บมาเปนสื่อกลางในการถายทอดเพ่ือสงเสริมสนับสนุนการเรียนการสอนใหมี
ประสิทธิภาพ โดยอาจจัดเป็นการเรียนการสอนทั้งกระบวนการหรือน ามาใชเปนเพียงสวนหนึ่งของ
กระบวนการทั้งหมด การเรียนการสอนผานเว็บจึงถือเปนวิธีการใหมที่ชวยสงเสริมพัฒนาใหเกิดการเรียน
รแูละชวยขจัดปญหาเรื่องอุปสรรคของการเรียนการสอนทางดานสถานที่และเวลาอีกดวย 
    ชุณหพงศ์  ไทยอุปถัมภ์ (2552) ได้ให้ความหมายว่า บทเรียนบนเครือข่ายนเทอร์เน็ต 
หรือ Electronic Learning หมายถึง รูปแบบการเรียนการสอนแบบใหม่ท่ีมีการประยุกต์ใช้เทคโนโลยี
สื่ออิเล็กทรอนิกส์สมัยใหม่ มีวัตถุประสงค์ท่ีเอ้ืออ านวยให้ผู้เรียนสามารถเรียนรู้องค์ความรู้ 
(Knowledge) ได้โดยไม่จ ากัดเวลาและสถานที่ (Anywhere-Anytime Learning) เพ่ือให้ระบบ 
การเรียนการสอนเป็นไปได้อย่างมีประสิทธิภาพมากขึ้น และเพ่ือให้ผู้เรียนสามารถบรรลุวัตถุประสงค์
ของกระบวนวิชาที่เรียนนั้น ๆ  
   สรุปได้ว่า ระบบเครือข่ายอินทราเน็ต หมายถึง ระบบการเชื่อมต่อคอมพิวเตอร์ตั้งแต่ 2  
เครื่องขึ้นไป เพ่ือวัตถุประสงค์ในการใช้งานทรัพยากรที่มีอยู่ร่วมกันในการแลกเปลี่ยนเรียนรู้โดยอาศัย 
การเชื่อมต่อผ่านสายเคเบิลระบบโทรศัพท์ คลื่นวิทยุ หรือเครือข่ายไร้สาย ภายในอกองค์กรที่น าการให้ 
บริการต่างๆ เช่นเดียวกับเครือข่ายอินเทอร์เน็ตโดยน ามาประยุกต์ใช้ภายในองค์กร ซ่ึงบุคคลภายนอก  
องค์กรไม่สามารถเข้าถึงได้ 
   1.2 การใช้เครือข่ายอินเทอร์เน็ตเพื่อการเรียนการสอน  
   ธนากร  ขติยะสุนทร  (2553) เมื่อการสอนผ่านเครือข่ายอินเทอร์เน็ตเป็นที่นิยมกัน
อย่างมากจึงได้ถูกน ามาใช้กับการสอนในหลายรูปแบบเช่น การจัดการเรียนการสอนผ่านเว็บ  
(web – based struction), การจัดการเรียนการสอนรายวิชาผ่านเว็บ (web – based course), 
ฝึกอบรมผ่านเว็บ (web – based training), เว็บการเรียน (web – based learning), เวิลด์ไวด์เว็บ
ช่วยสอน (WWW – based instruction), การเรียนการสอนผ่านเครือข่าย (online instruction)  
และการเรียนการสอนผ่านสื่ออิเล็กทรอนิกส์  (e-learning) เป็นต้น การใช้นวัตกรรมดังกล่าว  
ท าให้ผู้เรียนสามารถมีปฏิสัมพันธ์ร่วมกันท างานร่วมกันและเปิดโอกาสให้ผู้เรียนคิดแบบสร้างสรรค์
ลักษณะเช่นนี้เป็นการเปลี่ยนแปลงกระบวนทัศน์ทางการเรียนการสอน การเรียนการสอนผ่านเครือข่าย
อินเทอร์เน็ต หรือการสอนบนเว็บสามารถใช้ได้ดีกับวิชาต่างๆ โดยอาจเป็นการใช้เว็บเพื่อสอนวิชา
ทั้งหมดหรือเพ่ือใช้ประกอบเนื้อหาวิชาก็ได้ซึ่งมีหลากหลายรูปแบบตามวัตถุประสงค์  การเรียนการสอน
ตามแนวคิดของ พาร์สัน (Parson.    1997) ได้แบ่งประเภทของส าหรับจัดกิจกรรมการเรียนการสอน
ออกเป็น 3 ลักษณะ คือ 
    1.2.1 เว็บช่วยสอนแบบรายวิชาอย่างเดียว (stand – alone courses)  
เป็นรายวิชาที่มีเครื่องมือและแหล่งที่เข้าไปถึงและเข้าหาได้โดยผ่านระบบอินเทอร์เน็ตอย่างมากที่สุด  
ถ้าไม่มีการสื่อสารก็สามารถท่ีจะไปผ่านระบบคอมพิวเตอร์สื่อสารได้  ลักษณะของเว็บช่วยสอนแบบนี้มี
ลักษณะเป็นแบบวิทยาเขตมีนักศึกษาจ านวนมากที่เข้ามาใช้จริงแต่จะมีการส่งข้อมูลจากรายวิชาทางไกล 
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    1.2.2 เว็บช่วยสอนแบบเว็บสนับสนุนรายวิชา (Web – supported courses)  
เป็นรายวิชาที่มีลักษณะเป็นรูปธรรมที่มีการพบปะระหว่างผู้สอนกับผู้เรียน และมีแหล่งให้มากเช่น  
การก าหนดงานที่ให้ท าบนเว็บ การก าหนดให้อ่าน การสื่อสารผ่านระบบคอมพิวเตอร์ หรือการมีเว็บ  
ที่สามารถชี้ต าแหน่งของแหล่งบนพ้ืนที่ของเว็บไซต์โดยรวมกิจกรรมต่างๆ เอาไว้   
    1.2.3 เว็บช่วยสอนแบบศูนย์การศึกษา (web pedagogical resources) เป็นชนิด
ของเว็บไซต์ที่มีสื่อการเรียนรู้ เครื่องมือช่วยซึ่งสามารถรวบรวมรายวิชาขนาดใหญ่เข้าไว้ด้วยกัน หรือ 
เป็นแหล่งสนับสนุนกิจกรรมทางการศึกษาซึ่งผู้ที่เข้ามาใช้ก็จะมีสื่อให้บริการ เช่น เป็นข้อความเป็น
ภาพกราฟิกการสื่อสารระหว่างบุคคลและการท าภาพเคลื่อนไหวต่างๆ เป็นต้น 

   สรุปได้ว่า การเรียนการสอนผ่านเว็บหรือเครือข่ายเป็นการจัดสภาพการเรียนการสอน
ที่ได้รับการออกแบบอย่างมีระบบ โดยอาศัยคุณสมบัติและทรัพยากรของเวิลด์ไวด์เว็บมาเป็นสื่อกลาง  
ในการถ่ายทอดเพ่ือส่งเสริมสนับสนุนการเรียนการสอนให้มีประสิทธิภาพ โดยอาจจัด เป็นการเรียน 
การสอนทั้งกระบวนการหรือน ามาใช้เป็นเพียงส่วนหนึ่งของกระบวนการทั้งหมด การเรียน กาสอนผ่าน
เว็บจึงถือเป็นวิธีการใหม่ท่ีช่วยส่งเสริมพัฒนาให้เกิดการเรียนรู้ และช่วยขจัดปัญหา เรื่องอุปสรรคของ
การเรียนการสอนทางด้านสถานที่และเวลาอีกด้วย 
  1.3 รูปแบบของการเรียนการสอนในเครือข่ายอินเทอร์เน็ต 
   ในการจัดกิจกรรมต่างๆ ข้างตนนั้นผู้สอนควรเลือกรูปแบบเทคโนโลยีที่เหมาะสมใน
ช่วงเวลาที่ผ่านมามีรูปแบบที่น่าสนใจมากมายในบทความนี้จะขอกล่าวถึง 3 รูปแบบที่น ามาเป็นวิธีการ
สอนได้อย่างน่าสนใจ คือ การจัดการสอนด้วยระบบบริหารจัดการเรียนรู้ วิกิสเปซและเว็บบล็อก 
    ภูดิท  จุลโพธิ ์ (2551) ได้กล่าวถึงระบบบริหารจัดการการเรียนรู้ไว้ว่า  
     1. การจัดการสอนด้วยระบบบริหารจัดการเรียนรู้ (LMS: Learning 
Management System)  เป็นระบบที่ใช้ในการบริหารและสร้างบทเรียนแบบส าเร็จรูป (e-learning) 
ผู้ใช้งานไม่จ าเป็นต้องมีความสามารถในการเขียนโปรแกรมก็สามารถสร้างบทเรียนหรือระบบ 
e - learning  ใช้งานในหน่วยงานได้ ซึ่งระบบบริหารจัดการการเรียนรู้เป็นเครื่องมือหนึ่งที่ช่วยสร้าง
ระบบเรียนรู้ในหน่วยงาน  การที่จะให้ระบบใช้งานได้อย่างสมบูรณ์ต้องอาศัยอาจารย์หรือผู้ใส่บทเรียน
หรือเนื้อหา (Content) เข้าไปในระบบและมีการประเมินผู้เรียนอย่างต่อเนื่องระบบบริหารจัดการการ
เรียนรู้นับว่าเป็นระบบที่มีเครื่องมือส าหรับการจัดการการเรียนการสอนในหลายๆ ด้านได้แก่ 
      1.1 เครื่องมือส าหรับผู้สอนเพื่อน าเนื้อหาในรายวิชาที่มีอยู่แล้ว 
(Courseware) ในรูปแบบไฟล์เอกสาร ไฟล์ภาพหรือภาพเคลื่อนไหว ส่งต่อให้แก่ผู้เรียน 
      1.2 เครื่องมือส าหรับผู้สอนใช้ส าหรับประกาศเก่ียวกับกิจกรรมการเรียน 
การสอนรวมไปถึงก าหนดการในรายวิชาให้แก่ผู้เรียน (Announcement) 
      1.3 เครื่องมือการติดต่อสื่อสารระหว่างผู้สอนและผู้เรียน เช่น กระดานข่าว 
(Web Board) และห้องสนทนา (Chat Room)  
      1.4 เครื่องมือในการเก็บสถิติต่างๆ ของผู้เรียน (Student Progress 
Tracking)  เช่น การตรวจสอบจ านวนผู้มาเข้าเรียน และเก็บสถิติการเข้าใช้ เป็นต้น  
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     2. การจัดการเรียนการสอนด้วยวิกิ (Wiki) ในปัจจุบันนี้ มีการสอนออนไลน์
รูปแบบใหม่คือ วิกิซ่ึงเป็นเว็บไซต์ประเภทหนึ่งที่ช่วยให้ผู้ใช้งานสามารถใส่เนื้อหา เพ่ิมหรือแก้ไขเนื้อหา
ได้โดยง่ายซึ่งบางครั้งไม่จ าเป็นต้องมีการลงทะเบียนเพื่อแก้ไขด้วยความง่ายในการแก้ไขและโต้ตอบ 
วิกิเว็บไซตม์ักจะถูกน ามาใช้ในการเขียนงานร่วมกัน ดังนั้นผู้อ่านจึงกลายเป็นผู้เขียนและบรรณาธิการ 
Thomas (2008) โดยรูปแบบการสอนจะเริ่มจากการให้นักศึกษาจัดหาสมาชิกในกลุ่มของตนแล้ว
ด าเนินการสร้างเว็บโดยใช้พื้นที่หรือสเปซของวิกิประกอบด้วยโฮมเพจและหน้าอื่นๆ หลังจากนั้น
นักศึกษาจะใส่ข้อมูลต่างๆ  เกี่ยวกับสมาชิกในกลุ่ม ส่วนอาจารย์ใส่งานที่มอบหมายให้ท านักศึกษาจะเข้า
ไปมีปฏิสัมพันธ์กันแลกเปลี่ยนความคิดเห็นในหน้าต่างๆ ของวิกิถกเถียงกันผ่านทางวิกิโดยไม่ต้องมาเจอ
หน้ากัน ซึ่งการมีปฏิสัมพันธ์ระหว่างเรียนนี้ถือเป็นหัวใจของการสอนออนไลน์  (ชุติมา  สัจจานนท์.    
2550) ผู้สอนจึงต้องจัดกิจกรรมปฏิสัมพันธ์อย่างต่อเนื่องและส่งเสริมให้ผู้เรียนมีส่วนร่วมระหว่างเรียน 
นอกจากนี้ อาจารย์สามารถเข้าไปอ่านงานและแสดงความคิดเห็น (Carr et al.    2007) วิกิจึงเป็น
วิธีการหนึ่งที่จะช่วยให้ผู้เรียนสามารถประยุกต์ใช้เทคโนโลยีด้านคอมพิวเตอร์ต่างๆ ในการแสวงหา
ความรู้เพิ่มเติมจากบทเรียน สรุปได้ว่าวิกิเป็นเครื่องมือในการสร้างกิจกรรมการแลกเปลี่ยนเรียนรู้  
แบบร่วมมือกันท าให้เกิดองค์ความรู้ใหม่ได้เนื่องจากหลักการของวิกิคือการให้เสรีแก่ผู้ใช้ในการสร้าง  
และแก้ไขเนื้อหาในระบบอีเลิร์นนิ่ง ผู้สอนจึงใช้วิกิเป็นเครื่องมือในการสร้างกิจกรรมการเรียนรู้ใน
รูปแบบต่างๆ เช่น การมอบหมายงานเป็นกลุ่ม (Group Assignment) การเรียนการสอนโดยใช้โครงการ
เป็นฐาน (Project - based Learning) การเรียนรู้แบบสรรค์สร้างองค์ความรู้ (Constructivist 
Learning) และการเรียนรู้แบบร่วมมือหรือการเรียนรู้แบบร่วมงาน  (Cooperative/Collaborative 
Learning) (ศิริชัย นามบุรี.    2551) 
     3. การพัฒนาทักษะความรู้ผ่านเว็บบล็อก (Web Blog) เว็บบล็อกเป็นเครื่องมือ
ในการจัดการความรู้เป็นกระบวนการในการบริหารความรู้ที่มีอยู่มิให้สูญหายโดยการถ่ายทอดและ 
รักษาองค์ความรู้นั้นด้วยวิธีการหรือกระบวนการที่มีประสิทธิภาพในเก็บรักษาและถ่ายทอดความรู้นั้นๆ  
ไปสู่บุคคลอื่นความรู้ที่เป็นประโยชน์ควรถ่ายทอดจากผู้ที่เกี่ยวข้องเพ่ือแลกเปลี่ยนประสบการณ์และต่อ
ยอดความรู้การใช้เว็บบล็อกซ่ึงปัจจุบันเป็นเครื่องมือที่เป็นที่นิยมใช้กันในหลายสถาบันการศึกษา ได้ถูก
สร้างข้ึนเพื่อเป็นระบบการจัดการความรู้ แลกเปลี่ยนความรู้ ความคิดประสบการณ์ เทคนิคการท างาน
ความรู้เชิงปฏิบัติร่วมกัน บุคคลสามารถบันทึกเรื่องราวที่ตนถนัดหรือสนใจ มีการปรับปรุงเนื้อหา 
สม่ าเสมอสามารถเรียงล าดับย้อนตามวัน เวลาการเขียน มีการแยกย่อยเป็นกลุ่มๆ ตามหัวข้อหลักและ 
มีการเสนอความคิดเห็นต่างๆ เพ่ิมเติม การสร้างบล็อกเพ่ือประยุกต์ใช้ในการเรียนการสอนนั้นถือเป็นสื่อ
การเรียนการสอนอีกหนึ่งวิธีนอกเหนือจากการสอนแบบปกติในห้องเรียน ผู้เรียนสามารถศึกษาหา
ความรู้เพิ่มเติมจากในบล็อก ซึ่งผู้สอนได้ใส่รายละเอียดเนื้อหาสาระ เช่น ในรายวิชา ทีผู่้สอนอาจสร้าง
เว็บบล็อกอธิบายรายละเอียดเกี่ยวกับ รายละเอียดต่างๆ และหากผู้เรียนศึกษาในรายละเอียดแล้วไม่
เข้าใจ ผู้เรียนสามารถตั้งค าถามไปยังผู้สอน โดยผู้เรียนกล้าที่จะถาม เพราะผู้เรียนและผู้สอนไม่เห็นหน้า
ซึ่งกันและกัน 
    สรุปได้ว่า การออกแบบการเรียนการสอนของรายวิชา รูปแบบการเรียนการสอนจึง
เป็นในลักษณะเชิงระบบ ในการออกแบบส าหรับการเรียนการสอนทั้งคอร์ส (รายวิชา) หรือทั้งหลักสูตร  
การวิเคราะห์ความต้องการมีความจ าเป็นอย่างมาก จะต้องใช้ทรัพยากรในการพัฒนาสูงและต้องการ 
การท างานเป็นทีม โดยทีมการพัฒนาต้องมีประสบการณ์ในการออกแบบการสอนมาก่อนในระดับสูงถึง
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สูงมาก ส่วนการออกแบบสื่อจะใช้วิธีการพัฒนาขึ้นเองให้มากกว่าการเลือกสื่อที่มีอยู่แล้วความซับซ้อน
ของเทคโนโลยีที่เก่ียวข้องกับการออกแบบอยู่ในชั้นปานกลางถึงสูง และเม่ือออกแบบพัฒนาแล้ว 
การน าไปทดสอบและปรับปรุงรวมทั้งปริมาณการเผยแพร่อยู่ในระดับปานกลางถึงสูง  
  1.4 การออกแบบกิจกรรมการเรียนการสอนในเครือข่ายอินเทอร์เน็ต 
   อนิรุทธ์  สติมั่น  (2550)  ได้น าเสนอแนวทางจัดกิจกรรมการเรียนที่ค านึงถึง 
ความแตกต่างระหว่างบุคคลช่วยส่งเสริมให้ผู้เรียนได้สัมผัสและสัมพันธ์กับสิ่งแวดล้อมทั้งที่เป็นเพ่ือน
มนุษย์ธรรมชาติ และเทคโนโลยี ผู้เรียนได้ค้นคว้าทดลอง ฝึกปฏิบัติแลกเปลี่ยนเรียนรู้กับผู้อื่น ได้ฝึกวิธี
คิดวิเคราะห์สร้างสรรค์จินตนาการและสามารถแสดงออกได้ชัดเจนอย่างมีเหตุผลผู้เรียนมีโอกาสฝึก  
การประเมินและปรับปรุงตนเอง ยอมรับผู้อ่ืน สร้างจิตส านึกในความเป็นพลเมืองดีกิจกรรมการเรียน 
การสอนผ่านทางระบบเครือข่ายคอมพิวเตอร์ไว้ดังนี้  คือ 
    1. กิจกรรมการสนทนา (Chat) ระหว่างผู้เรียนกับผู้เรียนและระหว่างผู้เรียนกับ
ผู้สอน 
    2. กิจกรรมอภิปรายกลุ่มในเว็บเพจการอภิปราย (Discussion) เพ่ือแลกเปลี่ยน
ความคิดเห็นซึ่งกันและกันผ่านเว็บบอร์ด (Web Board) 
    3. กิจกรรมตอบปัญหาซึ่งสามารถถามและตอบปัญหาได้ภายในเว็บเพจที่ออกแบบ
ไว้ส าหรับการถาม – ตอบ (FAQ) Web Board หรือ e-mail ซึ่งการตอบปัญหานั้น ผู้เรียนก็สามารถ
ตอบค าถามที่ตนเองทราบค าตอบได้ 
    4. แนะน าให้ผู้เรียนศึกษาค้นคว้าด้วยตนเองเพ่ือให้เกิดการเรียนรู้ด้วยการค้นพบ
และสนับสนุนให้ผู้เรียนพัฒนาศักยภาพในการเรียนรู้อย่างเต็มท่ีโดยโยงไปสู่การค้นหาข้อมูลในเว็บเพจ 
ที่เป็นแหล่งข้อมูล (Resource) ซึ่งได้แก่ 
     4.1. โยงไปเว็บไซต์และแหล่งข้อมูลที่ให้บริการความรู้ ข้อมูล สารสนเทศ 
     4.2. โยงไปถ่ายโอนแฟ้มข้อมูลจากแหล่งข้อมูลที่ให้บริการถ่ายโอนข้อมูล  
(FTP Server) 
     4.3. โยงไปห้องสมุดเสมือนศูนย์ข้อมูลสารสนเทศเพ่ือ ดูหนังสือ สิ่งพิมพ์ 
อิเล็กทรอนิกส์ วีดิทัศน์ และสื่อการศึกษาประเภทต่างๆ 
    5. เสนอกิจกรรมแบบฝึกหัดและการบ้านพร้อมทั้งจัดกิจกรรมเสริมทักษะการเรียน
ด้วยตนเองการเรียนแบบร่วมมือการท างานกลุ่ม การเรียนรายบุคคล ให้ผู้เรียนได้มีปฏิสัมพันธ์กับ
สิ่งแวดล้อมและทรัพยากรทางการเรียน โดยผู้เรียนจะเกิดการเรียนรู้ด้วยตัวของผู้เรียนเอง 
    6. ให้ผู้เรียนท ากิจกรรมและแบบฝึกหัดต่างๆ ส่งแฟ้มงานให้กับผู้สอนทางไปรษณีย์
อิเล็กทรอนิกส์และน าเสนอในเว็บเพจผู้เรียนเพื่อให้ผู้เรียนคนอื่นๆ ได้แลกเปลี่ยนความรู้และ 
ความคิดเห็นเกี่ยวกับผลงานที่น าเสนอเป็นการขยายฐานความรู้ให้กว้างขวางออกไปมากยิ่งขึ้น 
    7. อาจารย์ตรวจผลงานของผู้เรียนแล้วส่งผลคะแนนและข้อมูลป้อนกลับทาง
ไปรษณีย์อิเล็กทรอนิกส์ ในการจัดกิจกรรมต่างๆ ข้างตนนั้น ผู้สอนควรเลือกรูปแบบเทคโนโลยีที่
เหมาะสมในช่วงเวลาที่ผ่านมามีรูปแบบที่น่าสนใจมากมาย  
   สรุปได้ว่า ความรู้และทักษะที่จ าเป็นของครูผู้สอน การใช้ระบบเครือข่ายคอมพิวเตอร์
เป็นประโยชน์ต่อการศึกษาโดยตรง เพราะเป็นการใช้เทคโนโลยีการสื่อสารผ่านเครื่องคอมพิวเตอร์มา
แก้ปัญหาทางการศึกษา ประโยชน์ของการใช้ระบบเครือข่ายคอมพิวเตอร์ คือความสามารถใน 
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การสื่อสารที่หลากหลายระหว่างที่มีกิจกรรมทางเครือข่าย เหตุผลนี้สอดคล้องกับความสามารถและ 
การจัดการเพ่ือการแลกเปลี่ยนข้อมูล ระหว่างสถานที่หนึ่งไปยังสมาชิกที่อยู่ ณ สถานที่อ่ืน ความจ าเป็น
ที่พึงระวังของผู้ใช้ในระบบเครือข่ายคอมพิวเตอร์  และการเปลี่ยนข้อมูลระหว่างสมาชิก 
  2. บทเรียนออนไลน์ (E-Learning) 
  2.1 ความหมายของบทเรียนออนไลน์ (E-Learning) 
   บทเรียนออนไลน์ (E-Learning) เป็นรูปแบบหนึ่งของบริการเครือข่ายอินเทอร์เน็ต 
ที่นักการศึกษาให้ความสนใจเป็นอย่างมากในปัจจุบัน เป็นความพยายามในการใช้คุณสมบัติต่างๆ ของ
อินเทอร์เน็ตมาสนับสนุนการจัดการการเรียนการสอนเพื่อให้เกิดประสิทธิภาพสูงสุด ซึ่งนักวิชาการและ
นักการศึกษาได้ให้ความหมายของบทเรียนออนไลน์ ดังนี้  
    สุรสิทธิ์ วรรณไกรโรจน์  (2551) ผู้อ านวยการโครงการการเรียนรู้แบบออนไลน์แห่ง 
สวทช. หรือส านักงานพัฒนาวิทยาศาสตร์และเทคโนโลยีแห่งชาติ ได้ให้ความหมายไว้ว่า การเรียนแบบ
ออนไลน์ หรือ E-Learning ว่าคือ การศึกษา เรียนรู้ผ่านเครือข่ายคอมพิวเตอร์ อินเทอร์เน็ต (Internet)  
หรือ อินทราเน็ต (Intranet) เป็นการเรียนรู้ด้วยตัวเอง ผู้เรียนจะได้เรียนตามความสามารถ และความ
สนใจของตน โดยเนื้อหาของบทเรียนซึ่งประกอบด้วย ข้อความ รูปภาพ เสียงวิดีโอและ มัลติมีเดียอ่ืนๆ 
จะถูกส่งไปยังผู้เรียนผ่าน Web Browser โดยผู้เรียน ผู้สอนและเพ่ือนร่วมชั้นเรียน  
ทุกคนสามารถ ติดต่อปรึกษา แลกเปลี่ยนความคิดเห็นระหว่างกันได้เช่นเดียวกบการเรียน ในชั้นเรียน
ปกต ิโดยอาศัยเครื่อง มือการติดต่อ สื่อสารที่ทันสมัย (E-mail, Web-board, Chat) จึงเป็นการเรียน
ส าหรับทุกคน, เรียนได้ ทุกเวลา และทุกสถานที่ 
    ใจทิพย์  ณ สงขลา  (2554  :  10) ได้ให้ความหมายว่า การเรียนการสอนบนเว็บ 
(Web Based Instruction WBI) หมายถึง การใช้คุณสมบัติไฮเปอร์มีเดีย และคอมพิวเตอร์เครือข่าย  
ซึ่งรวมทั้งเครื่องมือสื่อสารในการสร้างสรรค์สร้างกิจกรรมการเรียนการสอนที่หวังผลการเรียนรู้เชิง
วิชาการในรูปแบบต่าง ๆ  
    ฮอร์ตัน (Horton.    2012  :  18) ได้ให้ความหมายว่า E-Learning ตามท่ีได้กล่าว
ไว้ว่า “อีเลิร์นนิ่ง” คือการใช้เทคโนโลยีสื่ออิเล็กทรอนิกส์ในการสร้างสรรค์ประสบการณ์ทางการเรียนรู้   
(e-Learning is the use of Electronics Technology to Create Learning Experiences)  
    จากความหมายดังกล่าว บทเรียนออนไลน์จึงเป็นการเรียนในยุคสมัยที่เทคโนโลยี
คอมพิวเตอร์และเทคโนโลยีการสื่อสารมีบทบาทในการศึกษา โดยมีพัฒนาการไปตามความก้าวหน้าของ
เทคโนโลยีดังกล่าวที่มีอยู่ในอินเทอร์เน็ต ครอบคลุมการเรียนในหลายรูปแบบ ทั้งการเรียนทางไกล และ
เรียนผ่านเครือข่าย  
  2.2 องค์ประกอบของบทเรียนออนไลน์ (E-Learning)  
   จินตวีร์ คล้ายสังข ์ (2555  :  2 - 4) การเรียนการสอนแบบอีเลิร์นนิ่ง (E-Learning) 
จะมีองค์ประกอบส าคัญ 4 ส่วนด้วยกันกล่าวคือการสอนแบบอีเลิร์นนิ่งจะประกอบไปด้วยองค์ประกอบ
ส าคัญต่อไปนี้  
    1. บทเรียนอิเล็กทรอนิกส์ เป็นเนื้อหาสาระที่น าเสนอในรูปแบบสื่ออิเล็กทรอนิกส์ 
ส่วนใหญ่เป็นสื่อประสมโดยแบ่งเนื้อหาออกเป็น 3 ลักษณะคือ การใช้ข้อความออนไลน์เป็นหลัก  
การใช้บทเรียนสื่อประสมแบบปฏิสัมพันธ์ และการใช้บทเรียนคุณภาพสูงจากการผลิตโดยผู้เชี่ยวชาญ
เฉพาะด้าน  
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    2. ระบบบริหารจัดการความรู้ คือ โปรแกรมการบริหารจัดการความรู้ที่ท าหน้าที่ 
เป็นศูนย์กลางการจัดและสนับสนุนการเรียนรู้ โดยใช้อินเทอร์เน็ตมาจัดการให้เกิดปฏิสัมพันธ์ระหว่าง
ผู้เรียนกับผู้สอน ผู้เรียนกับผู้เรียน และผู้เรียนกับแหล่งข้อมูล ทั้งนี้จะช่วยให้ผู้เรียนและผู้สอนเข้าถึง
เนื้อหาสาระได้ง่าย โดยมีเครื่องมือด้านการจัดการ การปรับปรุง การควบคุม การส ารองและสนับสนุน
ข้อมูล การบันทึกและการประเมินผล ซึ่งเครื่องมือในการจัดการการเรียนแบบอีเลิร์นนิ่ง สามารถจ าแนก
ออกได้เป็น 6 กลุ่มได้แก่  
     เครือ่งมือสื่อสาร (Communication Tools)  
     เครื่องมืออ านวยประโยชน์ (Productivity Tools)  
     เครื่องมือสนับสนุนผู้เรียน (Student Involvement Tools)  
     เครื่องมือบริหารรายวิชา (Administration Tools)  
     เครื่องมือส่งผ่านรายวิชา (Course Delivery Tools)  
     การออกแบบหลักสูตร (Curriculum Design)  
    3. การติดต่อสื่อสาร เป็นเครื่องมือช่วยผู้เรียนในการติดต่อสอบถาม ปรึกษาหารือ 
และแลกเปลี่ยนความคิดเห็นระหว่างผู้เรียนและผู้สอน และระหว่างผู้เรียนกับเพ่ือนร่วมชั้นเรียน  
โดยเครื่องมือที่ใช้จ าแนกออกเป็น 2 ลักษณะคือ เครื่องมือแบบประสานเวลา (Synchronous) และ
เครื่องมือแบบไม่ประสานเวลา (Asynchronous)  
    4. การประเมินผลการเรียน ในการเรียนแบบผสมผสานในบางรายวิชาต้องท าการ 
วัดระดับความรู้ก่อนเรียน (Pre-test)  เพ่ือให้ผู้เรียนได้เลือกเรียนในบทเรียนหรือหลักสูตรที่เหมาะสม
มากที่สุดจะท าให้เกิดประสิทธิภาพสูงสุด เมื่อเข้าสู่บทเรียนก็มีการสอบย่อย (Quiz) และสอบใหญ่ก่อน
จบหลักสูตร (Final Examination)  
   ไชยยศ  เรืองสุวรรณ  (2554  :  29) ระบบการจัดการเรียนการสอนที่ถือว่า  
เป็นการเรียนการสอนบนเว็บ จะมีองค์ประกอบดังต่อไปนี้    
    1. ความเป็นระบบ (Conditions Approach) ความเป็นระบบสามารถแบ่งออก 
พิจารณาได้ดังนี้   
     1.1 มีปัจจัยป้อนเข้า (Input) ได้แก่ ผู้เรียน ผู้สอน จุดประสงค์การเรียน  
สื่อการเรียนการสอน ฐานความรู้ การสื่อสารและกิจกรรม การประเมิน และอ่ืนๆ แล้วแต่สถานศึกษา 
จะก าหนดปัจจัยที่นอกเหนือจากนี้   
     1.2 มีกระบวนการ (Process) ได้แก่ การสร้างสถานการณ์หรือการจัดสภาวะ  
การเรียนการสอน โดยใช้วัตถุดิบจากการป้อนเข้า อย่างมีกลยุทธ์ หรือตามท่ีก าหนดไว้ในแผนการเรียน
การสอน   
     1.3 ผลลัพธ์ (Output) ได้แก่ ผลการเรียนรู้ ซึ่งอาจได้แก่ ผลสัมฤทธิ์ทาง  
การเรียนทักษะและความสามารถด้านต่างๆ เช่นทักษะการคิดวิเคราะห์ และการคิดสร้างสรรค์  
รวมทั้งความพอใจ และความคงทนในการเรียนรู้ เป็นต้นซึ่งได้จากการประเมินด้วยแบบทดสอบ แบบวัด
และแบบบันทึกพฤติกรรม ฯลฯ   
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    2. ความเป็นเงื่อนไข เงื่อนไข (Conditions) นับว่าเป็นส่วนประกอบส าคัญส าหรับ 
บทเรียนบนเว็บ เช่นก าหนดเงื่อนไขว่า เมื่อเสร็จสิ้นจากการเรียนแล้ว จะต้องท าแบบทดสอบย่อยหรือ
แบบประเมินการเรียน หากท าแบบทดสอบผ่านตามเกณฑ์ท่ีก าหนดไว้ ก็สามารถเข้าไปศึกษาบทเรียน 
ต่อไป หรือบทเรียนอื่นๆ ที่ยากขึ้นเป็นล าดับต่อไปได้ แต่ถ้าทดสอบไม่ผ่านตามเงื่อนไขที่ก าหนดจะต้อง
กลับมาเรียนซ้ าจนกว่าจะผ่านการทดสอบ   
    3. การสื่อสารหรือกิจกรรม การสื่อสารและกิจกรรม จะเป็นสิ่งที่กระตุ้น ให้ผู้เรียน 
มีปฏิสัมพันธ์ หรือเกิดการติดต่อสื่อสารขึ้นภายในสถานการณ์การเรียน โดยไม่ต่างไปจากห้องเรียนปกติ 
จึงอาจเรียกการเรียนการสอนบนเว็บว่า ห้องเรียนเสมือจริง (Virtual Classroom) ได้ กิจกรรมจะเป็น 
สิ่งที่ช่วยให้การเรียนเข้าสู่เป้าหมายได้ง่ายขึ้น เช่น ใช้ Mail Chat Web Board Search ฯลฯ  
ติดต่อผู้สอนหรือเพ่ือนร่วมชั้นเรียนเพ่ือถามข้อสงสัยได้เป็นอย่างดี    
  สรุปได้ว่า ผู้เรียนจะได้เรียนตามความสามารถและความสนใจของตน โดยเนื้อหาของ
บทเรียนซึ่งประกอบด้วย ข้อความ รูปภาพ เสียง วิดีโอและมัลติมีเดียอื่นๆ จะถูกส่งไปยังผู้เรียนผ่าน 
Web Browser โดยผู้เรียน ผู้สอน และเพ่ือนร่วมชั้นเรียนทุกคน สามารถติดต่อ ปรึกษา แลกเปลี่ยน
ความคิดเห็นระหว่างกันได้เช่นเดียวกับการเรียนในชั้นเรียนปกติ โดยอาศัยเครื่องมือการติดต่อ สื่อสาร 
ที่ทันสมัย (E - mail, Web - board, Chat) จึงเป็นการเรียนส าหรับทุกคน  เรียนได้ทุกเวลา และ 
ทุกสถานที่ 
   2.3 รูปแบบของการเรียนบทเรียนออนไลน์ (E-Learning) 
   Horton  (2012  :  2) อีเลิร์นนิ่ง (E–Learning) มีรูปแบบการจัดการเรียนรู้
หลากหลายรูปแบบจ าแนกออกเป็นลักษณะส าคัญได้ดังต่อไปนี้    
    1. การเรียนรู้เนื้อหาวิชาด้วยตนเอง (Standalone Courses) เป็นการเรียนรู้ด้วย
ตนเองโดยเป็นไปตามระดับความสามารถทางการเรียนของแต่ละบุคคล ทั้งนี้ลักษณะการเรียนรู้จะเกิด
ปฏิสัมพันธ์ทางการเรียนร่วมกับครูและเพ่ือนร่วมชั้นเรียนจากโปรแกรมวิชาและจากการสืบค้นข้อมูลทาง
อินเทอร์เน็ต  
    2. การเรียนรู้จากการใช้เกมและสถานการณ์จ าลอง (Learning Games and 
Simulations) การเรียนรู้จากการฝึกปฏิบัติจากเกมและสถานการณ์จ าลองเพ่ือสร้างองค์ความรู้ที่ได้ 
จากการเรียนแบบสืบค้นหรือทดลองจากโปรแกรมดังกล่าว  
    3. การเรียนรู้จากสื่อทางไกล (Mobile Learning) เป็นผลผลิตของอุปกรณ์ 
การสื่อสารรูปแบบต่างๆ ที่น ามาใช้ทั้งในรูปแบบเครื่องมือสื่อสารโทรศัพท์เคลื่อนที่  คอมพิวเตอร์พกพา
รวมทั้งสื่อ Tablet ซึ่งสื่อเหล่านี้สามารถเชื่อมโยงเครือข่ายการสื่อสารเพ่ือการเรียนรู้ระหว่างผู้เรียนได้  
    4. การเรียนรู้จากสื่อสังคมออนไลน์ (Social Learning) เป็นการเรียนรู้ผ่านสื่อ
สังคมออนไลน์รูปแบบต่างๆ เพ่ือการสร้างปฏิสัมพันธ์ระหว่างผู้เรียนและผู้สอนเช่น Blogs,  
Text-messages เป็นต้น  
    5. การเรียนรู้จากห้องเรียนเสมือน (Virtual-classroom Courses) เป็นลักษณะ
การเรียนรู้จากห้องเรียนที่จ าลองสถานการณ์คล้ายสภาพจริงจากวิทยาการด้านเทคโนโลยีคอมพิวเตอร์
และการสื่อสารทางไกลในการน าเสนอเนื้อหาสาระให้กับผู้เรียน  
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   ใจทิพย์ ณ สงขลา  (2550  :  15 – 27) กล่าวว่าการเรียนอิเล็กทรอนิกส์ (E-Learning) 
มีการออกแบบหลักสูตรจากหลักการและวิธีการจัดการี่แตกต่างกันไปตามความพร้อมของเทคโนโลยี
และผู้เรียน ตัวอย่างรูปแบบการเรียนแบบอิเล็กทรอนิกส์หรือ e - Learning ที่น ามาใช้ในปัจจุบันได้แก่  
    1. การเรียนแบบยืดหยุ่น (Flexible Learning : FL) หมายถึง ระบบการเรียนที่ให้
ความยืดหยุ่นกับผู้เรียนที่จะเลือกประสบการณ์การเรียนรู้ตามเวลาและสถานที่ท่ีเหมาะสมกับตนเอง  
โดยใช้แหล่งสาระความรู้ที่ตอบสนองความแตกต่างในวิธีการเรียนแต่ละคน (Learning Style)  
    2. โมบายเลิร์นนิ่ง (Mobile Learning : M-Learning) หมายถึง การใช้ประโยชน์
จากเทคโนโลยีการสื่อสารที่ง่ายต่อการพกพาเข้าสู่แหล่งการเรียนรู้โดยผ่านเครื่องมือสื่อสารแบบไร้สาย
โดยผู้เรียนไม่จ าเป็นต้องพ่ึงเครื่องคอมพิวเตอร์หรือเชื่อมโยงอินเทอร์เน็ต เป็นระบบที่ตอบสนองต่อ
ผู้เรียนได้ในทันที (Justin Time : JIT)  
    3. การเรียนแบบผสมผสาน (Blended Learning) หมายถึง การใช้ยุทธวิธีในการ
เรียนรู้ที่ใช้คอมพิวเตอร์เป็นสื่อหลัก และอาจครอบคลุมการใช้สื่อเทคโนโลยีหรือสื่อทุกชนิดทั้งสื่อวิทยุ 
โทรทัศน์ หรือสิ่งพิมพ์รวมทั้งการสอนในห้องเรียน  
    4. การเรียนโดยมีที่ปรึกษา (Mentored Learning) หมายถึง การเรียนที่
ผู้ด าเนินการสอนหรือผู้เชี่ยวชาญในรายวิชาเป็นที่ปรึกษาหรือเป็นพี่เลี้ยง ท าหน้าที่สร้างความสัมพันธ์
แนะน าผู้เรียน ตลอดจนกิจกรรมการเรียนรู้ในรายวิชานั้นๆ ควบคู่ไปกับการให้เนื้อหาสาระเป็นโปรแกรม
การเรียนรู้ด้วยตนเอง  
    5. การเรียนรู้ตลอดชีวิต e - Learning เปิดโอกาสให้ผู้เรียนสามารถเรียนรู้ด้วย
ตนเองตามเวลา โอกาสและความเหมาะสม สามารถใช้เครื่องมือและแหล่งความรู้อ้างอิงต่างๆ  
บนอินเทอร์เน็ตเพื่อการเรียนรู้ตลอดชีวิตมักเป็นการเรียนรู้ด้วยวิธีการสืบค้น (Inquiry Method)  
เกิดการเรียนรู้แบบสังคมออนไลน์ในรูปแบบของสื่อประเภท วิก ิ(Wiki) เว็บเควสท์ (Web Ques t)  
    6. แรพิด อีเลิร์นนิ่ง (Rapid e - Learning) เป็นทางเลือกที่ใช้กลยุทธ์การออกแบบ
การสอนแบบทันเวลา ส่วนใหญ่ใช้ในการจัดฝึกอบรมออนไลน์ด้วยการใช้แม่แบบ (Template) หรือ
ทรัพยากรบุคคลผู้เชี่ยวชาญเนื้อหาในกระบวนการออกแบบและพัฒนาเป็นหลัก 
   สรุปได้วา่  ในการท าการออกแบบการเรียนการสอนใด ๆ ก็ตามตอ้งค านึงถึง หลักสูตร 
เนื้อหา หลักการทางการออกแบบการเรียนการสอน (เทคโนโลยีการศึกษา) หลักการทางจิตวิทยา 
และหลักการทางปรัชญาทางการศึกษา น ามาประกอบกันโดยไม่ต้องไปค านึงถึงทางด้านการออกแบบ
โปรแกรมซึ่งเป็นหน้าที่ของโปรแกรมเมอร์ (Programmer) ที่ต้องน าหลักการออกแบบการสอนของ
ผู้สอนให้น าไปออกแบบตามที่ก าหนด การออกแบบในเรื่องของ e-Learning นั้นโดยมากคนส่วนใหญ่
ค านึงถึงใช้โปรแกรมคอมพิวเตอร์ไม่เป็นไม่รู้เรื่องเกี่ยวกับคอมพิวเตอร์ ไม่มีหรือไม่รู้อินเทอร์เน็ต  
แต่ตอ้งยึดหลักตามแผนการเรียนรู้ที่ท าการสอนปกติเท่านั้น  
   2.4 ข้อดีและข้อจ ากัดของบทเรียนออนไลน์ (E-Learning) 
   บทเรียนบนเว็บมีข้อดีที่เป็นประโยชน์ต่อการจัดการศึกษา แต่ก็ยังมีข้อจ ากัดใน 
การพัฒนา ซึ่งนักวิชาการ และนักการศึกษาหลายท่านได้สรุปข้อดีและข้อจ ากัดของบทเรียนบนเว็บหรือ  
การเรียนการสอนบนเว็บ ไว้ดังนี้   
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    มนต์ชัย  เทียนทอง  (2554) บทเรียนออนไลน์ถือได้ว่าเป็นการปรับกระบวนทัศน์ 
ใหม่ทางการศึกษา เพราะสามารถนาไปใช้เพื่อพัฒนาการเรียนการสอนให้มีประสิทธิภาพและ
ประสิทธิผลยิ่งขึ้น ประโยชน์ของบทเรียนออนไลน์มีอยู่หลายประการ ดังนี้  
     1. ช่วยให้การจัดการเรียนรู้มีประสิทธิภาพยิ่งขึ้น มีงานวิจัยหลายชิ้นสนับสนุน
ว่า เนื้อหาการเรียนซึ่งถูกถ่ายทอดผ่านทางมัลติมีเดีย สามารถท าให้ผู้เรียนเกิดการเรียนรู้ได้ดีกว่า 
การเรียนจากสื่อข้อความแต่เพียงอย่างเดียว ดังนั้น บทเรียนออนไลน์ที่ได้รับการออกแบบและผลิต 
อย่างมีระบบจะช่วยให้ผู้เรียนเกิดการเรียนรู้ได้อย่างมีประสิทธิภาพมากขึ้น นอกจากนั้นในด้านของ
ระบบยังมีเครื่องมือซึ่งท าให้ผู้สอนสามารถตรวจสอบความก้าวหน้าด้านพฤติกรรมการเรียนของผู้เรียนได้
อย่างละเอียดตลอดเวลา  
     2. มีการใช้เทคโนโลยีสื่อหลายมิติ (Hypermedia) ซึ่งเป็นการเชื่อมโยงข้อมูลใน
รูปของข้อความ ภาพนิ่ง เสียง กราฟิก วีดีทัศน์ ภาพเคลื่อนไหว เข้าไว้ด้วยกันในลักษณะที่ผู้ใช้สามารถ
เข้าถึงข้อมูลอย่างอิสระ ท าให้ผู้เรียนสามารถเลือกเรียนเนื้อหาได้ตามความสะดวกโดยไม่ต้องเรียงล าดับ
กัน การประยุกต์ใช้สื่อหลายมิตินี้เป็นวิธีการน าเสนอความรู้ที่มีประสิทธิภาพ ทั้งนี้เนื่องจากการใช้สื่อ
หลายมิติ สามารถน าเสนอเนื้อหาในลักษณะของกรอบความคิดแบบใยแมงมุม (Web Framework)  
ซึ่งเป็นกรอบความคิดท่ีเชื่อว่ามีลักษณะที่คล้ายคลึงกันกับวิธีที่มนุษย์จัดระบบความคิดภายในจิตใจ  
ดังนั้นผู้เรียนที่เรียนจากบทเรียนออนไลน์จะสามารถควบคุมการเรียนของตนได้  ท าให้ได้รับความรู้และ
จดจาได้ดีขึ้น 
     3. ขยายขอบเขตของการเรียนรู้ของผู้เรียนในทุกหนแห่งจากห้องเรียนปกติไปยัง
บ้านและที่ท างาน ท าให้ไม่เสียเวลาในการเดินทาง เปิดโอกาสให้ผู้เรียนที่อยู่ห่างไกล หรือไม่มีเวลาใน 
การมาเข้าชั้นเรียนได้เรียนในเวลาและสถานที่ที่ต้องการ ซึ่งสามารถช่วยแก้ปัญหาด้านข้อจ ากัดเก่ียวกับ
เวลาและสถานที่ศึกษาของผู้เรียนเป็นอย่างดี สนับสนุนการเรียนรู้ตลอดชีวิตและเป็นการลดต้นทุนใน
การจัดการศึกษานั้น ๆ  
     4. ขยายโอกาสทางการศึกษาให้ผู้เรียนในสถานศึกษาต่างๆ รอบโลกท่ีร่วมมือ
กันได้มีโอกาสได้เรียนรู้ได้พร้อมกัน เป็นการส่งเสริมให้เกิดความเท่าเทียมกันทางการศึกษา ผู้เรียนที่
ศึกษาอยู่ในสถาบันการศึกษาในภูมิภาคหรือในประเทศหนึ่ง  สามารถที่จะศึกษา ถกเถียง อภิปรายกับ
ผู้สอนซึ่งสอนอยู่ที่สถาบันการศึกษาในนครหลวงหรือในต่างประเทศก็ตาม  
     5. ผู้เรียนควบคุมการเรียนตามความต้องการและความสามารถของตนเอง 
โดยสามารถควบคุมการเรียนของตนในด้านของล าดับการเรียนตามพ้ืนฐานความรู้  ความถนัด และ 
ความสนใจของตน สามารถเลือกเรียนเฉพาะเนื้อหาส่วนที่ต้องการทบทวน โดยไม่ต้องเรียนในส่วนที่
เข้าใจแล้ว ซึ่งเป็นการให้อิสระแก่ผู้เรียนในการควบคุมการเรียนของตน  
     6. การสื่อสารโดยใช้ไปรษณีย์อิเล็กทรอนิกส์ กระดานข่าว การพูดคุยสด ฯลฯ 
ท าให้การเรียนรู้มีชีวิตชีวาขึ้นกว่าเดิม ส่งเสริมให้ผู้เรียนมีส่วนช่วยกันในการเรียน  
     7. กระตุ้นให้ผู้เรียนรู้จักการสื่อสารในสังคมและก่อให้เกิดการเรียนแบบร่วมมือ 
ซึ่งที่จริงแล้วการเรียนแบบร่วมมือสามารถขยายขอบเขตจากห้องเรียนหนึ่งไปยังห้องเรียนอื่นๆ ได้ 
โดยการเชื่อมต่อทางอินเทอร์เน็ต    
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     8. ข้อมูลของหลักสูตรและเนื้อหารายวิชาสามารถหาได้โดยง่าย การเรียน
ออนไลน์ช่วยทลายก าแพงของห้องเรียน และเปลี่ยนจากห้องเรียนสี่เหลี่ยมไปสู่โลกกว้างแห่งการเรียนรู้ 
เปิดโอกาสให้ผู้เรียนสามารถเข้าถึงแหล่งข้อมูลต่าง ๆ ได้อย่างสะดวกและมีประสิทธิภาพ  
     9. การเรียนการสอนมีให้เลือกทั้งแบบประสานเวลา คือเรียนและพบกับผู้สอน
เพ่ือปรึกษาหรือถามปัญหาได้ในเวลาเดียวกัน และเรียนแบบไม่ประสานเวลา คือเรียนจากเนื้อหาใน 
เว็บเพจและติดต่อผู้สอนทางไปรษณีย์อิเล็กทรอนิกส์   
     10. ช่วยส่งเสริมแนวคิดในเรื่องของการเรียนรู้ตลอดชีวิต เนื่องจากเว็บเป็น
แหล่งความรู้ที่เปิดกว้างให้ผู้ที่ต้องการศึกษาเรื่องใดเรื่องหนึ่ง สามารถเข้ามาค้นคว้าหาความรู้ได้อย่าง
ต่อเนื่องและตลอดเวลา เปิดโอกาสแก่ผู้เรียนให้เข้าถึงผู้เชี่ยวชาญสาขาต่างๆ ทั้งในและนอกสถาบัน 
จากในประเทศและต่างประเทศท่ัวโลก โดยสามารถติดต่อสอบถามปัญหา ขอข้อมูลต่างๆ ที่ต้องการจาก
ผู้เชี่ยวชาญจริงโดยตรงซึ่งไม่สามารถท าได้ในการเรียนการสอนแบบเดิม นอกจากนี้ยังประหยัดทั้งเวลา
และค่าใช้จ่าย เมื่อเปรียบเทียบกับการติดต่อสื่อสารลักษณะเดิม 
     11. เอ้ือให้เกิดการปฏิสัมพันธ์ ซึ่งการเกิดปฏิสัมพันธ์นี้อาจท าได้ 2 รูปแบบ คือ  
      11.1 ปฏิสัมพันธ์กับผู้เรียนด้วยกันและ/หรือผู้สอน  
      11.2 ปฏิสัมพันธ์กับบทเรียนในเนื้อหาหรือบทเรียนออนไลน์ ซึ่งลักษณะ 
แรกจะอยู่ในรูปของการเข้าไปพูดคุย พบปะแลกเปลี่ยนความคิดเห็นกัน ส่วนในลักษณะหลังนั้นจะ 
อยู่ในรูปแบบของการเรียนการสอน แบบฝึกหัดหรือแบบทดสอบที่ผู้สอนได้จัดหาไว้ให้แก่ผู้เรียน  
     12. บทเรียนออนไลน์เปิดโอกาสให้ผู้เรียนได้มีโอกาสแสดงผลงานของตนสู่  
สายตาผู้อื่นอย่างง่ายดาย โดยไม่ได้จ ากัดเฉพาะเพ่ือนๆ ในชั้นเรียน หากแต่เป็นบุคคลทั่วไปทั่วโลก 
ดังนั้น จึงถือเป็นการสร้างแรงจูงใจภายนอกอย่างหนึ่งส าหรับผู้เรียนที่จะพยายามผลิตผลงานที่ดี 
เพ่ือไม่ให้เสียชื่อเสียงตนเอง นอกจากนี้ผู้เรียนยังมีโอกาสได้เห็นผลงานของผู้ อ่ืน เพ่ือนามาพัฒนางาน
ของตนเองให้ดียิ่งขึ้น  
     13. บทเรียนออนไลน์เปิดโอกาสให้ผู้สอนสามารถปรับปรุงเนื้อหาหลักสูตร 
ให้ทันสมัยได้อย่างสะดวกสบาย เนื่องจากข้อมูลบนเว็บมีลักษณะเป็นพลวัตร (Dynamic) ดังนั้นผู้สอน 
จึงสามารถปรับปรุงเนื้อหาที่ทันสมัยได้ตลอดเวลา นอกจากนี้การให้ผู้เรียนได้สื่อสารและแสดง 
ความคิดเห็นที่เก่ียวข้องกับเนื้อหา ท าให้เนื้อหามีความยืดหยุ่นมากกว่าการเรียนการสอนแบบเดิม และ
เปลี่ยนแปลงไปตามความต้องการของผู้เรียนเป็นส าคัญ  
     14. เพ่ิมทักษะทางเทคโนโลยี ผู้เรียนที่เรียนด้วยการเรียนการสอนผ่านบทเรียน 
ออนไลน์จะได้เพ่ิมพูนทักษะทางเทคโนโลยี เนื้อหาที่เรียนมีการเปลี่ยนแปลงอย่างเหมาะสมและ 
เพ่ิมแหล่งทรัพยากรต่าง ๆ ให้ผู้เรียนได้เพ่ิมพูนความรู้ ซึ่งผู้เรียนจะได้รับประสบการณ์และฝึกฝนทักษะ
จากเทคโนโลยีอันหลากหลาย  
     15. พฤติกรรมการเรียนการสอนเปลี่ยนไป การก าหนดเวลาเข้าเรียนอาจหมด 
ไป แต่จะเน้นไปที่ความถ่ีของการที่ผู้เรียนพบปะกับผู้สอนทางเครือข่ายอินเทอร์เน็ตแทน  การเรียนด้วย
บทเรียนออนไลน์จึงเป็นการปฏิรูปลักษณะการเรียนรู้ รูปแบบของการเรียนการสอน และวัฒนธรรม 
การเรียนรู้โดยรวม เมื่อผู้เรียนเรียนโดยใฝ่รู้และไม่จ ากัดแหล่งความรู้เหมือนแต่ก่อน  
     16. การประเมินผล ผู้สอนจะต้องประเมินผลงานว่าสอดคล้องกับระดับ 
ความสามารถตามปกติของผู้เรียนหรือไม่  
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     17. คุณสมบัติของผู้สอน ผู้สอนต้องแสวงหาลู่ทางใหม่ๆ ที่จะเอ้ือให้การเรียน 
การสอนมีคุณภาพดียิ่งข้ึน ต้องมีความสนุกที่จะใช้บทเรียนออนไลน์เพื่อการเรียนการสอน สิ่งส าคัญคือ
จะต้องปรับเปลี่ยนค่านิยมทั้งในส่วนที่เกี่ยวข้องกับผู้สอนด้วยกัน และในส่วนที่เกี่ยวกับผู้เรียน 
ความสัมพันธ์ระหว่างผู้สอนควรจะความร่วมมือกันมากข้ึนทั้งในและนอกรายวิชาที่สอน 
     18. คุณสมบัติของผู้เรียนที่ส าคัญคือ วินัยในการท างาน นับตั้งแต่การวางแผน 
งานให้รัดกุมแล้วปฏิบัติตามแผนโดยเคร่งครัด เพราะบทเรียนออนไลน์เปิดโอกาสให้ผู้เรียนท างาน 
โดยอิสระมากกว่าแบบเดิม ผู้เรียนควรมีนิสัยรักการอ่าน ใฝ่รู้ใฝ่คิด มีทักษะการคิดอย่างวิเคราะห์ 
สังเคราะห์ และประเมินได้  
    ไชยยศ เรืองสุวรรณ (2554  :  26) ประโยชน์ของการเรียนการสอนบนเว็บ 
ที่เป็นมิติใหม่ของเครื่องมือและกระบวนการในการเรียนการสอน ที่ส าคัญได้แก่    
     1. ผู้เรียนสามารถเรียนได้ทุกแห่งที่มีอินเทอร์เน็ตติดตั้งอยู่     
     2. ผู้เรียนสามารถเรียนได ้โดยไม่ท าให้งานในหน้าที่เสียหาย    
     3. ไม่ต้องเสียค่าใช้จ่ายอื่นเพ่ิมเติม เช่นค่าที่พัก ค่าเดินทาง    
     4. ผู้เรียนสามารถเรียนได้ตลอด 24 ชั่วโมง    
     5. การจัดการเรียนการสอนหรือการฝึกอบรมมีลักษณะที่ผู้เรียนเป็นศูนย์กลาง 
การเรียนรู้เกิดกับตัวผู้เรียนโดยตรง    
     6. การเรียนรู้เป็นไปตามความก้าวหน้าของผู้เรียนเอง    
     7. ผู้เรียนสามารถทบทวนบทเรียนและเนื้อหาได้ตลอดเวลา    
     8. สามารถซักถามหรือเสนอแนะได้ด้วยเครื่องมือบนเว็บไซด์    
     9. สามารถแลกเปลี่ยนข้อคิดเห็นระหว่างผู้เรียนได ้โดยใช้เครื่องมือสื่อสารใน 
ระบบอินเทอร์เน็ต ทั้งไปรษณีย์อิเล็กทรอนิกส์(E-Mail) หรือห้องสนทนา (Chat Room) หรืออ่ืนๆ 
     10. ไม่มีพิธีการมาก  
    ไชยยศ  เรืองสุวรรณ  (2551  :  17) กล่าวถึงข้อจ ากัดของการเรียนการสอนบน
เว็บว่า มีลักษณะไม่ต่างจากการพัฒนาคอร์สแวร์โดยทั่วไป ดังนี้  
     1. การออกแบบและพัฒนาบทเรียนบนเว็บยังมีไม่มากนัก เมื่อเปรียบเทียบกับ  
การพัฒนาโปรแกรมเพ่ือใช้ในวงการอื่น ๆ ท าให้บทเรียนบนเว็บมีจ านวนและขอบเขตจ ากัดท่ีจะ  
น ามาใช้เพื่อการเรียนการสอนวิชาต่างๆ 
     2. ผู้สอนมีขีดจ ากัดด้านเวลา ภาระงาน และความสามารถด้านเทคนิคใน 
การเป็นผู้ออกแบบและพัฒนาบทเรียนบนเรียนบนเว็บ 
     3. ผู้เรียนบางคนอาจไม่ชอบโปรแกรมท่ีเรียนตามข้ันตอน ท าให้เป็นอุปสรรคใน  
การเรียนรู้ได้  
     4. การพัฒนาสื่อคอมพิวเตอร์ช่วยสอน ต้องใช้ค่าใช้จ่ายสูงพอสมควร ทั้งใน 
ด้านฮาร์ดแวร์ และซอฟต์แวร์ 
     5. ต้องอาศัยความคิดจากผู้ช านาญการ หรือผู้เชี่ยวชาญ จ านวนมากใน 
การระดมความคิด             
     6. ใช้เวลาในการพัฒนานาน 
     7. การออกแบบสื่อ กระท าได้ยาก และซับซ้อน  
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    ปัญณิศา  กาญจน์อนุกูล  (2552  :  25-26) กล่าวถึงข้อเสียของการเรียนการสอน  
บนเว็บไว้ว่า  
     1. ไม่สามารถรับรู้ความรู้สึก ปฏิกิริยาที่แท้จริงของผู้เรียนและผู้สอน 
     2. ไม่สามารถสื่อความรู้สึก อารมณ์ในการเรียนรู้ได้อย่างแท้จริง 
     3. ผู้เรียน และผู้สอน จะต้องมีความพร้อมในการใช้คอมพิวเตอร์และ  
อินเทอร์เน็ตทั้งด้านอุปกรณ์ และทักษะการใช้งาน 
     4. ผู้เรียนบางคนไม่สามารถศึกษาด้วยตนเองได้ 
  จากการเปรียบเทียบทั้งข้อดีและข้อจ ากัดของการเรียนการสอนออนไลน์  จะเห็นได้ว่า  
การเรียนการสอนออนไลน์มีผลต่อการสอนในชั้นเรียนแบบดั้งเดิม คุณภาพของการสอนไม่ได้เกิดจากสื่อ
เท่านั้น หากแต่เกิดจากความตั้งใจที่จะต้องเรียนให้ส าเร็จ ส่วนประกอบส าคัญท่ีจะสร้างคุณภาพแก่การ
เรียนการสอน คือ การมีปฏิสัมพันธ์กับผู้เรียนและผู้สอน การให้ผลย้อนกลับโดยทันที ความสัมพันธ์ใน
รูปแบบที่แตกต่างกันของการเรียนรู้และกิจกรรมการเรียนรู้ การเรียน การสอนออนไลน์จะไม่เหมาะกับ
ทุกสถานการณ์ หรือกับผู้เรียนทุกคน แต่ลักษณะเด่นต่าง ๆ ของบทเรียนออนไลน์ และความยืดหยุ่นที่
ผู้สอนจะสามารถนาไปประยุกต์ในการเรียนการสอนได้หลายรูปแบบ ซึ่งคุณภาพและความส าเร็จ 
จากการเรียนการสอนออนไลน์ขึ้นอยู่กับการออกแบบเครื่องมือที่เก่ียวข้อง และการจัดกิจกรรมการเรียน 
การสอน 
  สรุปได้ว่า เครือข่ายอินเทอร์เน็ตและบทเรียนออนไลน์นั้นสามารถสรุปได้ว่า การออกแบบ
บทเรียนออนไลน์เพื่อการเรียนการสอนนั้น ต้องมีการวางแผนตรงตามจุดประสงค์ ต้องมีการจัดระบบ
สิ่งจ าเป็นเกี่ยวกับบทเรียนออนไลน์ ควรมีการน าทางผู้เข้ามาศึกษาและค านึงถึงผู้เรียนเป็นส าคัญ 
นอกจากนี้ยังควรค านึงถึงการเชื่อมโยงยังหน้าต่าง ๆ ตาราง กรอบหรือแหล่งวิชาการต่างๆ การออกแบบ
รูปแบบบทเรียนออนไลน์จึงมีความส าคัญที่จะสร้างความดึงดูดใจให้ผู้เรียนเข้ามาศึกษาและเกิดการ
เรียนรู้ รวมทั้งการศึกษาข้อดีและข้อจ ากัดของการน าบทเรียนออนไลน์มาในการจัดการเรียนการสอน   
ซึ่งจะท าให้สามารถออกแบบบทเรียนออนไลน์ให้น่าสนใจและบรรลุวัตถุประสงค์ในการจัดการเรียน  
การสอน  
 
การหาประสิทธิภาพของบทเรียน  
 
 ไชยยศ  เรืองสุวรรณ  (2552  :  144) กล่าวว่า ประสิทธิภาพของบทเรียน เป็นการ ประเมิน
หาประสิทธิภาพของกระบวนการเรียน (E1) (ระหว่างเรียน) และการหาผลที่เกิดจากการ เรียนด้วย
โปรแกรมบทเรียน (E2) (หลังเรียน) โดยก าหนดว่า ประสิทธิภาพของกระบวนการ (E1) ได้มาจาก
คะแนนที่ผู้เรียนได้จากการท าแบบทดสอบย่อยท้ายหน่วยการเรียน คิดเป็นร้อยละของคะแนนเต็ม 
ประสิทธิภาพผลลัพธ์ (E2) ได้มาจากคะแนนผลสัมฤทธิ์ทางการเรียนที่ผู้เรียนท าได้ คิดเป็นร้อยละของ
คะแนนเต็ม    
 สมนึก ภัททิยธนี และคณะ  (2551  :  98 - 99) กล่าวว่า ประสิทธิภาพของ กระบวนการ 
(E1) เป็นค่าที่บ่งบอกว่าแผนการจัดการเรียนรู้นั้นสามารถพัฒนาผู้เรียนให้เกิดการ เรียนรู้อย่างต่อเนื่อง
หรือไม่ภายใต้สถานการณ์และกิจกรรมที่ก าหนดให้ค านวณจากคะแนนที่ได้จาก การท าแบบทดสอบย่อย 
แบบฝึกทักษะในระหว่างที่ผู้เรียนก าลังเรียนตามแผนการจัดการเรียนรู้ ส่วนประสิทธิภาพของผลลัพธ์ 
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(E2) เป็นค่าที่บอกว่าแผนการจัดการเรียนรู้นั้น สามารถส่งผลให้ผู้เรียน เกิดสัมฤทธิ์ผลได้หรือไม่  
บรรลุวัตถุประสงค์หรือเป็นไปตามที่ก าหนดไว้ในแผนการจัดการเรียนรู้มากน้อยเพียงใดซึ่งค านวณ 
จากคะแนนที่ได้จากการท าแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน (ทดสอบหลังเรียน) ของผู้เรียนทุก
คน โดยเกณฑ์ท่ีนิยมใช้หลักการเรียนรู้แบบรอบรู้ (Mastering Learning) คือ ตั้งเกณฑ์ไว้ที่ร้อยละ 80 
และยอมรับความผิดพลาดได้ไม่เกินร้อยละ 2.5  
  เกณฑ์ประสิทธิภาพ (E1/E2) มีความหมายแตกต่างกันหลายลักษณะ เช่น   
   1 เกณฑ ์80/80 ในความหมายที่ 1 ตัวเลข 80 ตัวแรก (E1) คือ นักเรียน ทั้งหมดท า 
แบบฝึกหัดหรือแบบทดสอบย่อยได้คะแนนเฉลี่ยร้อยละ 80 ถือเป็นประสิทธิภาพของ กระบวนการส่วน
เลข 80 ตัวหลัง (E2) คือ นักเรียนทั้งหมดที่ท าแบบทดสอบหลังเรียน (Posttest) ได้คะแนนเฉลี่ยร้อยละ 
80 ถือเป็นประสิทธิภาพเชิงประจักษ์ (ไชยยศ  เรืองสุวรรณ.    2552  :  134 - 135) ใช้สูตรการหาค่า
ประสิทธิภาพกระบวนการ E1 และประสิทธิภาพผลลัพธ์ E2 ดังนี้ 
 

E1

 𝓍
N
A

× 100 

 
  เมื่อ E1  แทน  ประสิทธิภาพของกระบวนการ    
     𝓍  แทน  คะแนนรวมที่ผู้เรียนท าแบบฝึกหัดได้ในระหว่างเรียน    
    A   แทน  คะแนนเต็มของแบบฝึกหัดทุกชุดรวมกัน    
    N   แทน  จ านวนนักเรียนทั้งหมด   
 

E2

 γ
N
B

× 100 

 
  เมื่อ E2  แทน  ประสิทธิภาพของกระบวนการ    
     γ  แทน  คะแนนรวมที่ผู้เรียนท าแบบฝึกหัดได้ในระหว่างเรียน    
    B   แทน  คะแนนเต็มของแบบฝึกหัดทุกชุดรวมกัน    

 N   แทน  จ านวนนักเรียนทั้งหมด   
 

   2. เกณฑ ์80/80 ในความหมายที่ 2 ตัวเลข 80 ตัวแรก (E1) คือ จ านวน นักเรียน 
ร้อยละ 80 ท าแบบทดสอบหลังเรียน (Posttest) ให้คะแนนร้อยละ 80 ทุกคน ส่วนเลข 80 ตัวหลัง (E2) 
คือ นักเรียนทั้งหมดที่ท าแบบทดสอบหลังเรียนครั้งนั้นได้คะแนนเฉลี่ยร้อยละ 80   
   3. เกณฑ ์80/80 ในความหมายที่ 3 ตัวเลข 80 ตัวแรก (E1) คือ จ านวน นักเรียน 
ร้อยละ 80 ท าแบบทดสอบหลังเรียน (Posttest) ได้คะแนนเฉลี่ยร้อยละ 80 ส่วนเลข 80 ตัวหลัง (E2) 
คือ คะแนนเฉลี่ยร้อยละ 80 ที่นักเรียนท าเพ่ิมข้ึนจากแบบทดสอบหลังเรียน (Posttest) โดยเทียบกับ
คะแนนที่ท าได้ก่อนเรียน (Pretest)  
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   สรุปได้ว่า เกณฑ์ในการหาประสิทธิภาพของสื่อการเรียนการสอนจะนิยมตั้งเป็นตัวเลข 
3 ลักษณะ คือ 80/80 85/85 และ 90/90 ทั้งนี้ข้ึนอยู่กับธรรมชาติของวิชาและเนื้อหาที่ น ามาสร้างสื่อ 
นั้น ๆ ถ้าเป็นวิชาที่ค่อนข้างยากก็อาจจะตั้งเกณฑ์ไว้ 80/80 หรือ 85/85 ส าหรับวิชาที่มีเนื้อหาง่ายก็ 
อาจตั้งเกณฑ์ไว้ 90/90 เป็นต้น ถ้ายังได้คะแนนไม่ถึงก็ต้องปรับปรุงแก้ไขบทเรียนแล้ว ทดลองใช้ใหม่
จนกว่าจะได้ค่าตามเกณฑ์มาตรฐาน ค่าท่ียอมรับได้ จะเป็นค่าท่ีอยู่ระหว่าง +-2.50 (77.50-82.50 หรือ 
87.50-92.50)    
   ส่วนข้อมูลด้านคุณภาพด้านเทคนิค คุณภาพด้านเนื้อหาความถูกต้อง ตลอดจน
คุณลักษณะอ่ืน ๆ ของโปรแกรมบทเรียน จะได้จากผู้สอน ผู้เรียน นักเทคโนโลยีการศึกษาผู้เชี่ยวชาญ
ด้านการสอนและโปรแกรมเมอร์ เครื่องมือที่ใช้รวบรวมข้อมูลอาจเป็นแบบสอบถามแบบสังเกตและหรือ 
แบบสัมภาษณ์ ฯลฯ    
 
การหาดัชนีประสิทธิผลของบทเรียน  
  
 นักการศึกษา ได้กล่าวถึงแนวทางการหาค่าดัชนีประสิทธิผลของบทเรียนไว้ ดังนี้   
  ไชยยศ  เรืองสุวรรณ  (2552  :  134) กล่าวว่า ฮัฟแลนด์ ได้เสนอแนวคิดในการหา
ประสิทธิภาพสื่อ โดยการค านวณหาค่าดัชนีประสิทธิผล (Effectiveness Index : E.I.) ค่าท่ีค านวณได้
จะเป็นทศนิยม ซึ่งค่าทศนิยมที่ได้ ถ้ามีค่าใกล้ 1 มากเพียงใด ยิ่งแสดงว่าโปรแกรมบทเรียนนั้นมี
ประสิทธิภาพมาก ข้อมูลที่น ามาใช้ในการค านวณมาจากคะแนนผลสัมฤทธิ์ทางการเรียน ทั้งการทดสอบ
ก่อนเรียน และการทดสอบหลังเรียน    
  สมนึก  ภัททิยธนี และคณะ  (2551  :  102) กล่าวถึง ดัชนีประสิทธิผลของสื่อการสอน
หรือนวัตกรรมทางการศึกษา (The Effectiveness Index : E.I.) ไว้ว่า เป็นค่าที่แสดงอัตราการเรียนรู้ 
ที่ก้าวหน้าขึ้นจากพ้ืนฐานความรู้เดิมที่มีอยู่แล้ว หลังจากท่ีผู้เรียนได้เรียนจากสื่อหรือ นวัตกรรมหรือ
แผนการจัดการเรียนรู้นั้น ๆ  
  ดัชนีประสิทธิผลสามารถน ามาประยุกต์ใช้เพื่อประเมินสื่อ โดยเริ่มจากการทดสอบก่อน
เรียนซึ่งเป็นตัววัดว่าผู้เรียนมีความรู้พื้นฐานอยู่ระดับใด รวมถึงการวัดทางด้านความเชื่อ เจตคติและ
ความตั้งใจของผู้เรียน คะแนนที่ได้จากการทดสอบมาแปลงให้เป็นร้อยละหาค่าคะแนนสูงสุดที่เป็นไปได้  
น านักเรียนเข้ารับการทดลองเสร็จแล้วท าการทดสอบหลังเรียนแล้ว คะแนนที่ได้มาหาดัชนีประสิทธิผล 
โดยน าคะแนนก่อนเรียนไปลบออกจากคะแนนหลังเรียนได้เท่าไรน ามาหารด้วยค่าที่ได้จากค่าทดสอบ
ก่อนเรียนสูงสุดที่ผู้เรียนจะสามารถท าได้ลบด้วยคะแนนทดสอบก่อนเรียนโดยท าให้อยู่ในรูปร้อยละ  
ดัชนีประสิทธิผลจะมีค่าอยู่ระหว่าง -1.00 – 1.00 หากค่าทดสอบก่อนเรียนเป็น 0 และการทดสอบ
ปรากฏว่านักเรียนไม่มีการเปลี่ยนแปลง คือ ได้คะแนน 0 เท่าเดิม แต่ถ้าคะแนนทดสอบก่อนเรียนได้
เท่ากับ 0 และการทดสอบหลังเรียนท าได้สูงสุด คือเต็ม 100  
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Mahasarakham University 



36 

  ในการค านวณหาค่าดัชนีประสิทธิผล (The Effectiveness Index : E.I.) นิยมใช้  
เป็นวิธีการหาค่า E.I. (ไชยยศ เรืองสุวรรณ. 2552 : 134) โดยใช้สูตรดังนี้   

  

E. I. =
ผลรวมของคะแนนทดสอบหลังเรียนทุกคน − ผลรวมของคะแนน  

(จ านวนนักเรียน X คะแนนเต็ม)  − ผลรวมของคะแนนทดสอบ
 

   
   E.I. = ดัชนีประสิทธิผล 
 

    ดัชนีประสิทธิผลสามารถน ามาประยุกต์ใช้เพื่อประเมินผลสื่อ โดยเริ่มจากการทดสอบ 
ก่อนเรียนซึ่งเป็นตัววัดว่าผู้เรียนมีความรู้พื้นฐานอยู่ในระดับใด รวมถึงการวัดทางด้านความเชื่อ เจตคติ
และความตั้งใจของผู้เรียน น าคะแนนที่ได้มาหาค่าดัชนีประสิทธิผล โดยน าผลรวมของคะแนนก่อนเรียน
ไปลบออกจากผลรวมของคะแนนหลังเรียน ได้เท่าใดน ามาหารด้วยค่าที่ได้จากค่าคะแนนเต็มของ
แบบทดสอบคูณด้วยจ านวนผู้เรียน แล้วลบด้วยผลรวมของคะแนนทดสอบก่อนเรียน    
  สรุปได้ว่า ถ้าหลังเรียนนักเรียนได้คะแนนเต็มทุกคน ค่า E.I. จะเป็น 1.00 เสมอไม่ว่า  
ผลการสอบก่อนเรียนจะได้เท่าไรก็ตาม (ยกเว้นได้คะแนนเต็มทุกคน) หรือกล่าวได้ว่าผู้เรียน  
มีความก้าวหน้าในเรื่องที่เรียน คิดเป็นร้อยละ 100 หรือบรรลุวัตถุประสงค์ของการเรียนตามที่ต้องการ 
ลักษณะที่พบในงานวิจัยของนิสิตบ่อย ๆ คือแผนการเรียนหรือสื่อมีค่า E1 /E2 สูงกว่า เกณฑ์ท่ีก าหนด 
ค่า E.I. ก็สูง แต่ผลการทดสอบความคงทนมีนัยส าคัญทางสถิติ ปัญหานี้น่าจะมาจากนักเรียนไม่ได้ตั้งใจ
หรือเบื่อหน่ายในการท าข้อสอบอย่างจริงจัง แม้ว่าผู้วิจัยจะมีความรู้สึกว่าสื่อ หรือแผนการจัดการเรียนรู้ 
ที่ผู้วิจัยใช้จะมีคุณภาพท าให้นักเรียนเกิดความเข้าใจเนื้อหาสาระที่เรียนมากหรือมีความตรึงตาตรึงใจต่อ
บทเรียนมากเท่าไรก็ตาม   
 
ความพึงพอใจในการเรียนรู้ 
 
 1. ความหมายของความพึงพอใจ 
  นักการศึกษาได้ให้ความหมายเกี่ยวกับความพึงพอใจในการเรียนรู้  ไว้ดังนี้ 
   ณรัตน์  ลาภมูล (2546  :  7) ได้ให้ความหมายว่า ความพึงพอใจในการปฏิบัติงาน 
หมายถึง ความรู้สึกท่ีสามารถประเมินค่าได้ของบุคคลที่มีต่อการปฏิบัติงานที่ท าอยู่  ซึ่งครอบคลุมมิติ 
ต่าง ๆ ของงาน 
   ประสาท  อิศรปรีดา  (2547  :  300) ได้ให้ความหมายว่า ความพึงพอใจ หมายถึง 
พลังที่เกิดจากพลังทางจิตที่มีผลไปสู่เป้าหมายที่ต้องการของมนุษย์  และเป็นพฤติกรรมไปสู่จุดหมาย 
ที่ตั้งไว้ 
   ศรีสุดา  ญาติปลื้ม  (2547  :  69) ได้ให้ความหมายว่า ความพึงพอใจว่า ความพึง
พอใจหมายถึง ความรู้สึกรัก ชอบ พอใจ หรือเป็นเจตคติที่ดีของบุคคลที่มีต่อสิ่งใดสิ่งหนึ่งซึ่งเกิด 
จากการได้รับการตอบสนองความต้องการหรือความคาดหวังในทางที่ดีท้ังด้านวัตถุแลด้านจิตใจ  
เป็นความรู้สึกเม่ือได้รับความส าเร็จความต้องการหรือแรงจูงใจ 
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  สรุปได้ว่า ความพึงพอใจ หมายถึง ความรู้สึกในทางบวก ที่ชอบหรือพอใจ  
ที่มีต่อองค์ประกอบ และสิ่งจูงใจในด้านต่างๆ ในการร่วมปฏิบัติกิจกรรมการเรียนการสอนอย่างต่อเนื่อง 
จนสามารถด าเนินกิจกรรมนั้นๆ จนบรรลุผลส าเร็จ  
 2. แนวคิดทฤษฎีเกี่ยวกับความพึงพอใจ 
  การที่ผู้ปฏิบัติจะเกิดความพึงพอใจในกิจกรรมนั้นมากหรือน้อย ขึ้นอยู่กับสิ่งจูงใจที่มีอยู่ใน 
กิจกรรมนั้น การสร้างสิ่งจูงใจหรือแรงกระตุ้นให้เกิดกับปฏิบัติงานจึงเป็นสิ่งจ าเป็น เพ่ือให้การปฏิบัติงาน 
เป็นไปตามวัตถุประสงค์ที่วางไว้มีผู้ท าการศึกษาค้นคว้าจนเกิดแนวคิดทฤษฎีเกี่ยวกับแรงจูงใจไว้ดังนี้  
   ใกล้รุ่ง  นคราวนากุล  (2547  :  54) ได้น าแนวคิดพ้ืนฐานที่เก่ียวกับความพึงพอใจมา 
ประยุกต์ในการด าเนินการจัดกิจกรรมการเรียนรู้ เนื่องจากเห็นว่าความพึงพอใจเป็นสิ่งส าคัญใน 
การกระตุ้นให้ผู้เรียนท างานที่ได้รับมอบหมาย หรือต้องปฏิบัติให้บรรลุวัตถุประสงค์ของการเรียน ดังนั้น
ครูจึงสอนบทบาทส าคัญในการสร้างความพึงพอใจให้เกิดข้ึนในผู้เรียน ซึ่งสามารถท าได้หลายวิธีการ ดังนี้ 
    1. จัดกิจกรรมการเรียนรู้ที่หลากหลายวิธีการเรียนรู้ เพ่ือกระตุ้นความสนใจใน 
การเรียน 
    2. จัดหาสื่ออุปกรณ์ท่ีเอ้ือต่อการเรียนรู้ เพ่ือให้เกิดแรงจูงใจในการเรียน 
    3. ให้นักเรียนได้รับผลตอบแทนภายใน จากการเรียนรู้ในแต่ละครั้ง โดยการให้ 
รางวัลภายในที่ท าให้นักเรียนเกิดความรู้สึกที่ดี เช่น ความรู้สึกในความส าเร็จของตนที่สามารถเอาชนะ
ความยุ่งยากต่างๆ  ได้ ความภาคภูมิใจ ความมั่นใจ 
    4. เมื่อบรรลุวัตถุประสงค์ในการเรียนการสอน ครูผู้สอนอาจให้ผลตอบแทน
ภายนอก เช่น ค าชมเชย รางวัล หรือใช้คะแนนผลสัมฤทธิ์ทางการเรียนในระดับที่น่าพอใจ 
   เผชิญ  กิจระการ  (2544  :  7) ได้กล่าวถึง แนวความคิดของแฮทฟิลด์และฮิวส์  
ที่ได้ท าการพัฒนาแนวความคิดของนักวิจัยต่าง ๆ มาเป็นเครื่องมือวัดความพึงพอใจ ซึ่งเป็นที่นิยม
แพร่หลายในปัจจุบัน ประกอบด้วยองค์ประกอบ 5 ประกอบ ดังนี้    
    ตัวแปรที่ 1 องค์ประกอบเกี่ยวกับงานที่ท าในปัจจุบัน แบ่งเป็น   
     1. ความตื่นเต้น/น่าเบื่อ   
     2. ความสนุกสนาน/ความไม่สนุกสนาน   
     3. ความโล่ง/ความสลัว   
     4. ความท้าทาย/ไม่ท้ายทาย   
     5. ความพอใจ/ไม่พอใจ   
    ตัวแปรที่ 2 องค์ประกอบทางด้านค่าจ้าง ประกอบด้วย   
     1. ถือว่าเป็นรางวัล/ไม่เป็นรางวัล   
     2. มาก/น้อย   
     3. ยุติธรรม/ไม่ยุติธรรม   
     4. เป็นทางบวก/เป็นทางลบ    
    ตัวแปรที่ 3 องค์ประกอบทางด้านการเลื่อนต าแหน่ง   
     1. ยุติธรรม/ไม่ยุติธรรม   
     2. เชื่อถือได้/เชื่อถือไม่ได้   
     3. เป็นเชิงบวก/เป็นเชิงลบ   
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     4. เป็นเหตุผล/ไม่เป็นเหตุผล    
    ตัวแปรที่ 4 องค์ประกอบทางด้านผู้นิเทศ/ผู้บังคับบัญชา   
     1. อยู่ใกล้/อยู่ไกล   
     2. ยุติธรรมแบบจริงใจ/ยุติธรรมแบบไม่จริงใจ  
     3. เป็นมิตร/ค่อนข้างไม่เป็นมิตร  
     4. เหมาะสมทางคุณสมบัติ/ไม่เหมาะสมทางคุณสมบัติ  
    ตัวแปรที่ 5 องค์ประกอบทางด้านเพ่ือนร่วมงาน 
     1. เป็นระเบียบเรียบร้อย/ไม่เป็นระเบียบเรียบร้อย  
     2. จงรักภักดีต่อที่ท างาน/ไม่จงรักภักดีต่อที่ท างานและเพ่ือนร่วมงาน  
     3. สนุกสนานร่าเริง/ดูไม่มีชีวิตชีวา  
     4. ดูน่าสนใจเอาจริงเอาจัง/ดูเหนื่อยหน่าย  
   ธงศักดิ์  พิทักษ์  (2544  :  12 - 13) เห็นว่ามนุษย์ถูกกระตุ้นจากความปรารถนา 
ที่จะครอบครอง ความต้องการเฉพาะอย่างซึ่งความต้องการใดได้รับการตอบสนองแล้ว  ความต้องการ
อย่างอ่ืนจะเข้ามาแทนที่ ความต้องการที่ไม่ได้รับการตอบสนอง จึงเป็นสิ่งจูงใจต่อไปนั้น ความต้องการ
ของมนุษย์จึงมีล าดับขั้นตามความส าคัญ 5 ขัน้ตอนตามล าดับ 
    1. ความต้องการทางด้านร่างกาย (Physiological Needs) เป็นความต้องการเบื้อ  
ต้นเพื่อความอยู่รอดของชีวิต เช่น ความต้องการในเรื่องของอาหาร น้ า อากาศ เครื่องนุ่งห่ม ยารักษา
โรค ที่อยู่อาศัย ความต้องการทางเพศ ความต้องการทางด้านร่างกายจะมีอิทธิพลต่อพฤติกรรมของตน 
ก็ต่อเมื่อความต้องการทั้งหมดของคนยังไม่ได้รับการตอบสนอง 
    2. ความต้องการความปลอดภัยหรือความมั่นคง (Security of Safety Needs)  
ถ้าหากความต้องการทางร่างกายได้รับการตอบสนองตามสมควรแล้วมนุษย์ต้องการในขั้นสู งต่อไป คือ 
เป็นความรู้สึกท่ีต้องการความปลอดภัยหรือมั่นคงในปัจจุบันหรืออนาคต ซึ่งรวมถึงความก้าวหน้า และ 
ความอบอุ่น 
    3. ความต้องการทางสังคม (Social or Belonging Needs) ภายหลังจากท่ีคน  
ได้รับการตอบสนองในสองข้ันดังกล่าวแล้วก็จะมีความต้องการในขั้นสูงขึ้นคือ ความต้องการทางสังคม
เป็นความต้องการที่จะเข้าร่วมและได้รับการยอมรับในสังคม ความเป็นมิตรและความรัก จากเพ่ือน 
    4. ความต้องการที่จะได้รับการยกย่องนับถือ (Esteem Needs) เป็นความต้องการ 
ให้คนอ่ืนยกย่องให้เกียรติ และเห็นความส าคัญของตน อย่างเด่นในสังคม รวมถึง ความส าเร็จ ความรู้
ความสามารถ ความเป็นอิสระ และเสรีภาพ 
    5. ความต้องการความส าเร็จในชีวิต (Self Needs) เป็นความต้องการระดับสูงสุด 
ของมนุษย์ ส่วนมากจะเป็นการอยากจะเป็น อยากจะได้ ตามความคิดของตน หรือต้องการจะเป็น
มากกว่าที่ตนเองเป็นอยู่ในขณะนี้  
  สรุปได้ว่า เมื่อน ามาใช้ในการจัดกิจกรรมการเรียนการสอน ผลตอบแทนหรือรางวัล 
เป็นผลทางด้านความรู้สึกของผู้เรียนหรือผลตอบแทนภายในที่เกิดข้ึนอันส่งผลให้เกิดความภาคภูมิใจ 
ความมั่นใจในตนเอง ตลอดจนการได้รับการยกย่องชมเชยจากครูผู้สอน พ่อแม่ ผู้ปกครอง หรือ 
แม้การได้รับคะแนนผลสัมฤทธิ์ทางการเรียนในระดับที่น่าพอใจซึ่งเป็นการตอบแทนจากภายนอก  
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 3. การวัดความพึงพอใจในการเรียนรู้    
  การจะค้นว่าบุคคลมีความพึงพอใจหรือไม่ วิธีที่ง่ายที่สุดก็คือการถาม ซ่ึงการศึกษา  
ในระยะหลังๆ ที่ต้องมีผู้บอกข้อมูลจ านวนมาก ๆ มักใช้แบบสอบถามที่ใช้มาตราส่วนประมาณค่าเป็น
เครื่องมือหนึ่งที่นิยมกันมากโดยเฉพาะการเก็บรวบรวมข้อมูลทางสังคมศาสตร์  ทั้งนี้เพราะเป็นวิธีที่
สะดวก และสามารถใช้วัดได้อย่างกว้างขวาง โดยค าถามเป็นตัวกระตุ้นเร่งเร้าให้บุคคลแสดง พฤติกรรม
ต่าง ๆ ออกมาใช้ในการประเมินนักเรียน และนักเรียนใช้ในการประเมินหรือพิจารณา ตนเองหรือสิ่ง 
อ่ืน ๆ ใช้ทั้งการประเมินในการปฏิบัติ กิจกรรม ทักษะต่าง ๆ และพฤติกรรมด้านจิตพิสัย เช่น ความพึง
พอใจ เจตคติ แรงจูงใจใฝ่สัมฤทธิ์ ความสนใจ การวัดความพึงพอใจของนักเรียนที่มีต่อการเรียนรู้ด้วย
บทเรียนบนเครือข่ายที่ผู้วิจัยพัฒนาขึ้น เป็นแบบมาตราส่วนประมาณค่า (Rating Scale) มี 5 ระดับ 
ส าหรับเลือกตอบคือ มากที่สุด มาก ปานกลาง น้อย น้อยที่สุดและน าค่าเฉลี่ยที่ได้จากแบบสอบถาม 
มาแปลความหมายเป็นระดับ สร้างโดยยึดตามแบบประเมินบทเรียนบทเรียนบนเครือข่าย  
(ไชยยศ  เรืองสุวรรณ.    2552  :  139) โดยเปรียบเทียบเกณฑ์แปลความหมาย ดังนี้    
     ค่าเฉลี่ย   ระดับความพึงพอใจ   
     4.50-5.00   มากที่สุด   
     3.50-4.49   มาก   
     2.50-3.49   ปานกลาง   
     1.50-2.49   น้อย   
     1.00-1.49   น้อยที่สุด    
  การสร้างข้อค าถามเพ่ือประเมินความพึงพอใจต่อสิ่งใดสิ่งหนึ่ง  คุณลักษณะส าคัญ ของ
มาตรวัดความรู้สึก (Affective) คือ การประเมินว่าชอบหรือไม่ชอบ การสร้างข้อค าถามมีสิ่งต้องระวัง 
ในเรื่องต่อไปนี้ จิระวัฒน์  วงศ์สวัสดิวัฒน์  (2547  :  47)    
   1. อย่าให้มีข้อที่กล่าวถึงความเป็นจริง หรือแปลได้ว่าเป็นจริง   
   2. หลีกเลี่ยงการใช้ค า เสมอ ไม่มี ไม่เคย ทั้งหมด   
   3. ค าว่า เท่านั้น เพียงแต ่มักจะ ควรใช้ด้วยความระมัดระวัง   
   4. หลีกเลี่ยงการใช้ค าถามแบบค าถามน า   
   5. หลีกเลี่ยงการใช้ประโยคปฏิเสธซ้อนปฏิเสธ   
   6. หลีกเลี่ยงการใช้ประโยคท่ีสามารถแปลได้มากกว่าหนึ่ง    
   7. ค าถามหนึ่ง ๆ ต้องถามเพียงเรื่องเดียว   
   8. ค าถามท่ีถาม ต้องแน่ใจว่าผู้ตอบมีความรู้ในเรื่องนั้น   
   9. พยายามตัดข้อที่มีแนวโน้มว่าทุกคนจะตอบเหมือนกันออก   
   10. ต้องไม่มีค าถามท่ีพาดพิงถึงอดีต   
   11. ใช้ประโยคง่าย ๆ ชัดเจน และสั้น ไม่ควรเกิน 20 ค า   
   12. ค าถามท่ีระบุถึงด้านดีและด้านไม่ดีของสิ่งที่จะวัด (ประโยค Positive และ 
Negative) ควรมีจ านวนข้อพอ ๆ กัน  
   13. จ านวนค าถามต้องไม่มากเกินไป ควรมีพอที่จะครอบคลุมเนื้อหาท่ีส าคัญเท่านั้น 
เพราะถ้ายาวเกินไปผู้ตอบจะเบื่อ   
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   14. ค าถามแต่ละข้อควรจะเขียนลงในบัตร 3 X 5 นิ้ว เวลาแก้หรือดึงออกหรือ 
เพ่ิมเติม จะได้ท าได้ง่ายและง่ายต่อการเรียงหัวข้อใหม่จากง่ายไปยาก หรือเรียงตามเนื้อหาแล้ว 
แต่ความต้องการ  
   15. ถ้าเป็นค าถามท่ีส่งให้ผู้ตอบตอบเอง ค าชี้แจงจะต้องชัดเจน สมบูรณ์และ เข้าใจง่าย 
นอกจากนี้การวางรูปค าถามควรมีลักษณะชวนให้ตอบ เป็นระเบียบ และการเรียงเรื่องก็ ควรเป็นไปตาม
หลักจิตวิทยาเช่น เรียงจากเรื่องท่ีง่ายและท่ัว ๆ ไปก่อน แล้วจึงถึงเรื่องที่ยากและ เฉพาะเจาะจง  
  สรุปได้ว่า ความพึงพอใจในการเรียน และผลการเรียนจะมีความสัมพันธ์กันในทางบวก
ทั้งนี้ข้ึนอยู่กับกิจกรรมที่ผู้เรียนได้ปฏิบัตินั้น ท าให้ผู้เรียนได้รับการตอบสนองความต้องการทางด้าน
ร่างกายและจิตใจ ซึ่งเป็นส่วนส าคัญท่ีจะท าให้เกิดความสมบูรณ์ของชีวิตมากน้อยเพียงใด นั่นคือสิ่งที่
ผู้สอนจะค านึงถึงองค์ประกอบต่างๆ ในการเสริมสร้างความพึงพอใจในการเรียนรู้ให้กับผู้เรียน 
  
งานวิจัยท่ีเกี่ยวข้อง 
 
 1. งานวิจัยในประเทศ 
  วิสุทธิพงศ์  ยอดเสาดี  (2553  :  84 - 85) ผลการศึกษาค้นคว้าพบว่า การพัฒนาบทเรียน 
ออนไลน์กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี เรื่อง เทคโนโลยีสารสนเทศและคอมพิวเตอร์  
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่1 พบว่า 1) บทเรียนออนไลน์ กลุ่มสาระการเรียนรู้การงานอาชีพ 
และเทคโนโลยี เรื่อง เทคโนโลยีสารสนเทศและคอมพิวเตอร์ ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่1  
มีประสิทธิภาพ เท่ากับ 77.22/86.78 สูงกว่าเกณฑ์ 75/75 2) นักเรียนชั้นมัธยมศึกษาปีที่ 1/4  
มีผลสัมฤทธิ์ทางการเรียนหลังเรียนโดยใช้บทเรียนออนไลน์ กลุ่มสาระการเรียนรู้การงานอาชีพและ 
เทคโนโลยี เรื่อง เทคโนโลยีสารสนเทศและคอมพิวเตอร์ ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่1 สูงกว่า
เกณฑ ์ร้อยละ 75 อย่างมีระดับนัยส าคัญทางสถิติที่ระดับ .01 และ 3) นักเรียน ชั้นมัธยมศึกษาปีที ่1/4 
มีความคิดเห็นต่อการเรียนด้วยบทเรียนออนไลน์ กลุ่มสาระการเรียนรู้ การงานอาชีพและเทคโนโลยี 
เรื่อง เทคโนโลยีสารสนเทศและคอมพิวเตอร์ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่1 อยู่ในระดับมาก 
  สามารถ  สิงห์มา  (2555  :  64-65) ผลการศึกษาค้นคว้าพบว่า ผลการเรียนบทเรียน 
เว็บแบบผสมผสาน เรื่อง วิวัฒนาการของดาวฤกษ์ส าหรับนักศึกษาระดับปริญญาตรี ชั้นปีที่ 2 
มหาวิทยาลัยขอนแก่น พบว่า 1) มีประสิทธิภาพเท่ากับ 81.69/80.63 สูงกว่าเกณฑ์ 80/80 2) มีค่าดัชนี
ประสิทธิผลเท่ากับ  0.6497 คิดเป็นร้อยละ 64.97 3) มีผลสัมฤทธิ์ทางการเรียนเพิ่มขึ้นจากก่อนเรียน 
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 4) มีความพึงพอใจต่อการเรียนด้วยบทเรียนโดยรวมอยู่ในระดับ
มากที่สุด 5) มีความคงทนในการเรียนรู้ คิดเป็นร้อยละ 99.60 ซึ่งไม่แตกต่างจากคะแนนเฉลี่ยหลังเรียน 
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05  
  ศิริพร  พลพุฒินันท์  (2555  :  111-117) ผลการศึกษาค้นคว้าพบว่า การเปรียบเทียบ 
ผลการเรียนเรื่อง การสร้างผลงานการน าเสนอแบบมัลติมีเดีย ชั้นประถมศึกษาปีที่ 6 ระหว่างการเรียน 
โดยใช้บทเรียนบนเว็บที่พัฒนาตามหลักการจัดกิจกรรม Synecticsd กับการเรียนปกติ พบว่า 
1) มีประสิทธิภาพเท่ากับ 84.77/80.71 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนดไว้คือ 80/80 2) มีค่าดัชนี
ประสิทธิผลเท่ากับ  0.5897 คิดเป็นร้อยละ 58.97 3) มีทางการเรียน ความคิดสร้างสรรค์ และแรงจูงใจ
ใฝ่สัมฤทธิ์หลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05  4) ผลสัมฤทธิ์ทางการเรียน 
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ความคิดสร้างสรรค์ และแรงจูงใจใฝ่สัมฤทธิ์หลังเรียนของนักเรียนที่เรียนโดยใช้บทเรียนบนเว็บสูงกว่า
กลุ่มที่เรียนแบบปกติอย่างมีนัยส าคัญทางสถิติท่ีระดับ .05 
  สวลี  มูลวณิชย์  (2555  :  58 - 59) ผลการศึกษาค้นคว้าพบว่า ผลการพัฒนาบทเรียน 
บนเว็บ เรื่องการออกแบบระบบเครือข่ายและเครือข่ายอินเตอร์เน็ตด้วยการเรียนแบบผสมผสานของ
นักศึกษาชั้นประกาศนียบัตรวิชิชีพชั้นสูง พบว่า 1) มีประสิทธิภาพ เท่ากับ 88.46/91.67 ซึ่งเป็นไปตาม
เกณฑ์ท่ีก าหนดไว้คือ 80/80 2) มีค่าดัชนีประสิทธิผลเท่ากับ 0.8304 คิดเป็นร้อยละ 83.04 3)  
นักศึกษามีความพึงพอใจต่อการเรียนด้วยบทเรียนโดยรวมอยู่ในระดับมาก  
  นุชนภา  อินธแสน ิ (2555  :  107 - 112) ผลการศึกษาค้นคว้าพบว่า การเปรียบเทียบ
ผลสัมฤทธิ์ทางการเรียน ปฏิสัมพันธ์ของนิสิตที่เรียนด้วยบทเรียนบนเครือข่ายแบบเว็บเควสท์กับบทเรียน
บนเครือข่ายแบบปกติวิชา ทฤษฎีและการปฏิบัติด้านการเรียนรู้บนเครือข่าย พบว่า 1) มีประสิทธิภาพ
เท่ากับ 85.89/89.73 และบทเรียนบนเครือข่ายแบบปกติ มีประสิทธิภาพ เท่ากับ 80.85/85.20 ซึ่งสูง
กว่าเกณฑ์ท่ีตั้งไว 2) ดัชนีประสิทธิผล มีค่าเท่ากับ .07103 และ 0.6275 แสดงว่า นิสิตมีความก้าวหน้า  
ทางการเรียนคิดเป็นร้อยละ 71.03 และ 62.75 ตามล าดับ 3) นิสิตที่เรียนด้วยบทเรียนบนเครือข่าย 
แบบเว็บเควสท์ มีผลสัมฤทธิ์ทางการเรียนหลังเรียนสูงกว่านิสิตที่เรียนรู้ด้วยบทเรียนบนเครือข่ายแบบ
ปกต ิอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 4) นิสิตที่เรียนด้วยบทเรียนบนเครือข่ายแบบเว็บเควสท์  
มีปฏิสัมพันธ์โดยรวมและเป็นรายข้ออยู่ในระดับมากถึงมากท่ีสุด ซึ่งมากกว่านิสิตที่เรียนรู้ด้วยบทเรียน
บนเครือข่ายแบบปกติ อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 5) นิสิตมีความพึงพอใจต่อการเรียนรู้ด้วย
บทเรียนบนเครือข่ายแบบเว็บเควสท์และบทเรียนบนเครือข่ายแบบปกติ โดยรวมและเป็นรายด้าน 
อยู่ในระดับมาก    
  ธีระศักดิ์  เกียงขวา  (2555  :  113 - 115) ผลการศึกษาค้นคว้าพบว่า ผลการเรียนด้วย
บทเรียนบนเว็บแบบผสมผสาน เรื่อง หลักการใช้สื่อการเรียนการสอนที่มีต่อผลการเรียนของนิสิตระดับ
ปริญญาตรีที่มีการรู้คอมพิวเตอร์และการน าการเรียนด้วยตนเองต่างกัน  พบว่า 1) มีประสิทธิภาพ เท่ากับ 
80.75/80.68 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนดไว้คือ 80/80 2) มีค่าดัชนีประสิทธิผลเท่ากับ 0.7066  
ซึ่งแสดงว่านักศึกษามีความก้าวหน้าในการเรียนร้อยละ 70.66 3) นิสิตโดยรวมและจ าแนกตาม 
การรู้คอมพิวเตอร์ และการน าการเรียนด้วยตนเองหลังจากเรียนด้วยบทเรียนแบบผสมผสาน  
เรื่อง หลักการใช้สื่อการสอน มีผลสัมฤทธิ์ทางการเรียน และการคิดวิเคราะห์โดยรวมและเป็นรายด้าน
เพ่ิมข้ึนจากก่อนเรียน อย่างมีนัยส าคัญ ทางสถิติท่ีระดับ .05 4) มีปฏิสัมพันธ์ระหว่างการรู้คอมพิวเตอร์
และการน าการเรียนด้วยตนเองต่อการมีผลสัมฤทธิ์ทางการเรียนของนิสิตอย่างมีนัยส าคัญทางสถิติ  
โดยนิสิตที่มีการรู้คอมพิวเตอร์ต่ า และมีการน าการเรียนด้วยตนเองต่ ามีผลสัมฤทธิ์การเรียนต่ ากว่า 
นิสิตกลุ่มอ่ืน (p<.025) แต่ไม่มีปฏิสัมพันธ์ระหว่างการมีการรู้คอมพิวเตอร์ และการน าการเรียนด้วย
ตนเองต่อการมีการคิดวิเคราะห์โดยรวมและเป็นรายด้าน และนิสิตที่มีการรู้คอมพิวเตอร์ต่างกัน หรือ
นิสิตที่มีการน าการเรียนด้วยตนเองต่างกันมีการคิดวิเคราะห์โดยรวม และรายด้านไม่แตกต่างกัน  
5) นิสิตที่มีความรู้คอมพิวเตอร์ต่างกัน มีความคงทนในการเรียนรู้หลังเรียนไปแล้ว 2 สัปดาห์ ไม่แตกต่าง
กัน แต่นิสิตที่มีการน าการเรียนด้วยตนเองสูง มีความคงทนในการเรียนมากกว่านิสิตที่มีการน าการเรียน
ด้วยตนเองต่ า อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และไม่มีปฏิสัมพันธ์ระหว่างการรู้คอมพิวเตอร์และ
การน าการเรียนรู้ด้วยตนเองต่อการมีความคงทนในการเรียนรู้  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Mahasarakham University 



42 

  ฉัตรวิรุณ  ห่อทรัพย์  (2555  :  129-131) ผลการศึกษาค้นคว้าพบว่า การเปรียบเทียบผล
การเรียนรู้ เรื่องการสะกดค า ของนักเรียนชั้นประถมศึกษาปีที่ 2 ที่เรียนด้วยบทเรียนบนเว็บแบบร่วมมือ 
กับการเรียนแบบปกติ พบว่า 1) มีประสิทธิภาพเท่ากับ 92.10/90.50 ซ่ึงสูงกว่าเกณฑ์มาตรฐาน 80/80 
ที่ก าหนดไว้ 2) มีค่าดัชนีประสิทธิผลเท่ากับ 0.8333 หรือคิดเป็นร้อยละ 83.33 3) นักเรียนที่เรียนด้วย
บทเรียนบนเว็บและนักเรียนที่เรียนแบบปกติ มีผลสัมฤทธิ์ทางการเรียนและทักษะการอ่านแตกต่างกัน 
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 4) นักเรียนที่เรียนด้วยบทเรียนบนเว็บ มีผลสัมฤทธิ์ทางการเรียน
และทักษะการอ่านสูงกว่านักเรียนที่เรียนแบบปกติ (p < .0001)  
  แสวง  ชุมแวงวาปี  (2555  :  82 - 83) ผลการศึกษาค้นคว้าพบว่า การพัฒนาบทเรียน 
บนเว็บ โดยใช้กระบวนการเรียนแบบผสมผสาน เรื่องการใช้โปรมแกรมอ่านหน้าจอ ส าหรับนักเรียน 
ชั้นมัธยมศึกษาตอนต้นที่มีความบกพร่องทางการเห็น พบว่า 1) มีประสิทธิภาพเท่ากับ 81.81/81.25  
ซึ่งเป็นไปตามเกณฑ์ 75/75 2) มีค่าดัชนีประสิทธิผล เท่ากับ 0.7043 คิดเป็นร้อยละ 70.43 3) ผลการ
เปรียบเทียบผลสัมฤทธิ์ทางการเรียนระหว่างการสอบก่อนและหลังเรียนด้วยการสอนด้วยบทเรียน 
บนเว็บแบบผสมผสาน เรื่องการใช้โปรแกรมอ่านหน้าจอ ส าหรับนักเรียนชั้นมัธยมศึกษาตอนต้น 
ที่มีความบกพร่องทางการเห็น นักเรียนมีความก้าวหน้าทางการเรียน 4) นักเรียนกลุ่มทดลองมีความพึง
พอใจต่อการจัดการเรียนด้วยโปรแกรมอ่านหน้าจอ ส าหรับนักเรียนชั้นมัธยมศึกษาตอนต้น อยู่ในระดับ
มากที่สุด 5) นักเรียนกลุ่มทดลองมีพฤติกรรมการเรียนต่อการจัดการเรียนด้วยโปรแกรมอ่านหน้าจอ  
ส าหรับนักเรียนชั้นมัธยมศึกษาตอนต้น อยู่ในระดับดี   
  อรวรรณ  คิดถูก  (2555  :  86 - 90) การเปรียบเทียบผลการเรียน เรื่อง เทคโนโลยี
สารสนเทศและการสื่อสาร ชั้นมัธยมศึกษาปีที่ 4 ระหว่างการเรียนด้วยบทเรียนบนเว็บแบบ Big Six 
Skills และการเรียนแบบปกติ พบว่า 1) มีประสิทธิภาพเท่ากับ 83.38/81.03 ซึ่งเป็นไปตามเกณฑ์ 
ที่ก าหนดไว้ 2) มีค่าดัชนีประสิทธิผลเท่ากับ 0.7016 แสดงว่านักเรียนมีความก้าวหน้าทางการเรียน 
ร้อยละ 70.16 3) นักเรียนที่เรียนด้วยบทเรียนบนเว็บแบบ Big Six Skills เรื่องเทคโนโลยีสารสนเทศ
และการสื่อสาร มีผลสัมฤทธิ์ทางการเรียนและความสามารถในการคิดแก้ปัญหา มากกว่านักเรียนที่เรียน
แบบปกติ อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 4) นักเรียนชั้นมัธยมศึกษาปีที่ 4 มีความพึงพอใจมีต่อ
การเรียนด้วยบทเรียนบนเว็บแบบ Big Six Skills โดยรวมอยู่ในระดับมากที่สุด 5) นักเรียนที่เรียน 
ด้วยบทเรียนบนเว็บแบบ Big Six Skills มีพฤติกรรมการเรียนโดยรวมอยู่ในระดับดี 
  วราดา  ขันต ี(2555  :  93 – 99) ผลการศึกษาค้นคว้าพบว่า การเปรียบเทียบผลสัมฤทธิ์
ทางการเรียนและการคิดอย่างมีวิจารณญาณของนักศึกษาระดับประกาศนียบัตรวิชาชีพ  เรื่องการผลิต
สื่อสิ่งพิมพ์ที่เรียนด้วยบทเรียนบนเครือข่ายแบบ PBL กับ TAI พบว่า 1) มีประสิทธิภาพ 86.44/84.22 
และ 86.07/85.67 ตามล าดับ 2) มีค่าดัชนีประสิทธิผลเท่ากับ 0.62 และ 0.66 3) นักเรียนที่เรียน 
ด้วยบทเรียนบนเครือข่ายแบบ PBL กับบทเรียนบนเครือข่าย แบบ TAI มีผลสัมฤทธิ์ทางการเรียน และ
การคิดวิจารณญาณโดยรวม และเป็นรายด้านทั้ง 5 ด้านหลังเรียนสูงกว่าก่อนเรียนอย่างมีนัยส าคัญ 
ทางสถิติท่ีระดับ .05 4) นักเรียนที่เรียนด้วยบทเรียนบนเครือข่ายแบบ PBL กับบทเรียนบนเครือข่าย
แบบ TAI ผลสัมฤทธิ์ทางการเรียนไม่ต่างกัน (p > .05) แต่นักเรียนที่เรียนด้วยบทเรียนบนเครือข่าย 
แบบ PBL มีการคิดวิจารณญาณ โดยรวมและเป็นรายด้าน 4 ด้าน คือ ด้านการยอมรับข้อตกลงเบื้องต้น 
ด้านการนิรนัย ด้านการตีความ และด้านการประเมินข้อโต้แย้ง สูงกว่านักเรียนที่เรียนด้วยบทเรียนบน
เครือข่ายแบบ TAI อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 ส่วนด้านด้านการอนุมานไม่ต่างกันกับนักเรียน
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ที่เรียนด้วยบทเรียนบนเครือข่ายแบบ PBL 5) นักเรียนระดับประกาศนียบัตรวิชาชีพ ชั้นปีที่ 2  
มีความพึงพอใจโดยรวมต่อการเรียนด้วยบทเรียนบนเครือข่ายแบบ PBL อยู่ในระดับมาก (×  = 4.40, 
S.D. = 0.72) และมีความพึงพอใจโดยรวมต่อการเรียนด้วยบทเรียนบนเครือข่ายแบบ TAI  
อยู่ในระดับมาก  (×  = 4.47, S.D. = 0.53)  
 2. งานวิจัยต่างประเทศ 
  ชู (Chuo.    2004  :  1703-A) ได้ศึกษาผลของเว็บเควสท์ที่มีต่อการแสดงออกและ 
ความเข้าใจทางการเขียนภาษาอังกฤษส าหรับชาวต่างประเทศ โดยเปรียบเทียบกลุ่มควบคุมซ่ึงใช้  
วิธีการสอนแบบปกติ จ านวน 52 คน และกลุ่มตัวอย่างซึ่งใช้วิธีสอนแบบเว็บเควสท์ จ านวน 51 คน 
พบว่า การแสดงออกทางการเขียนของผู้เรียนมีความแตกต่างกัน โดยผู้เรียนที่เรียนจากบทเรียน 
แบบเว็บเควสท์ มีการแสดงออกสูงกว่าผู้เรียนที่เรียนแบบปกติ ส่วนด้านความเข้าใจทางภาษา 
ให้ผลไม่แตกต่างกัน  
   Pucel  (2005  :  7) ประสิทธิผลและความพึงพอใจของนักศึกษากับการเรียนด้วย  
Web-Based เมื่อเทียบกับหลักสูตรการศึกษาของครูแบบดั้งเดิม (แบบปกติ) วัตถุประสงค์การศึกษา
การศึกษานี้มองที่ความสามารถของนักเรียนและความพึงพอใจของนักเรียนในสองหลักสูตรที่น าเสนอ
โดยมหาวิทยาลัยมินนิโซตาที่ใช้ในการบริการประกอบอาชีพและครูผู้สอนการศึกษาทางเทคนิคท่ีถูก
เตรียมการสอนโปรแกรมการประกอบอาชีพในโรงเรียนมัธยมปลายหรือระดับวิทยาลัยเทคนิคการศึกษา
เปรียบเทียบผลการปฏิบัติงานของนักเรียนและความพึงพอใจในการเพิ่มการสอน WBI ในชั้นเรียนสอง
ชั้นเรียนประสิทธิภาพการท างานและความพึงพอใจในเทียบเท่าห้องเรียนแบบดั้งเดิมเหมือนกันสองชั้น 
การศึกษาได้ด าเนินการเพื่อพัฒนารูปแบบทั่วๆ  ไปส าหรับการประเมินหลักสูตรการสอนด้วย WBI และ
เพ่ือตรวจสอบว่าถ้าหลักสูตรการสอนแบบ WBI มีผลลัพธ์ที่คล้ายกับหลักสูตรดั้งเดิม  (แบบปกติ) 
  Chikotas  (2005  :  1242-A) ได้ศึกษาการเรียนรู้จากปัญหาเป็นฐานในการศึกษา  
ของพยาบาลฝึกหัดรวมถึงการฝึกหัดในคลินิก  จากมุมมองของผู้ฝึกหัดของนักศึกษาพยาบาล  
จ านวน  13 คน ผลการศึกษาพบว่า  ข้อมูลบทเรียนต่างๆ  ที่ได้จากห้องเรียนที่มีการใช้  หลักสูตร  
PBL เข้าไปสอนสามารถน าข้อมูลนั้นไปประยุกต์ใช้ในวิชาชีพพยาบาลได้จริง  การวิเคราะห์ข้อมูลยัง
สนับสนุนว่าหลักสูตร  PBL นี้คือการเรียนรู้จากประสบการณ์ตรงของผู้เรียนและเป็นการเรียนรู้  
ที่ต้อง ใช้เวลานานตลอดชีวิต   
  Garcia (2005  :  1067) ได้วิจัยเปรียบเทียบการสอนแบบวัฏจักรการเรียนรู้ 5 ขั้น กับ
การสอนแบบดั้งเดิมในโรงเรียนระดับกลางของสเปน จากการศึกษาใช้จ านวนผู้เรียนในชั้นปีที่ 7  
จ านวน 160 คน เปรียบเทียบคะแนนหลังเรียนจากกลุ่มที่ศึกษาไม่มีความแตกต่างอย่างมีนัยส าคัญ  
ทางสถิติเก่ียวกับความเข้าใจ หรือหัวข้อของวิทยาศาสตร์ การค้นพบวิธีการนวัตกรรมการเรียนรู้ 
โดยเฉพาะอย่างยิ่งรูปแบบวัฏจักรการเรียนรู้ 5 ขั้น เป็นตัวอย่างการค้นคว้าวิจัยที่ดี เพราะมีการพัฒนา
ปรับปรุงคะแนนที่ต่ าของผู้เรียนให้ดีขึ้นได้ 
  Kundu และ Bain  (2006  :  15) กล่าวว่า  เว็บเควสท์เป็นสื่อทางเทคโนโลยีที่อ านวย
ความสะดวกในการเรียนรู้อย่างมีความหมาย การสอนให้นักศึกษาฝึกสอนสร้างเว็บเควสท์ ร่วมกับ 
การเรียนรู้แบบสร้างความรู้ด้วยตนเอง  (Constructivist learning) จะท าให้นักศึกษาฝึกสอนเกิด  
การเรียนรู้อย่างมีความหมายผ่านการสะท้อน และการตัดสินจากการขัดแย้งทางความคิด (Cognitive 
conflict) นอกจากนี้ยังท าให้นักศึกษาฝึกสอนมีส่วนร่วมในการแก้ปัญหา หลังจากสร้างเว็บเควสท ์
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พบว่า  นักศึกษาฝึกสอนสามารถเชื่อมโยงสิ่งใหม่  ๆ เพ่ือสร้างผลผลิตและความเข้าใจใน  
การประยุกต์ใช้เทคโนโลยี ส่งผลให้เกิดความคิดสร้างสรรค์ มีการคิดอย่างมีวิจารณญาณ  
(Critical thinking) และทักษะการแก้ปัญหา 
  Bennison  (2006  :  unpaged) ได้ศึกษาเพ่ือมุ่งเน้นที่การตรวจสอบขั้นตอนที่น ามา  
โดยการบริหารที่วิทยาลัยเล็ก ๆ แห่งหนึ่ง เพ่ือน าการเปลี่ยนแปลงเป็นการตรวจสอบสนองต่อเรียน  
แบบ E-learning ขั้นตอนที่น าเข้ามาเพ่ือสนับสนุนการเริ่มต้นใหม่ๆ และทัศนคติที่มีอยู่ในระหว่าง 
ผู้บริหารและอาจารย์เพ่ือสนับสนุนและท าให้ง่ายต่อการพัฒนาการศึกษาทางไกลจะมีการสัมภาษณ์ 
อาจารย์และผู้บริหาร เพ่ือก าหนดขั้นตอนที่น ามาซึ่งการเรียนแบบ e-learning ความสนใจพิเศษคือ  
กลยุทธ์ที่ใช้เพ่ือสนับสนุนอาจารย์ในระหว่างที่มีการเปลี่ยนแปลงในวิธีการเรียนและการสอน   
  Robinson  (2006  :  unpaged) ได้ศึกษาสิ่งแวดล้อมในโรงเรียนระดับกลาง 
โดยใช้ทักษะการคิดวิจารณญาณ จุดมุ่งหมายเพ่ือศึกษาข้อสรุปของหลักสูตรศึกษาสิ่งแวดล้อมโดย
ประเมินทักษะการคิดวิจารณญาณ การศึกษาสุ่มประเมินจากห้องที่ 6, 7 และ 8 จาก 5 โรงเรียนที่
แตกต่างกัน ผู้เรียนในห้องที่ทดลองประกอบด้วย กลุ่มศึกษาเรื่องน้ าจ านวน 48 คน กลุ่มท่ีศึกษา 
เรื่องป่า  จ านวน 61 คน กลุ่มท่ีเรียนรู้เรื่องต้นไม้จ านวน 45 คน หรือกลุ่มสืบเสาะและประเมิน
สิ่งแวดล้อม  จ านวน 44 คน ห้องเปรียบเทียบเป็นกลุ่มควบคุม จ านวน 48 คน ผู้เรียนทั้งหมดสอบ
เนื้อหาก่อนเรียนในบทเรียนที่เรียน 8 สัปดาห์ จาก 16 บทเรียน แล้วท าการทดสอบหลังเรียน  
ผลจากการศึกษาพบว่า 30.3 เปอร์เซ็นต ์ของตัวแปรในคะแนนการคิดวิจารณญาณสามารถอธิบาย 
ความแตกต่างของการศึกษาหลักสูตรโดยปราศจากอิทธิพลของตัวแปร ระดับผู้เรียนเพศ สถานะ 
ความสามารถการทดสอบก่อนเรียนเป็นส่วนหนึ่งที่มีผลให้ตัวแปรมีการเปลี่ยนแปลง 3.59 เปอร์เซ็นต์ 
  เวตตี้  (Vietti.    2006  :  บทคัดย่อ) ได้ศึกษาการน าเอาคอมพิวเตอร์ช่วยสอนมาใช้  
ในการจัดการเรียนการสอนแบบห้องเรียนรวมหลายระดับในเวลาเดียวกัน เพ่ือให้มีมาตรฐานและ 
เป็นบรรทัดฐานเดียวกัน เกี่ยวกับค าอธิบาย การวัดผลประเมินผลพบว่า วิธีที่จะได้มาซึ่งมาตรฐาน 
ดังกล่าว คือ การสร้างบทเรียนคอมพิวเตอร์ช่วยสอน มาช่วยในการจัดการเรียนการสอน  
ซึ่งเป็นเครื่องมือที่มีประสิทธิผลอย่างยิ่งส าหรับครูทุกคน เพราะบทเรียนคอมพิวเตอร์ช่วยสอนใช้ได้ทุก
เวลาทุกสถานที ่กี่ครั้งก็ได้ โดยผู้เรียนสามารถพัฒนาตนเองและรู้ว่าจุดอ่อนตัวเอง คืออะไร และ
นอกจากนี้ ผู้สอนยังสมารถสร้างข้อสอบ หรือเนื้อหาที่มีความเป็นปรนัย ที่ใช้ได้ผลกับทั้งผู้เรียนกลุ่มใหญ่ 
กลุ่มเล็ก ต่างระดับ หรือรายบุคคล และท าให้ผลสัมฤทธิ์ทางการเรียนก่อนเรียนและหลังเรียนต่างกัน
อย่างมีนัยส าคัญและแปลผลได้มาตรฐานเดียวกัน  
  โดยสรุป  จากงานวิจัยทั้งในประเทศและต่างประเทศจะเห็นได้ว่า การเรียนการสอน
บทเรียนออนไลน์ช่วยพัฒนารูปแบบการเรียนการสอนให้มีความน่าสนใจ เป็นสื่อที่ทันสมัย และเปิด
โอกาสทางการศึกษาแก่ผู้เรียน โดยขจัดปัญหาทางด้านเวลา และสถานที ่ทั้งนี้เพ่ือหาผลสรุปว่าผลที่ได้
จากการวิจัยจะน าไปใช้ในการจัดการเรียนการสอนเพ่ือให้ผู้เรียนเกิดความรู้  เพ่ือน าไปใช้ประโยชน์ได้
มากที่สุด อาจกล่าวได้ว่า บทเรียนออนไลน์เป็นนวัตกรรมทางเทคโนโลยีที่มีประสิทธิภาพต่อการจัดการ
เรียนการสอนเป็นอย่างมาก การสร้างหรือพัฒนาและการหาประสิทธิภาพบทเรียนออนไลน์ก็ 
เพ่ือน าประโยชน์ไปใช้เป็นสื่อในการจัดกระบวนการเรียนการสอน ท าให้ผู้เรียนเกิดความสนใจ  
มีความกระตือรือร้น สามารถศึกษาค้นคว้าด้วยตนเอง และท าให้เกิดการพัฒนาในการเรียนรู้ 
บนเครือข่าย ส่งผลให้เกิดกระบวนการคิด และความสามารถในการคิดวิเคราะห์ของผู้เรียน  
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บทที่ 3 
 

วิธีด าเนินการศึกษาค้นคว้า 
 

 การศึกษาค้นคว้าครั้งนี้ เป็นการศึกษาค้นคว้า เพ่ือพัฒนาโปรแกรมบทเรียนออนไลน์ 
เรื่องการใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 ซึ่งมีวิธีการด าเนินการศึกษาค้นคว้า ดังนี้ คือ 
  1. ประชากรและกลุ่มตัวอย่าง 
  2. เครื่องมือที่ใช้ในการศึกษาค้นคว้า 
  3. วิธีการสร้างเครื่องมือในการศึกษาค้นคว้า 
  4. วิธีด าเนินการทดลองและการเก็บรวบรวมข้อมูล 
  5. การจัดกระท าและการวิเคราะห์ข้อมูล 
  6. สถิติที่ใช้ในการวิเคราะห์ข้อมูล 
 
ประชากรและกลุ่มตัวอย่าง 
 
 1. ประชากรและกลุ่มตัวอย่าง 
  1.1 ประชากรที่ใช้ในการศึกษาครั้งนี้ เป็นนิสิตที่ก าลังศึกษาอยู่ในระดับชั้นปีที่ 1  
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม 
ปกีารศึกษา 2556  จ านวน  2  กลุ่ม  60 คน 
  1.2 กลุ่มตัวอย่างท่ีใช้ในการศึกษาค้นคว้าครั้งนี้ เป็นนิสิตที่ก าลังศึกษาอยู่ในระดับชั้นปีที่ 1 
สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม 
ปกีารศึกษา 2556 กลุ่มท่ี 2 จ านวน 30 คน ได้มาโดยการเลือกแบบเจาะจง (Purposive Sampling) 
เนื่องจากเป็นนักศึกษาที่มีผลสัมฤทธิ์ทางการเรียนไม่แตกต่างกัน 
 
เครื่องมือที่ใช้ในการศึกษาค้นคว้า 
 
 เครื่องมือที่ใช้ในการศึกษาค้นคว้าครั้งนี้ประกอบด้วย 
  1. โปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  จ านวน 5 หน่วย
การเรียนรู้ใช้เวลา 16 ชั่วโมง ประกอบด้วย 
   หน่วยที่ 1 เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0  เวลา 1 ชั่วโมง 
    หน่วยที่ 2 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer  เวลา 3 ชั่วโมง 
    หน่วยที่ 3 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Impress  เวลา 4 ชั่วโมง 
    หน่วยที่ 4 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc  เวลา 4 ชั่วโมง 
    หน่วยที่ 5 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base  เวลา 4 ชั่วโมง 
  2. แบบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ซอฟต์แวร์ openoffice.org  มี 1 ชุด  
เป็นแบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จ านวน 30 ข้อ 
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  3. แบบวัดความพึงพอใจของนิสิตที่มีต่อโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้
ซอฟต์แวร์ openoffice.org  เป็นแบบมาตราส่วนประมาณค่า (Rating Scale) แบ่งระดับความพึงพอใจ
เป็น 5 ระดับ คือ มากที่สุด มาก ปานกลาง น้อย และน้อยที่สุด จ านวน 15 ข้อ   
 
การสร้างและหาคุณภาพเครื่องมือ 
 
 ในการวิจัยครั้งนี้ผู้วิจัยได้ใช้เครื่องมือในการเก็บรวบรวมข้อมูล และวิธีสร้างตามข้ันตอนดังนี้ 
  1. การสร้างโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
ผู้วิจัยได้ด าเนินการสร้างตามล าดับขั้นตอน ดังนี้ 
   1.1 ศึกษาหลักสูตรและวิเคราะห์เนื้อหา เรื่อง การใช้ซอฟต์แวร์ openoffice.org   
ซึ่งมีเนื้อหาทั้งหมด 5 หน่วยการเรียน ได้แก่  
    หน่วยที่ 1 เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0   
     หน่วยที่ 2 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer   
     หน่วยที่ 3 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Impress   
     หน่วยที่ 4 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc   
     หน่วยที่ 5 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base   
    เพ่ือน ามาสร้างเป็นโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org และเอกสารประกอบการเรียนการสอนที่เกี่ยวข้อง เพ่ือท าความเข้าใจกับมาตรฐาน
การเรียนรู้ของบทเรียน ขอบข่ายเนื้อหา ผลการเรียนรู้ที่คาดหวัง วิธีการสอน และการวัดผลประเมินผล 
ดังนี้ 
    1.1.1 ก าหนดจุดประสงค์การเรียนรู้ และจุดประสงค์เชิงพฤติกรรม เพ่ือก าหนด 
ขอบข่ายเนื้อหาในแต่ละหน่วยการเรียน 
    1.1.2. ก าหนดขอบข่ายของการน าเสนอเนื้อหาในบทเรียน  โดยแบ่งเนื้อหาออกเป็น
แต่ละตอน จัดตามล าดับ ก าหนดกิจกรรมการเรียนการสอน 
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ตาราง 4 วิเคราะห์เนื้อหาบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org 
 

หน่วยการเรื่องรู้ เนื้อหา จุดประสงค์การเรียนรู้ 
จ านวน
ชั่วโมง 

1. แนะน าและ  
   การติดตั้ง    
   OpenOffice. 
   org 2.0   

1. ประวัติความเป็นมาของ   
    OpenOffice 
2. ติดตั้งโปรแกรม   
    OpenOffice  
3. ตั้งค่าเมนูภาษาไทย  
    OpenOffice  
4. ยกเลิกการติดตั้ง      
    OpenOffice  

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับ 
   ประวัติความเป็นมาของ OpenOffice 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ติดตั้งโปรแกรม OpenOffice ได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ตั้งค่าเมนูภาษาไทย OpenOffice ได ้
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ยกเลิกการติดตั้ง OpenOffice ได้ 

1 

2. การใช้งาน 
   โปรแกรม  
   OpenOffice. 
   org Writer   

1. หน้าจอโปรแกรม Writer 
2. การสร้างเอกสารใหม่ 
3. การเปิดเอกสารเดิม 
4. การสั่งพิมพ์และส่งออกเป็น  
    PDF  
5. การจัดรูปแบบตัวหนังสือ 
6. การจัดรูปแบบย่อหน้า 
7. การใช้แถบไม้บรรทัดและ 
    การตั้งระยะก้ัน 
8. การตรวจค่าผิด 
9. การค้นหาและแทนที่ 
10. การตั้งค่าหน้ากระดาษ 
11. รายการและรายการ 
    ล าดับ 
12. การใช้ลักษณะและการ 
    จัดรูปแบบ 
13. การสร้างตาราง 
14. การแทรกรูปภาพ 
15. การวาดรูป 
 

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับ 
    หน้าจอโปรแกรม Writer 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถ  
    การสร้างเอกสารใหม่ได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    เปิดเอกสารเดิมได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สั่งพิมพ์และส่งออกเป็น PDF ได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    จัดรูปแบบตัวหนังสือได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    จัดรูปแบบย่อหน้าได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ใช้แถบไม้บรรทัดและการตั้งระยะกั้นได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ตรวจค่าผิดได ้
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ค้นหาและแทนที่ได้ 
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ตั้งค่าหน้ากระดาษได้ 
11. ผู้เรียนมีความรู้ความเข้าใจเกี่ยวกับ 
    รายการและรายการล าดับ 
12. ผู้เรียนมีความรู้ความเข้าใจและสามารถใช ้
    ลักษณะและการจัดรูปแบบได ้
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ตาราง 4  (ต่อ) 
 

หน่วยการเรื่องรู้ เนื้อหา ผลการเรียนรู้ที่คาดหวัง 
จ านวน
ชั่วโมง 

  13. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
     สร้างตารางได้ 
14. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    แทรกรูปภาพได้ 
15. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ใช้การวาดรูปได้ 

 

3. การใช้งาน 
    โปรแกรม  
    OpenOffice. 
    org Impress   

1. หน้าจอโปรแกรม Impress 
2. การสร้างเอกสารเปล่า 
3. สร้างการน าเสนอด้วย 
    แม่แบบ 
4. การตั้งค่าตัวเลือกและ 
    น าเสนองาน 
5. การพิมพ์และส่งออกข้อมูล 
6. การเปลี่ยนพื้นหลัง 
7. การจัดรูปแบบกล่อง 
    ข้อความ 
8. การสร้างแผนภูมิ 
9. การแทรกรูปภาพ 
10. ก าหนดการเปลี่ยนภาพนิ่ง 
 

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับ 
    หน้าจอโปรแกรม Impress 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างเอกสารเปล่าได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างการน าเสนอด้วยแม่แบบได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ตั้งค่าตัวเลือกและน าเสนองานได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    พิมพ์และส่งออกข้อมูลได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    เปลี่ยนพื้นหลังได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    จัดรูปแบบกล่องข้อความได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างแผนภูมิได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    แทรกรูปภาพได้ 
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ก าหนดการเปลี่ยนภาพนิ่งได้ 
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ตาราง 4  (ต่อ) 
 

หน่วยการเรื่องรู้ เนื้อหา ผลการเรียนรู้ที่คาดหวัง 
จ านวน
ชั่วโมง 

4. การใช้งาน 
    โปรแกรม  
    OpenOffice. 
    org Calc   

1. หน้าจอโปรแกรม 
2. การจัดการกับแฟ้ม 
3. ชนิดของข้อมูล 
4. การพิมพ์เอกสาร 
5. การเลือกช่วงเซลล์ 
6. การกรอกข้อมูลอัตโนมัติ  
    AutoFill  
7. การย้ายและคัดลอกข้อมูล 
8. การรวมผลและจัดรูปแบบ 
    อัตโนมัติ 
9. การใช้แผ่นงาน 
10. การป้องกันข้อมูล 
11. การจัดรูปแบบข้อมูล 
12. การบันทึกหมายเหตุและ
วางแบบพิเศษ 
13. การตรึงแนวและการแยก 
    แผ่นงาน 
14. การใช้สูตร 
15. การใช้ฟังก์ชั่น 
 

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับ   
    หน้าจอโปรแกรม 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    จัดการกับแฟ้มได้ 
3. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับชนิด 
    ของข้อมูล 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    พิมพ์เอกสารได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    เลือกช่วงเซลล์ได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    กรอกข้อมูลอัตโนมัติ AutoFill ได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ย้ายและคัดลอกข้อมูลได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    รวมผลและจัดรูปแบบอัตโนมัติได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ใช้แผ่นงานได ้
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ป้องกันข้อมูลได้ 
11. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    จัดรูปแบบข้อมูลได้ 
12. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    บันทึกหมายเหตุและวางแบบพิเศษได้ 
13. ผู้เรียนมีความรู้ความเข้าใจและสามารถ  
    ตรึงแนวและการแยกแผ่นงานได้ 
14. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ใช้สูตรได ้
15. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    ใช้ฟังก์ชั่นได้ 
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ตาราง  4 (ต่อ) 
 

หน่วยการเรื่องรู้ เนื้อหา ผลการเรียนรู้ที่คาดหวัง 
จ านวน
ชั่วโมง 

5. การใช้งาน 
    โปรแกรม  
    OpenOffice. 
    org Base   

1. หน้าจอโปรแกรม Base 
2. การสร้างตารางโดยใช้ตัว 
    ช่วงสร้าง 
3. การสร้างตารางในมุมมอง 
    การออกแบบ 
4. การสร้างตารางเชื่อมโยง 
    กับข้อมูลภายนอก 
5. การเรียงล าดับและการ 
    กรอกข้อมูลตาราง 
6. การสร้างข้อค าถามโดยใช้ 
    ตัวช่วยสร้าง 
7. การสร้างข้อค าถามโดยใช้ 
    มุมมองออกแบบ 
8. การสร้างฟอร์ม 
9. การแก้ไขฟอร์ม 
10. การสร้างรายงาน 

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับ 
    หน้าจอโปรแกรม Base 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างตารางโดยใช้ตัวช่วงสร้างได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างตารางในมุมมองการออกแบบได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
   สร้างตารางเชื่อมโยงกับข้อมูลภายนอกได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    เรียงล าดับและการกรอกข้อมูลตารางได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างข้อค าถามโดยใช้ตัวช่วยสร้างได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถ   
    สร้างข้อค าถามโดยใช้มุมมองออกแบบได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างฟอร์มได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    แก้ไขฟอร์มได้ 
10.ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
    สร้างรายงานได ้

4 

รวม 16 
 
   1.2 วิเคราะห์เนื้อหาวิชาและจุดประสงค์เชิงพฤติกรรม เพ่ือแสดงความสัมพันธ์  
ระหว่างเนื้อหากับจุดประสงค์เชิงพฤติกรรม แล้วน าเสนอประธานและกรรมการควบคุมวิทยานิพนธ์ 
และ ผู้เชี่ยวชาญด้านเนื้อหา ท าการตรวจสอบการใช้ภาษาในการเขียนยังไม่ถูกต้อง และความเท่ียงตรง
เชิงเนื้อหา (Content Validity) ผู้เชี่ยวชาญประกอบด้วย   
    1.2.1 ผู้ช่วยศาสตราจารย์ ดร.ทรงศักดิ์ ภูสีอ่อน สาขาวิชาวิจัยและพัฒนาการศึกษา  
คณะศึกษาศาสตร์  มหาวิทยาลัยมหาสารคาม 
    1.2.2 อาจารย์ ดร.ธัชชัย จิตรนันท ์สาขาวิชาการบริหารการศึกษา คณะ
ศึกษาศาสตร์  มหาวิทยาลัยมหาสารคาม 
    1.2.3 อาจารย์ ดร. คชากฤษ เหลี่ยมไธสง  สาขาวิชาสื่อนฤนิต คณะวิทยาการ
สารสนเทศ  มหาวิทยาลัยมหาสารคาม 
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    ผลการประเมิน จากการพิจารณาของผู้เชี่ยวชาญทั้ง 3 ท่าน พบว่า มีค่าตั้งแต่ 4.00 
- 5.00 มีค่าเฉลี่ยเท่ากับ 4.16 หมายความว่า โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org มีความเท่ียงตรงเชิงเนื้อหา แสดงว่า หน่วยการเรียนรู้และผลการเรียนรู้ที่คาดหวัง 
มีความสัมพันธ์กัน  
   1.3 น าเนื้อหาที่ได้วิเคราะห์จากผู้เชี่ยวชาญแล้ว จัดท าผังงาน (Flowchart)   
โปรแกรมบทเรียนออนไลน์ น าเสนอต่อประธานและกรรมการควบคุมวิทยานิพนธ์ แล้วเสนอผู้เชี่ยวชาญ
ด้านโปรแกรมคอมพิวเตอร์และด้านสื่อการสอน เพ่ือตรวจสอบความถูกต้องและความเหมาะสม  
   1.4 ออกแบบแผนโครงเรื่อง (Storyboard) โปรแกรมบทเรียนออนไลน์ เพ่ือออกแบบ 
หน้าเว็บเพจ แล้วน าเสนอให้ผู้เชี่ยวชาญด้านโปรแกรมคอมพิวเตอร์และผู้เชี่ยวชาญด้านสื่อการสอน 
ตรวจสอบความถูกต้องและความเหมาะสมซึ่งผู้เชี่ยวชาญประกอบด้วย 
    1.4.1 อาจารย์ ธนันชัย  ค าเกตุ  สาขาเทคโนโลยีสารสนเทศและการสื่อสาร  
คณะวิทยาการสารสนเทศ  มหาวิทยาลัยมหาสารคาม 
    1.4.2 อาจารย์ ดร.ธัชชัย จิตรนันท ์ สาขาวิชาการบริหารการศึกษา  
คณะศึกษาศาสตร์  มหาวิทยาลัยมหาสารคาม 
    1.4.3 อาจารย์ ดร. คชากฤษ เหลี่ยมไธสง  สาขาวิชาสื่อนฤนิต คณะวิทยาการ
สารสนเทศ  มหาวิทยาลัยมหาสารคาม 
   1.5 ศึกษาหลักการและเทคนิคของโปรแกรม และคัดเลือกโปรแกรมในการพัฒนา
โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  โดยส่วนของเนื้อหาบทเรียน  
ใช้โปรแกรม joomla เป็นโปรแกรมในการสร้างเว็บเพจ การเคลื่อนไหวของตัวอักษรใช้โปรแกรม 
Macromedia Flash และการสร้าง ตัดแต่งรูปภาพประกอบเนื้อเรื่องใช้โปรแกรม Adobe Photoshop 
และ โปรแกรม PHP Mysql เป็นฐานข้อมูลของโปรแกรมบทเรียนออนไลน์ 
   1.6 พัฒนาโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
   1.7 น าโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org ที่สร้าง 
เสร็จเรียบร้อยแล้วให้ ประธานและกรรมการควบคุมวิทยานิพนธ์ และผู้เชี่ยวชาญด้านโปรแกรมและสื่อ
การเรียนการสอน พิจารณาตรวจสอบความถูกต้อง และความเหมาะสมในการออกแบบบทเรียน  
ทั้งในด้านเนื้อหา ด้านการออกแบบการสอน และด้านการสื่อสาร/เชื่อมโยง ข้อมูล พบว่า ควรเพิ่มขนาด
ข้อความ ตัวอักษรให้ตัวใหญ่มากขึ้น แล้วน าไปปรับปรุงตามค าแนะน า    
   1.8 ทดสอบและตรวจสอบโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org ผ่านโปรแกรมเว็บเบราเซอร์ (Web Browrer) เพ่ือตรวจสอบข้อบกพร่องและ 
ข้อผิดพลาด    
   1.9 แก้ไขปรับปรุงโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
จากข้อบกพร่องและข้อผิดพลาดที่พบก่อนจะส่งขึ้นเครื่องแม่ข่าย (Up Load to Server) เพ่ือไป
แสดงผลจริงบนระบบเครือข่ายอินเทอร์เน็ต   
   1.10 ท าการส่งข้อมูลขึ้นเครื่องแม่ข่าย (Up Load to Server) ของระบบ Hosting  
Unlimited Datatransfer & Add Domain – Hosting (http://www.thanakorn-openoffice.com 
/index.php) เป็นการเช่าพ้ืนที่ในการวาง เนื้อหาและตัวโปรแกรมบทเรียนออนไลน์  
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   1.11 สร้างแบบประเมินคุณภาพโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org  ส าหรับผู้เชี่ยวชาญ 3 ด้าน ประกอบด้วย แบบประเมินส าหรับผู้เชี่ยวชาญ    
ด้านเนื้อหา ด้านโปรแกรมคอมพิวเตอร์ และด้านสื่อการสอน ตามล าดับ ซึ่งผู้ศึกษาค้นคว้าดัดแปลงมา
จาก ไชยยศ เรืองสุวรรณ  (2552  :  139)  แบบประเมินเป็นแบบมาตราส่วนประมาณค่า (Rating 
Scale) และแบบปลายเปิดในส่วนท้ายของการประเมิน เพื่อสอบถามความคิดเห็นและข้อเสนอแนะ 
ต่าง ๆ โดยแบ่งเกณฑ์เป็น 5 ระดับ ได้แก่ ดีมาก ดี ปานกลาง น้อย และน้อยที่สุด ดังนี้    
     ค่าเฉลี่ย    ระดับคุณภาพ   
     4.51-5.00   มีคุณภาพระดับดีมาก   
     3.51-4.50   มีคุณภาพระดับดี   
     2.51-3.50   มีคุณภาพระดับปานกลาง   
     1.51-2.50   มีคุณภาพระดับ น้อย   
     1.00-1.50   ยังต้อง น้อยที่สุด 
   1.12 น าแบบประเมินที่ดัดแปลงเสร็จแล้วไปเสนอ ประธานและกรรมการควบคุม  
วิทยานิพนธ์ ตรวจสอบความชัดเจนทางภาษา และความถูกต้องตามเนื้อหา แล้วน าไปปรับปรุงแก้ไข   
ตามค าแนะน า   
   1.13 น าแบบประเมินให้ผู้เชี่ยวชาญด้านการวัดผล ตรวจสอบความเที่ยงตรง   
เชิงเนื้อหา (Content Validity)    
   1.14 น าแบบประเมินที่ผ่านความเห็นชอบแล้วไปให้ผู้เชี่ยวชาญทั้ง 3 ด้าน ท า 
การประเมินโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org ด้วยแบบประเมิน  
3 แบบ ได้แก่   
    1.14.1 แบบประเมินของผู้เชี่ยวชาญด้านเนื้อหา ประเมินความถูกต้องของเนื้อหา   
การใช้ภาษา และการสรุป   
    1.14.2 แบบประเมินของผู้เชี่ยวชาญด้านโปรแกรมคอมพิวเตอร์ ประเมิน  
ด้านโครงสร้างของโปรแกรม ด้านการสื่อสาร / การเชื่อมโยงข้อมูล   
    1.14.3 แบบประเมินของผู้เชี่ยวชาญด้านสื่อการสอน ประเมินด้านการออกแบบ   
การสอนผ่านเว็บ ข้อบกพร่องที่พบ ได้แก่ ด้านสื่อการสอนเพ่ิมการเชื่อมโยงในบทเรียนและเพ่ิมรูปภาพ
ในบทเรียน    
     ด้านเนื้อหา    
      โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org 
มีคะแนนเฉลี่ยเท่ากับ 4.16 ซึ่งอยู่ในเกณฑ์คุณภาพในระดับดี 
       ด้านโปรแกรมคอมพิวเตอร์    
      โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
มีคะแนนเฉลี่ยเท่ากับ 4.17 ซึ่งอยู่ในเกณฑ์คุณภาพในระดับดี    
      ผู้เชี่ยวชาญให้ข้อเสนอแนะเกี่ยวกับการเชื่อมโยงของโปรแกรม  
ควรให้มี  ความต่อเนื่องกัน ระหว่างเนื้อหาของแต่ละหน่วยการเรียนรู้    
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     ด้านสื่อการสอน    
      โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
มีคะแนนเฉลี่ยเท่ากับ 4.17  ซึ่งอยู่ในเกณฑ์คุณภาพในระดับดี    
      ผู้เชี่ยวชาญให้ข้อเสนอแนะเกี่ยวกับการเพ่ิมสีสัน และภาพประกอบ   
ที่มีความสอดคล้องกับเนื้อหา    
    1.15 ผู้วิจัยปรับปรุงแก้ไขโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org ตามข้อเสนอแนะของผู้เชี่ยวชาญทั้ง 3 ด้าน    
    1.16 น าไปใช้โดยน าโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org ที่ผ่านการตรวจสอบแก้ไขจากผู้เชี่ยวชาญแล้ว ท าการส่งข้อมูลขึ้นสู่เครื่องแม่ข่าย 
(Up Load to Server) แล้วไปทดลองใช้ (Try out) ในการเรียนการสอนเพ่ือประเมินหา ประสิทธิภาพ
ของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org กับนิสิตที่ไม่เคยเรียนวิชานี้ 
มาก่อน ในภาคเรียนที่ 3 ปีการศึกษา 2556 โดยมีล าดับขั้นตอน ดังนี้  
     1.16.1 การทดลองแบบหนึ่งต่อหนึ่ง (One to One Testing 1 : 1)  
โดยน าโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org ไปทดลองกับนิสิตชั้นปีที่ 1  
ที่ไม่เคยเรียนวิชานี้มาก่อน จ านวน 3 คน (ระดับเก่ง 1 คน หมายถึงนิสิตที่มีค่า คะแนนเฉลี่ยในภาคเรียน
ที่แล้วตั้งแต่ 3.00 ขั้นไป ระดับปานกลาง 1 คน หมายถึงนิสิตที่มีค่าคะแนนเฉลี่ยในภาคเรียนที่แล้วตั้งแต่ 
2.00-2.99 ระดับอ่อน 1 คน หมายถึงนิสิตที่มีค่าคะแนนเฉลี่ยในภาคเรียนที่แล้วตั้งแต่ 1.00-1.99)  
โดยทดลองคราวละ 1 คนผลจากการทดลองพบว่า การเชื่อมโยงของหน้าบทเรียน ยังมีการติดขัดอยู่บ้าง 
ผู้วิจัยน าข้อบกพร่องที่ค้นพบไปปรับปรุงแก้ไข และน าไปให้ผู้เชี่ยวชาญด้านสื่อและโปรแกรมตรวจสอบ
อีกครั้งก่อนน าไปทดลองในข้ันต่อไป   
     1.16.2 การทดลองแบบกลุ่มเล็ก (Small Group Testing) โดยน าโปรแกรม 
บทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org ไปทดลองกับนิสิตชั้นปีที่ 1 ที่ไม่ใช่กลุ่ม
ตัวอย่าง ภาคเรียนที่ 3 ปีการศึกษา 2556 จ านวน 27 คน ผลการทดลองพบว่า การแสดงผล  
หน้าบราวเซอร์  ไม่ตรงในบางหน้า ผู้วิจัยจึงได้ท าการแก้ไข และน าไปให้ผู้เชี่ยวชาญด้านสื่อและ
โปรแกรมตรวจสอบ   อีกครั้งก่อนน าไปกับกลุ่มตัวอย่างต่อไป    
    1.17 ผู้วิจัยน าข้อบกพร่องที่ค้นพบมาปรับปรุงแก้ไข แล้วน าไปเสนอประธานและ 
คณะกรรมการควบคุมวิทยานิพนธ์ตรวจสอบอีกครั้ง ก่อนน าไปใช้จริงกับกลุ่มตัวอย่าง ได้แก่    
นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและการสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัย
มหาสารคาม ภาคเรียนที่ 3 ปีการศึกษา 2556 จ านวน 30 คน   
  2. การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน    
   ผู้วิจัยได้สร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ซอฟต์แวร์  
openoffice.org  จ านวน 1 ฉบับ เป็นข้อสอบแบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จ านวน 30 ข้อ 
โดยได้ด าเนินการสร้างตามข้ันตอน ดังนี้        

2.1 ศึกษารายละเอียดเนื้อหา เรื่อง การใช้ซอฟต์แวร์ openoffice.org   
ซึ่งมีเนื้อหาทั้งหมด 5 หน่วยการเรียน ได้แก่  
     หน่วยที่ 1 เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0   
      หน่วยที่ 2 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer   
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      หน่วยที่ 3 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Impress   
      หน่วยที่ 4 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc   
      หน่วยที่ 5 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base 
    2.2 ก าหนดจุดประสงค์เชิงพฤติกรรม และสร้างตารางวิเคราะห์ข้อสอบ 
โดยยึดตามจุดประสงค์เชิงพฤติกรรมเพื่อก าหนดข้อสอบ และก าหนดขั้นตอนในการวัดผล 
    2.3 สร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนตามที่ก าหนดไว้ใน 
ตารางวิเคราะห์ข้อสอบ โดยสร้างเป็นแบบปรนัย 4 ตัวเลือก จ านวน 42 ข้อ ซึ่งจะใช้จริง 
จ านวน 30 ข้อ  ดังตาราง 5 
 

ตาราง 5 วิเคราะห์ข้อสอบผลสัมฤทธิ์ทางการเรียน 
 

หน่วยการเรื่องรู้ จุดประสงค์เชิงพฤติกรรม 
จ านวนข้อสอบ 
สร้าง ต้องการ 

1. แนะน าและ 
    การติดตั้ง  
    OpenOffice. 
    org 2.0   

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับประวัติความ 
   เป็นมาของ OpenOffice 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถติดตั้ง   
   โปรแกรม OpenOffice ได ้
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถตั้งค่าเมนู  
   ภาษาไทย OpenOffice ได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถยกเลิกการ 
   ติดตั้ง OpenOffice ได ้

8 6 

2. การใช้งาน  
   โปรแกรม  
   OpenOffice. 
   org Writer   

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับหน้าจอ 
   โปรแกรม Writer 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถการสร้าง  
   เอกสารใหม่ได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถเปิดเอกสาร 
   เดิมได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถสั่งพิมพ์และ 
   ส่งออกเป็น PDF ได ้
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถจัดรูปแบบ 
   ตัวหนังสือได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถจัดรูปแบบ 
   ย่อหน้าได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถใช้แถบไม้ 
   บรรทัดและการตั้งระยะก้ันได้ 

8 6 
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ตาราง 5 (ต่อ) 
 

หน่วยการเรื่องรู้ จุดประสงค์เชิงพฤติกรรม 
จ านวนข้อสอบ 
สร้าง ต้องการ 

 8. ผู้เรียนมีความรู้ความเข้าใจและสามารถตรวจค่าผิด 
   ได ้
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถค้นหาและ 
   แทนที่ได้ 
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถตั้งค่า 
   หน้ากระดาษได้ 

  

3. การใช้งาน 
   โปรแกรม  
   OpenOffice. 
   org Impress   

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับหน้าจอ 
   โปรแกรม Impress 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้าง 
   เอกสารเปล่าได้ 
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างการ 
   น าเสนอด้วยแม่แบบได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถตั้งค่า 
   ตัวเลือกและน าเสนองานได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถพิมพ์และ 
   ส่งออกข้อมูลได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถเปลี่ยนพื้น 
   หลังได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถจัดรูปแบบ 
   กล่องข้อความได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้าง 
   แผนภูมิได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถแทรก 
   รูปภาพได้ 
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถ 
   ก าหนดการเปลี่ยนภาพนิ่งได้ 

9 6 
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ตาราง 5 (ต่อ) 
 

หน่วยการเรื่องรู้ จุดประสงค์เชิงพฤติกรรม 
จ านวนข้อสอบ 
สร้าง ต้องการ 

4. การใช้งาน 
   โปรแกรม  
   OpenOffice. 
   org Calc   

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับหน้าจอ  
   โปรแกรม 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถจัดการกับ 
   แฟ้มได้ 
3. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับชนิดของข้อมูล 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถพิมพ์ 
   เอกสารได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถเลือกช่วง 
   เซลล์ได้ 
6. ผู้เรียนมีความรู้ความเข้าใจและสามารถกรอกข้อมูล  
   อัตโนมัติ AutoFill ได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถย้ายและ 
   คัดลอกข้อมูลได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถรวมผลและ 
   จัดรูปแบบอัตโนมัติได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถใช้แผ่นงาน 
10. ผู้เรียนมีความรู้ความเข้าใจและสามารถป้องกัน 
   ข้อมูลได้ 
11. ผู้เรียนมีความรู้ความเข้าใจและสามารถจัดรูปแบบ 
   ข้อมูลได้ 
12. ผู้เรียนมีความรู้ความเข้าใจและสามารถบันทึก 
   หมายเหตุและวางแบบพิเศษได้ 
13. ผู้เรียนมีความรู้ความเข้าใจและสามารถตรึงแนว 
   และการแยกแผ่นงานได้ 
14. ผู้เรียนมีความรู้ความเข้าใจและสามารถใช้สูตรได้ 
15. ผู้เรียนมีความรู้ความเข้าใจและสามารถใช้ฟังก์ชั่น 
   ได้ 
 

9 6 
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ตาราง 5 (ต่อ) 
 

หน่วยการเรื่องรู้ จุดประสงค์เชิงพฤติกรรม 
จ านวนข้อสอบ 
สร้าง ต้องการ 

5. การใช้งาน 
   โปรแกรม  
   OpenOffice. 
   org Base   

1. ผู้เรียนมีความรู้ความเข้าใจเก่ียวกับหน้าจอ     
   โปรแกรม Base 
2. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างตาราง   
   โดยใช้ตัวช่วงสร้างได ้
3. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างตาราง 
   ในมุมมองการออกแบบได้ 
4. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างตาราง 
   เชื่อมโยงกับข้อมูลภายนอกได้ 
5. ผู้เรียนมีความรู้ความเข้าใจและสามารถเรียงล าดับ 
   และการกรอกข้อมูลตารางได้ 
6. ผู้เรียนมีความรู้ความเขา้ใจและสามารถสร้างข้อ 
   ค าถามโดยใช้ตัวช่วยสร้างได้ 
7. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างข้อ 
   ค าถามโดยใช้มุมมองออกแบบได้ 
8. ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้างฟอร์ม 
   ได้ 
9. ผู้เรียนมีความรู้ความเข้าใจและสามารถแก้ไขฟอร์ม 
   ได ้
10.ผู้เรียนมีความรู้ความเข้าใจและสามารถสร้าง 
   รายงานได ้

8 6 

รวม 42 30 
 
    2.4 น าแบบทดสอบที่สร้างขึ้นเสนอต่อประธานและคณะกรรมการควบคุม 
วิทยานิพนธ์น าข้อคิดเห็นไปปรับปรุง แล้วเสนอให้ผู้เชี่ยวชาญตรวจสอบความถูกต้องของเนื้อหา และ 
ความสอดคล้องระหว่างข้อสอบกับผลการเรียนรู้ที่คาดหวัง และจุดประสงค์การเรียนรู้ หรือค่า IOC 
(Index of Item Objective Congruence) โดยวิเคราะห์ข้อมูลหาค่าดัชนีความสอดคล้องระหว่าง 
ข้อสอบกับผลการเรียนรู้ที่คาดหวัง และเลือกข้อสอบที่มีค่า IOC ตั้งแต ่0.50 ขึ้นไป ผู้เชี่ยวชาญได้ 
ให้ข้อเสนอแนะพบว่า ข้อค าถามของแบบทดสอบควรให้ครอบคลุมในเรื่องความรู้ ความเข้าใจ 
และการน าไปใช้การวิเคราะห์มากกว่าถามแบบความจ า 
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     ผู้เชี่ยวชาญประเมินความเที่ยงตรงเชิงเนื้อหาของข้อสอบ โดยวิธีใช้สูตร IOC 
(สมนึก ภัททิยธนี.    2552  :  104) ซึ่งมีเกณฑ์การประเมินดังนี้ 
      ให้คะแนน +1 เมื่อ แน่ใจว่าข้อสอบนั้น ๆ วัดได้ตรงจุดประสงค์  
      ให้คะแนน 0   เมื่อ ไม่แน่ใจ  
      ให้คะแนน -1  เมื่อ แน่ใจว่าข้อสอบนั้นไม่วัดตรงตามจุดประสงค์ 
     ผลการพิจารณาของผู้เชี่ยวชาญพบว่าข้อสอบที่มีค่า IOC โดยใช้เกณฑ์   
คัดเลือกไว้ใช้ตั้งแต่ 0.50 - 1.00 ปรากฏว่าได้ข้อสอบ จ านวน 30 ข้อ   
    2.5 น าข้อสอบที่ได้รับการพิจารณาจากผู้เชี่ยวชาญแล้ว พิมพ์เป็นแบบทดสอบ   
จ านวน 30 ข้อ แล้วน าไปทดลองสอบ (Try-out) กับนิสิตชั้นปีที่ 1 ที่ไม่ใช่กลุ่มตัวอย่าง จ านวน 30 คน 
เพ่ือน าผลการทดสอบมาหาคุณภาพ ของข้อสอบ   
    2.6 น ากระดาษค าตอบที่นักเรียนสอบเสร็จแล้วมาตรวจให้คะแนนโดยตอบถูก   
ให้ 1 คะแนน ตอบผิด หรือ ไม่ตอบ หรือ ตอบมากกว่า 1 ข้อ ให้ 0 คะแนน น าผลการตรวจข้อสอบมา
วิเคราะห์ข้อสอบเป็นรายข้อ โดยวิธีของแบรนแนน (Brennan) เพ่ือหาค่าความยากง่าย (P) และ 
ค่าอ านาจจ าแนก (B) (บุญชม  ศรีสะอาด และคณะ.    2552  :  91) คัดเลือกข้อสอบที่มีค่าความยาก
ง่าย (P) ระหว่าง 0.20-0.80 และค่าอ านาจจ าแนก (B) ระหว่าง 0.20-1.00 พบว่า ได้ข้อสอบที่ผ่าน
เกณฑ ์จ านวน 30 ข้อ มีค่าความยากง่ายตั้งแต่ 0.40 ถึง 0.70 และมีค่าอ านาจจ าแนกรายข้อตั้งแต่ 0.13 
ถึง 0.80    
    2.7 น าข้อสอบที่คัดเลือกไว้ทั้ง 30 ข้อ มาหาค่าความเชื่อม่ันของแบบทดสอบ   
ทั้งฉบับโดยใช้วิธีของโลเวท (Lovett) (บุญชม ศรีสะอาด และคณะ.    2552  :  97)  ได้ค่าความเชื่อม่ัน 
ทั้ง ฉบับเท่ากับ 0.868    
    2.8 น าข้อสอบที่ผ่านการหาคุณภาพ และความเชื่อม่ันแล้ว จ านวน 30 ข้อ   
น าไปจัดพิมพ์ไว้ในโปรแกรมบทเรียนออนไลน์ ใช้เป็นแบบทดสอบก่อนเรียนและหลังเรียนเพื่อใช้   
ในการทดลองและหาประสิทธิภาพของบทเรียนต่อไป   
   3. สร้างแบบสอบถามความพึงพอใจของผู้เรียนที่มีต่อโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org ผู้ศึกษาค้นคว้าได้สร้างแบบสอบถามความพึงพอใจ  
(สมบัติ ท้ายเรือค า.    2551  :  101)  
    3.1 ศึกษาข้อความที่แสดงถึงความพึงพอใจและสร้างแบบสอบถามความพึงพอใจ  
จ านวน 15 ข้อ    
    3.2 น าแบบสอบถามความพึงใจที่สร้างเสร็จแล้วไปเสนอต่อประธานกรรมการ
ควบคุม วิทยานิพนธ์ ตรวจสอบความชัดเจนทางภาษาและความถูกต้องตามเนื้อหาและแก้ไข 
ตามเสนอแนะ    
    3.3 สร้างแบบสอบถามความพึงพอใจในการเรียนด้วยโปรแกรมบทเรียนออนไลน์ 
เรื่อง การใช้ซอฟต์แวร์ openoffice.org ชนิดมาตราส่วนประมาณค่า (Rating Scale) จ าแนกระดับ
ความพึงพอใจเป็น 5 ระดับ จ านวน 15 ข้อ 
    3.4 น าแบบวัดความพึงพอใจที่ผ่านการตรวจสอบจากประธานกรรมการควบคุม  
วิทยานิพนธ์ เสนอผู้เชี่ยวชาญด้านการวัดผลและประเมินผลเพื่อพิจารณาตรวจสอบความเที่ยงตรง   
เชิงเนื้อหา (Validity)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Mahasarakham University 



59 

     3.4.1 ผศ.ดร.ทรงศักดิ์ ภูสีอ่อน  สาขาวิชาวิจัยและพัฒนาการศึกษา  
คณะศึกษาศาสตร์  มหาวิทยาลัยมหาสารคาม 
     3.4.2 อ.ดร.ธัชชัย จิตรนันท์  สาขาวิชาการบริหารการศึกษา คณะศึกษาศาสตร์   
มหาวิทยาลัยมหาสารคาม 
     3.4.3 อ.ดร. คชากฤษ เหลี่ยมไธสง  สาขาวิชาสื่อนฤนิต คณะวิทยาการ
สารสนเทศ  มหาวิทยาลัยมหาสารคาม   
      จากการตรวจสอบของผู้เชี่ยวชาญ ค่าดัชนีความสอดคล้องอยู่ระหว่าง 0.67 
- 1.00 ค่าเฉลี่ยเท่ากับ 0.87 และค่าความเชื่อมั่นเท่ากับ 0.787    
    3.5 พิมพ์แบบวัดความพึงพอใจในการเรียนด้วยโปรแกรมบทเรียนออนไลน์ 
เรื่อง การใช้ซอฟต์แวร์ openoffice.org ฉบับจริง เพ่ือน าไปใช้ในการเก็บรวบรวมข้อมูลต่อไป 
(ภาคผนวก ฌ)  
 
วิธีด าเนินการทดลองและการเก็บรวบรวมข้อมูล 
 
 ผู้ศึกษาค้นคว้าด าเนินการทดลองโดยมีขั้นตอนดังนี้    
  1. ด าเนินการทดลองกลุ่มตัวอย่าง นิสิตชั้นปีที่ 1 สาขาเทคโนโลยีสารสนเทศและ 
การสื่อสาร คณะวิทยาการสารสนเทศ มหาวิทยาลัยมหาสารคาม ปีการศึกษา 3/2556 จ านวน 30 คน 
ดังนี้  
   1.1 ท าการทดลองตามเวลาที่ก าหนด วันที่ 21 – 22 พฤษภาคม 2557  
วันละ 8 ชั่วโมง รวมเวลา 16 ชั่วโมง จากที่ได้ก าหนดวันและเวลาดังกล่าว เนื่องจาก  
    1.1.1 ผู้ศึกษาค้นคว้าได้ใช้การฝึกอบรมโปรแกรมเรียนออนไลน์เป็นกระบวนการ
เรียนการสอน 
    1.1.2 ผู้ศึกษาค้นคว้าต้องก าหนดเป้าหมายให้ชัดเจนไม่ว่าจะเป็นวันและเวลา 
ที่จะต้องก าหนดให้สอดคล้องกับบทเรียนที่ผู้ศึกษาค้นคว้าได้ พัฒนาขึ้น  
    1.1.3 ผู้ศึกษาค้นคว้าไม่สามารถควบคุมกลุ่มตัวอย่างได้เองเนื่องจากผู้ศึกษาค้นคว้า
ไม่ได้เป็นอาจารย์ผู้สอนหรือพนังงานในหน่วยงานมหาวิทาลัย จ าต้องอาศัยขอความร่วมมือกับอาจารย์
ผู้สอน เพ่ือที่จะให้นิสิตได้เข้าไปเรียนในบทเรียนออนไลน์ที่ผู้ศึกษาค้นคว้าได้พัฒนาขึ้น 
   1.2 ชี้แจงรายละเอียดลักษณะรูปแบบการเรียนโดยใช้โปรแกรมบทเรียน 
ออนไลน์ เช่น วิธีการศึกษา การเข้าสู่บทเรียน และข้อตกลงอ่ืน ๆ  ทีน่ิสิตควรทราบ 
   1.3 การทดลองเริ่มต้นโดยให้กลุ่มตัวอย่างท าแบบทดสอบก่อนเรียน (Pre-test)  
โดยให้นิสิตท าในโปรแกรมบทเรียนหลังจากนั้นให้นิสิตศึกษาเนื้อหาตามกระบวนการของโปรแกรม
บทเรียนออนไลน์  
   1.4 เมื่อนิสิตศึกษาเนื้อหาตามกระบวนการของโปรแกรมบทเรียนออนไลน์ครบ 
ทุกตอนตามก าหนดให้ท าแบบวัดผลสัมฤทธิ์ทางการเรียน (Post-test) โดยกระท าทันทีเมื่อสิ้นสุด 
การเรียน โดยใช้แบบวัดผลสัมฤทธิ์ทางการเรียนชุดเดียวกันกับการสอบก่อนเรียนโดยท าในโปรแกรม
บทเรียน (เพ่ือสะดวกต่อการด าเนินการทดสอบและควบคุม) 
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   1.5 การให้คะแนน ตรวจจากแบบวัดผลสัมฤทธิ์ทางการเรียนที่ให้นิสิต 
ท าถ้าตอบถูกให้ 1 คะแนน ตอบผิดหรือไม่ตอบ ให้ 0 คะแนน 
   1.6 ในครั้งสุดท้ายของการเรียนให้กลุ่มตัวอย่าง ท าแบบวัดความพึงพอใจของ 
ผู้เรียนต่อโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org   
   1.7 รวบรวมและน าข้อมูลที่ได้จากการทดลองมาวิเคราะห์โดยวิธีทางสถิติต่อไป 
 
การจัดกระท าและการวิเคราะห์ข้อมูล 
 

 ผู้วิจัยท าการวิเคราะห์ข้อมูลโดยใช้โปรแกรมคอมพิวเตอร์ส าเร็จรูป โดยด าเนินการดังนี้  
  1. วิเคราะห์การประเมินคุณภาพของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org โดยใช้ค่าเฉลี่ย และส่วนเบี่ยงเบนมาตรฐาน    
  2. วิเคราะห์หาประสิทธิภาพของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org โดยใช้    
   2.1 หาค่าสถิติพ้ืนฐาน ได้แก่ ร้อยละ ค่าเฉลี่ย และส่วนเบี่ยงเบนมาตรฐานของคะแนน 
จากการท าแบบทดสอบในบทเรียนและคะแนนผลสัมฤทธิ์หลังการเรียน 
   2.2 หาประสิทธิภาพของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org ตามเกณฑ์ 80/80 โดยใช้สูตร E1/E2 (เผชิญ กิจระการ.    2554  :  159 - 161) 
   2.3 หาค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org  (The Effectiveness Index : E.I.) (เผชิญ กิจระการ.    2554  :  159 - 161) 
  3. การหาคุณภาพของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน    
   3.1 หาค่าดัชนีความสอดคล้องระหว่างข้อสอบกับจุดประสงค์ โดยใช้สูตร IOC  
สมนึก ภัททิยธนี  (2552  :  104) พิจารณาคัดเลือกข้อสอบที่มีคะแนนเฉลี่ยตั้งแต่ 0.5 ถึง 1.00  
   3.2 หาค่าความยาก (Difficulty : P) ระหว่าง 0.20-0.80 และค่าอ านาจจ าแนก 
(Discrimination : r) ตั้งแต่ 0.20 ถึง 1.00 โดยใช้วิธีวิเคราะห์แบบอิงเกณฑ์ ใช้วิธีของเบรนแนน 
(Brennan) (สมนึก ภัททิยธนี.    2552  :  86-88) 
   3.3 หาค่าความเชื่อมั่นของแบบทดสอบ โดยใช้วิธีความเชื่อมั่น ใช้วิธีของโลเวทท์   
(Lovett) (สมนึก ภัททิยธนี.    2552  :  97) 
  4. วิเคราะห์ความพึงพอใจ และการมีปฏิสัมพันธ์ต่อการเรียนด้วยโปรแกรมบทเรียน 
ออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org โดยท าการวิเคราะห์ข้อมูลโดยการหาค่าเฉลี่ยและ   
ค่าส่วนเบี่ยงเบนมาตรฐานเป็นรายข้อและโดยรวมทุกข้อ โดยก าหนดเกณฑ์ในการแปลความหมาย 
   ของค่าเฉลี่ยความคิดเห็นดังนี้ ไชยยศ เรืองสุวรรณ  (2552  :  139)   

  ค่าเฉลี่ย            ระดับความคิดเห็น    
   4.51 – 5.00   มากที่สุด    
   3.51 – 4.50   มาก    
   2.51 – 3.50   ปานกลาง    
   1.51 – 2.50   น้อย    
   1.00 – 1.50   น้อยที่สุด   
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สถิติที่ใช้ในการวิเคราะห์ข้อมูล 
  
 สถิติที่ใช้ในการวิจัยครั้งนี้ มีดังนี้ 
  1. สถิติพ้ืนฐาน       
   1.1 หาร้อยละ (Percentage) โดยใช้สูตรการค านวณดังนี้ (สมบัติ ท้ายเรือค า.    2551 
:  119)        
 

𝑝 =
𝑓

𝑛
𝑥100 

      
    เมื่อ  P  แทน ร้อยละ   
      f   แทน ความถี่ท่ีต้องการแปลงเป็นร้อยละ   
      n  แทน จ านวนความถี่ทั้งหมด   
 
   1.2 ค่าเฉลี่ย (× ) โดยใช้สูตรต่อไปนี้ (บุญชม  ศรีสะอาด และคณะ.    2553  :  29) 
 

× =
 X

N
 

 
    เมื่อ  ×    แทน ค่าเฉลี่ย 

 X แทน ผลรวมของคะแนนทุกตัว 
N   แทน จ านวนคะแนนทั้งหมด 
 

   1.3 ส่วนเบี่ยงเบนมาตรฐาน (S.D.) โดยใช้สูตรดังนี้ (บุญชม  ศรีสะอาด และคณะ. 
2553  :  46) 
 

s =  
N X2 −   X 2

N N − 1 
 

   
    เมื่อ  S  แทน ค่าส่วนเบี่ยงเบนมาตรฐาน    
      X  แทน คะแนนแต่ละตัว    
      N   แทน จ านวนคะแนนทั้งหมด    
         แทน ผลรวม    
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  2. สถิติที่ใช้หาคุณภาพของเครื่องมือที่ใช้ในการทดลอง    
   2.1 สูตรที่ใช้ในการค านวณประสิทธิภาพของโปรแกรมบทเรียนออนไลน์ ตามเกณฑ์  
80/80 โดยใช้วิธีการหาประสิทธิภาพ E1/E2 ในการค านวณ ดังนี้ (เผชิญ กิจระการ.    2554  :  159 - 
161)   

E1

 Χ
N
A

Χ 100 

 

    เมื่อ E1   แทน ประสิทธิภาพของกระบวนการ    
       ×  แทน คะแนนรวมที่ผู้เรียนท าแบบฝึกหัดได้ในระหว่างเรียน 
      A   แทน คะแนนเต็มของแบบฝึกหัดทุกชุดรวมกัน    
      N   แทน จ านวนนักเรียนทั้งหมด   

  

E2

 γ
N
B

Χ 100 

 
    เมื่อ E2   แทน ประสิทธิภาพของกระบวนการ    
       γ  แทน คะแนนรวมที่ผู้เรียนท าแบบฝึกหัดได้ในระหว่างเรียน  
      B   แทน คะแนนเต็มของแบบฝึกหัดทุกชุดรวมกัน    
      N   แทน จ านวนนักเรียนทั้งหมด 

 
   2.2  การหาค่าดัชนีประสิทธิผลของ โปรแกรมบทเรียนออนไลน์  โดยใช้สูตรดังนี้ 

  
 
 
 
    เมื่อ  E.I.  แทน ดัชนีประสิทธิผล 
 
   2.3  แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
    2.3.1 หาค่าดัชนีความสอดคล้องระหว่างข้อสอบกับผลการเรียนรู้ที่คาดหวัง 
โดยหาค่าเฉลี่ยการประเมินของผู้เชี่ยวชาญทั้งหมด โดยใช้สูตรดัชนีความสอดคล้อง IOC 
(สมนึก ภัททิยธนี.    2552  :  104)  พิจารณาข้อสอบที่มีคะแนนเฉลี่ยตั้งแต่ 0.50-1.00 ใช้สูตรดังนี้ 
 

IOC =  
 R

N
 

 

 

ผลรวมของคะแนนแบบทดสอบหลังเรียน – ผลรวมของคะแนนแบบทดสอบก่อนเรียน 

(จ านวนนิสิต x คะแนนเต็ม) – ผลรวมของคะแนนแบบทดสอบก่อนเรียน 

 

E.I. =  
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    เมื่อ  IOC   แทน  ดัชนีความสอดคล้องระหว่างผลการเรียนรู้ที่คาดหวังกับ 
              ข้อสอบ 
       R   แทน  ผลรวมคะแนนความคิดเห็นของผู้เชี่ยวชาญ 
      N    แทน  จ านวนผู้เชี่ยวชาญ 

 
    2.3.2 สูตรหาค่าความยาก (Difficulty : P) และอ านาจจ าแนก (Discrimination : 
r) ดังนี้ สูตรค่าความยาก (สมนึก ภัททิยธนี.    2552  :  86-88) 
 

P =
R

N
 

 

    เมื่อ  P   แทน   ระดับความยาก 
      R   แทน   จ านวนผู้ตอบถูกทั้งหมด 
      N   แทน   จ านวนคนในกลุ่มสูงและกลุ่มต่ า 
 
    สูตรการหาค่าอ านาจจ าแนก  
   

B =
U

N1
−

L

N2
 

 
    เมื่อ  B   แทน  ค่าอ านาจจ าแนก  
      N1  แทน  จ านวนนักเรียนที่สอบผ่านเกณฑ์  
      N2  แทน  จ านวนนักเรียนที่สอบไม่ผ่านเกณฑ์  
      U   แทน  จ านวนนักเรียนที่สอบผ่านเกณฑ์ตอบถูก  
      L   แทน  จ านวนนักเรียนที่สอบไม่ผ่านเกณฑ์ตอบถูก 

 
    2.3.3 ค่าความเชื่อม่ัน (Reliability) ของแบบทดสอบโดยวิธีของโลเวท (Lovett  
Method) (สมนึก ภัททิยธนี.    2552  :  97) 
 

r∝ = 1 −
K Xi −  Xi

2

 K − 1   Xi − C 2
 

 
    เมื่อ  r∝   แทน   ค่าความเชื่อม่ันของแบบทดสอบ  
      K      แทน   จ านวนข้อสอบ  
      Xi     แทน   คะแนนสอบของนักเรียนแต่ละคน  
      C      แทน   คะแนนจุดตัด  
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   2.4 แบบวัดความพึงพอใจ  
    2.4.1 การวิเคราะห์ความพึงพอใจของนักเรียนที่มีต่อโปรแกรมบทเรียนออนไลน์  
โดยหาค่าเฉลี่ย (×  ) และส่วนเบี่ยงเบนมาตรฐาน (S.D.)    
    2.4.2 หาค่าความเที่ยงตรงของความสอดคล้องระหว่างข้อค าถามกับพฤติกรรม   
ชี้วัดความพึงพอใจ IOC (สมบัติ  ท้ายเรือค า.    2551  :  101) พิจารณาข้อสอบที่มีคะแนนเฉลี่ยตั้งแต่   
0.50-1.00 ใช้สูตรดังนี้    
 

IOC =  
 R

N
 

 
    เมื่อ  IOC   แทน  ดัชนีความสอดคล้องระหว่างข้อค าถามกับพฤติกรรมชี้วัด 

           ความพอใจ 
       R   แทน  ผลรวมของคะแนนความคิดเห็นของผู้เชี่ยวชาญทั้งหมด 
      N    แทน  จ านวนผู้เชี่ยวชาญ 
  
    2.4.3 หาค่าความเชื่อมั่นของแบบวัดความพึงพอใจโดยใช้วิธีของครอนบาค 
(Cronbach) หรือสัมประสิทธิ์ของแอลฟาและค านวณจากสูตรดังนี้ (บุญชม ศรีสะอาด และคณะ.    
2552  :  101)  

α =
n

n − 1
 1 −

 Si
2

St
2   

 
    เมื่อ  α   แทน   ค่าความเชื่อม่ัน    
      n    แทน  จ านวนข้อ    
      Si

2  แทน  ความแปรปรวนแต่ละข้อ    
      St

2  แทน  ความแปรปรวนของคะแนนรวม  
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บทที่ 4 
 

ผลการวิเคราะห์ข้อมูล 
 
 การวิเคราะห์ข้อมูล  ผู้ศึกษาค้นคว้าได้เสนอผลการวิเคราะห์ข้อมูลดังนี้  
  1. สัญลักษณ์ท่ีใช้ในการเสนอผลการวิเคราะห์ข้อมูล 
  2. ล าดับขั้นในการเสนอผลการวิเคราะห์ข้อมูล 
  3. ผลการวิเคราะห์ข้อมูล 
 
สัญลักษณ์ที่ใช้ในการเสนอผลการวิเคราะห์ข้อมูล 
 
 ผู้ศึกษาค้นคว้าได้ก าหนดความหมายของสัญลักษณ์ท่ีใช้ในการน าเสนอผลการวิเคราะห์  
เพ่ือให้เกิดความเข้าใจในการแปลความหมาย และเสนอผลการวิเคราะห์ข้อมูลให้ถูกต้อง  ตลอดจน 
การสื่อความหมายของข้อมูลที่ตรงกัน  ดังนี้  
  ×   =  คะแนนเฉลี่ย 
  N  =  จ านวนนิสิต 
  S.D =  ส่วนเบี่ยงเบนมาตรฐาน 
  E1  =  ประสิทธิภาพของโปรแกรมบทเรียนจากการท าแบบทดสอบระหว่างเรียน 
  E2  =  ประสิทธิภาพของโปรแกรมบทเรียนจากการท าแบบทดสอบหลังเรียน 
  E.I.  =  ดัชนีประสิทธิผล 
 
ล าดับขั้นในการเสนอผลการวิเคราะห์ข้อมูล 
 
 การวิเคราะห์ข้อมูล  ผู้ศึกษาค้นคว้าได้ด าเนินการตามล าดับขั้นตอน  ดังนี้  
  ตอนที่ 1 วิเคราะห์หาประสิทธิภาพของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org นิสิตชั้นปีที่ 1 ตามเกณฑ์ 80/80  
  ตอนที่  2 วิเคราะห์ค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ 
ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
  ตอนที่ 3 วิเคราะหค์วามพึงพอใจของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
 
ผลการวิเคราะห์ข้อมูล 
 
 ตอนที่ 1 วิเคราะห์หาประสิทธิภาพของโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org นิสิตชั้นปีที่ 1  ตามเกณฑ์ 80/80 
  ผู้ศึกษาค้นคว้าได้ท าการทดลองกับกลุ่มตัวอย่างจ านวน 30 คน  โดยทดสอบก่อนเรียน
และให้นิสิตศึกษาตามโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
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นิสิตชั้นปีที่ 1 จากเว็บไซต์ http://www.thanakorn-openoffice.com/  ที่ผู้ศึกษาค้นคว้าได้จัดสร้าง
ขึ้นและให้นิสิตท าแบบทดสอบย่อยท้ายบทเรียนแต่ละตอน  แล้วท าการตรวจให้คะแนนเพื่อหาค่าร้อยละ  
ค่าเฉลี่ย  และส่วนเบี่ยงเบนมาตรฐาน  และเม่ือนิสิตได้เรียนจากโปรแกรมบทเรียนออนไลน์ 
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  ครบทั้ง 5 ตอนแล้วจึงได้ท าการทดสอบวัดผลสัมฤทธิ์ทางการ
เรียนหลังเรียน ได้ผลดังแสดงใน ตาราง 6  
 
ตาราง  6  ค่าเฉลี่ยของคะแนนแบบทดสอบย่อยหลังเรียนแต่ละหน่วย (E1) และคะแนนแบบทดสอบ 
  วัดผลสัมฤทธิ์หลังเรียนด้วยโปรแกรมบทเรียนออนไลน์ (E2) เรื่อง การใช้ซอฟต์แวร์  
       openoffice.org นิสิตชั้นปีที่ 1 

 

คนที ่
คะแนนทดสอบ
ก่อนเรียน (30) 

คะแนนทดสอบย่อยระหว่างเรียน คะแนนทดสอบ
หลังเรียน (30) P1(10) P2(10) P3(10) P4(10) P5(10) 

1 19 8 7 10 7 9 21 
2 20 7 8 10 8 9 22 
3 18 10 10 10 9 8 23 
4 29 8 10 10 8 9 29 
5 14 9 8 8 9 8 24 
6 21 9 8 9 8 9 25 
7 11 8 8 8 9 9 21 
8 16 7 8 9 8 9 23 
9 17 7 8 9 8 10 27 
10 20 7 9 8 8 9 24 
11 6 7 7 9 9 7 26 
12 13 8 8 8 8 9 23 
13 9 8 7 8 9 9 29 
14 21 8 9 10 8 8 24 
15 26 7 7 10 8 10 29 
16 24 8 8 10 8 9 26 
17 25 8 9 8 9 8 29 
18 17 8 7 9 8 8 27 
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ตาราง 6 (ต่อ) 
 
คนที่ คะแนน

ทดสอบก่อน
เรียน (30) 

คะแนนทดสอบย่อยระหว่างเรียน คะแนน
ทดสอบหลัง
เรียน (30) P1(10) P2(10) P3(10) P4(10) P5(10) 

19 15 9 8 7 8 10 25 
20 20 9 9 8 8 8 26 
21 19 8 9 9 8 8 22 
22 13 8 7 10 9 8 23 
23 19 9 8 10 9 9 21 
24 18 7 8 8 8 8 23 
25 14 8 7 9 8 9 24 
26 12 8 8 9 9 9 22 
27 10 8 9 9 8 9 20 
28 13 8 8 8 8 8 23 
29 15 8 8 10 10 8 21 
30 9 9 7 8 9 9 29 
รวม 503 1262 731 

 16.77 42.07 24.37 
S.D. 5.39 3.87 2.77 

ร้อยละ 55.89 84.14 81.22 
 
  จากตาราง 6 พบว่าคะแนนเฉลี่ยของนิสิตจากการท าแบบทดสอบวัดผลสัมฤทธิ์ก่อนเรียน
เท่ากับ 16.77  คิดเป็นร้อยละ 55.89 คะแนนเฉลี่ยของนิสิตจากการท าแบบทดสอบย่อยทุกชุดรวมกัน
เท่ากับ 42.07 คิดเป็นร้อยละ 84.14 คะแนนเฉลี่ยของนิสิตจากการท าแบบทดสอบวัดผลสัมฤทธิ์หลัง
เรียนเท่ากับ 24.37  คิดเป็นร้อยละ 81.22 เมื่อน ามาวิเคราะห์หาประสิทธิภาพของโปรแกรมบทเรียน
ออนไลน์เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 มีค่าเท่ากับ 84.14/81.22 

 
ตาราง 7  ค่าประสิทธิภาพของโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
  นิสิต ชั้นปีที่ 1 ตามเกณฑ์  80/80 
 

คะแนน คะแนนเต็ม ×  ร้อยละ 
คะแนนเฉลี่ยจากการท าแบบทดสอบย่อยท้ายบทเรียน  E1 50 42.07 84.14 
คะแนนเฉลี่ยจากการท าแบบวัดผลสัมฤทธิ์ทางการเรียนหลังเรียน E2 30 24.37 81.22 

ประสิทธิภาพของโปรแกรมบทเรียนออนไลน์    84.14/81.22 
 

_ 
X 
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  จากตาราง 7 จากการท าแบบทดสอบย่อยท้ายบทเรียน โดยใช้บทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 ทั้ง 5 หน่วยการเรียน E1 มีค่าเฉลี่ย 42.07   
จากคะแนนเต็ม 50 คะแนน คิดเป็นร้อยละ 84.14 และ คะแนนจากการท าแบบวัดผลสัมฤทธิ์หลังเรียน 
E2   มีค่าเฉลี่ย 24.37 จากคะแนนเต็ม 30 คะแนน คิดเป็น ร้อยละ 81.22 ของคะแนนเต็ม   
ดังนั้นโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 มีประสิทธิภาพ
เท่ากับ  84.14/81.22  ซึ่งสูงกว่าเกณฑ์ท่ีตั้งไว้ 80/80 
 
 ตอนที่ 2 วิเคราะห์ค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ 
ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1  
  ผู้ศึกษาค้นคว้าได้วิเคราะห์ดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org โดยใช้สูตร E.I. ซึ่งวัดได้จากคะแนนก่อนเรียนและหลังเรียน
จากการท าแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน ดังตาราง 8 
 
ตาราง 8  ผลการวิเคราะห์ดัชนีประสิทธิผล (E.I.) ของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
  openoffice.org  นิสิตชั้นปีที่ 1  
 

จ านวนนิสิต คะแนนเต็ม คะแนนสอบ ค่าดัชนีประสิทธิผล 

30 30 
ทดสอบก่อนเรียน ทดสอบหลังเรียน 

0.574 
503 731 

 
  จากตาราง 8 ผลปรากฏว่า  ดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์   
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 มีค่าดัชนีประสิทธิผลเท่ากับ  0.574  ซึ่งแสดงว่า
นิสิตที่เรียนรู้ ด้วยโปรแกรมบทเรียนออนไลน์ มีความก้าวหน้าทางการเรียนรู้ คิดเป็นร้อยละ 57.40 
 
 ตอนที่ 3 วิเคราะหค์วามพึงพอใจของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 ที่พัฒนาขึ้น 
  ผลการวิเคราะห์ความพึงพอใจของนิสิตที่มีต่อการเรียน โปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org ผู้ศึกษาค้นคว้าได้วิเคราะห์ค่าความพอใจจากแบบวัด 
ความพอใจของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์ ทั้งหมด 15 ข้อ ดังตาราง 9 
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ตาราง 9  ค่าเฉลี่ยและส่วนเบี่ยงเบนมาตรฐาน ระดับความพึงพอใจของนิสิตที่มีต่อการเรียน 
  ด้วยโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
 

ข้อความ ×  S.D. 
ระดับความ
พึงพอใจ 

1. บทเรียนอธิบายรายละเอียดและวัตถุประสงค์ อย่างชัดเจน 
2. เนื้อหาและบทเรียนมีความน่าสนใจท าให้เข้าใจได้ง่าย 
3. เนื้อหาและบทเรียนมีความสอดคล้องกับวัตถุประสงค์ 
4. บทเรียนมีปริมาณของเนื้อหาที่เหมาะสมในแต่ละบทเรียน 
5. บทเรียนมีความง่ายเหมาะสมกับผู้เรียน 
6. รูปภาพและวิดีโอประกอบสามารถสื่อความหมายและมีความ   
    สอดคล้องกับเนื้อหา 
7. การล าดับขั้นตอนในการน าเสนอเนื้อหาของบทเรียนมีความ  
    เหมาะสม 
8. เสียงบรรยายและเนื้อหามีความเหมาะสม  ชัดเจน 
9. เวลาที่ใช้ในการเรียนบทเรียน มีความเหมาะสม 
10. มีการเชื่อมโยงไปยังบทเรียนอ่ืน ๆ ที่เกี่ยวข้อง และง่ายต่อ 
     การท าความเข้าใจ 
11. ผู้เรียนสามารถติดต่อกับผู้สอนทางกระดานสนทนาเมื่อ   
     ต้องการข้อมูลเพิ่มเติม 
12. บทเรียนท าให้ผู้เรียนเรียนสนุกสนานน่าตื่นเต้นไม่น่าเบื่อ 
13. ผู้เรียนสามารถเข้าถึงบทเรียนได้สะดวกและรวดเร็ว 
14. บทเรียนตรงกับความต้องการและความสนใจของผู้เรียน 
15. ความรู้จากการเรียนบทเรียนสามารถน าไปประยุกต์ใช้ให้เกิด 
     ประโยชน์ในชีวิตการท างาน 

4.52 
4.48 
4.67 
4.48 
4.27 

 
4.21 

 
4.15 
4.33 
4.39 

 
4.09 

 
4.12 
4.09 
4.06 
4.18 

 
4.33 

0.50 
0.50 
0.47 
0.66 
0.76 

 
0.69 

 
0.75 
0.81 
0.49 

 
0.72 

 
0.74 
0.80 
0.70 
0.68 

 
0.81 

มากที่สุด 
มาก 

มากที่สุด 
มาก 
มาก 

 
มาก 

 
มาก 
มาก 
มาก 

 
มาก 

 
มาก 
มาก 
มาก 
มาก 

 
มาก 

รวม 4.29    0.67 มาก 
 
  จากตาราง 9 ผลปรากฏว่านิสิตมีความพึงพอใจต่อโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 โดยรวมอยู่ในระดับมาก  (×  = 4.29)  และ 
(S.D. = 0.67) เมื่อพิจารณาเป็นรายข้อแล้วพบว่า มีความพึงพอใจอยู่ในระดับมากที่สุด 2 ข้อ และ 
อยู่ในระดับมาก 13 ข้อ ข้อที่มีค่าเฉลี่ยสูงสุดอันดับ 1 (×  = 4.67) คือ ข้อ 3. เนื้อหาและบทเรียน 
มีความสอดคล้องกับวัตถุประสงค์ ข้อที่มีค่าเฉลี่ยต่ าสุด (×  = 4.06)  คือ ข้อ 14. บทเรียนตรงกับ 
ความต้องการและความสนใจของผู้เรียน 
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บทที่ 5 
 

สรุปผล อภิปรายผล และข้อเสนอแนะ 
 
 การศึกษาค้นคว้าในครั้งนี้ เป็นการศึกษาเพ่ือพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้
ซอฟต์แวร์ openoffice.org ได้สรุปผลการศึกษาค้นคว้าและข้อเสนอแนะ ดังนี้ 
  1. ความมุ่งหมายของการศึกษาค้นคว้า 
  2. สรุปผล 
  3. อภิปรายผล 
  4. ปัญหาและอุปสรรคการศึกษาค้าคว้า 

  5. ข้อเสนอแนะ 
 
ความมุ่งหมายของการศึกษาค้นคว้า 
 
 1. เพ่ือพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
นิสิตชั้นปีที่ 1 ให้มีประสิทธิภาพตามเกณฑ์ 80/80 
 2. เพ่ือหาค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org นิสิตชั้นปีที่ 1 ทีผู่้ศึกษาค้นคว้าได้พัฒนาขึ้น 
  3. เพ่ือศึกษาความพึงพอใจของนิสิตที่มีต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์ 
เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
 
สรุปผล 
 
 การศึกษาค้นคว้าการพัฒนาโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org  ปรากฏผล  ดังนี้ 
  1. โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org    
ทีผู่้ศึกษาค้นคว้าได้พัฒนาขึ้นมีประสิทธิภาพ เท่ากับ 84.14/81.22  
  2. ค่าดัชนีประสิทธิผลของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org  ทีผู่้ศึกษาค้นคว้าได้พัฒนาขึ้น เท่ากับ 0.574 แสดงว่านิสิตที่เรียนรู้ ด้วยโปรแกรม
บทเรียนออนไลน์ มีความก้าวหน้าทางการเรียนรู้ คิดเป็นร้อยละ 57.40   
  3. นิสิตมีความพึงพอใจต่อการเรียนด้วยโปรแกรมบทเรียนออนไลน์   
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  ทีผู่้ศึกษาค้นคว้าได้พัฒนาขึ้น โดยอยู่ในระดับมาก 
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อภิปรายผล 
 
 การศึกษาค้นคว้าการพัฒนาโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ 
openoffice.org นิสิตชั้นปีที่ 1 มีประเด็นที่น่าสนใจที่ควรน ามาอภิปราย ดังนี้ 
  1. โปรแกรมบทเรียนออนไลน์  เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1  
ที่ผู้ศึกษาค้นคว้าได้พัฒนาขึ้น มีประสิทธิภาพ 84.14/81.22 หมายความว่าโปรแกรมบทเรียนออนไลน์นี้  
ท าให้นิสิตเกิดการเรียนรู้ระหว่างเรียนเฉลี่ยร้อยละ 84.14 ถือเป็นประสิทธิภาพของกระบวนการและ 
ท าให้นิสิตมีผลการเรียนรู้หลังเรียนเฉลี่ย 81.22  ถือเป็นประสิทธิภาพของผลลัพธ์ ไชยยศ เรืองสุวรรณ 
(2552  :  134 - 135)  เป็นไปตามท่ีก าหนดซึ่งผลการศึกษาค้นคว้าข้างต้น 80 ตัวแรก (E1) คือผู้เรียน
ทั้งหมดท าแบบทดสอบย่อยท้ายบทเรียนได้คะแนนเฉลี่ยร้อยละ 84.14 ถือว่าเป็นประสิทธิภาพของ
กระบวนการ ส่วน 80 ตัวหลัง (E2) คือ ผู้เรียนทั้งหมดท าแบบวัดผลสัมฤทธิ์หลังเรียน ได้คะแนนเฉลี่ย
ร้อยละ 81.22 ถือเป็นประสิทธิภาพของผลลัพธ์ แสดงว่าโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้
ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 มีประสิทธิภาพสูงกว่าเกณฑ์มาตรฐาน 80/80 ที่ก าหนดไว้  
ทั้งนี้อาจเนื่องมาจาก 
   1.1 การพัฒนาโปรแกรมบทเรียนออนไลน์ ผู้ศึกษาค้นคว้าได้ท าการวิเคราะห์เนื้อหา 
วิเคราะห์จุดประสงค์การเรียนรู้ ผ่านการพิจารณาตรวจสอบความถูกต้องเหมาะสม ทั้งดา้นเนื้อหา  
การใช้ภาษา รูปแบบโครงสร้างของสื่อ จากประธานและกรรมการควบคุมวิทยานิพนธ์ มีผู้เชี่ยวชาญ 
ด้านเนื้อหา ด้านสื่อการเรียนการสอน ด้านโปรแกรม ตรวจสอบทุกขั้นตอน และผู้วิจัยได้ปรับปรุงแก้ไข
ตามข้อเสนอแนะนอกจากนั้นแล้วยังได้ท าการทดลองใช้บทเรียนแบบหนึ่งต่อหนึ่ง และทดลองแบบกลุ่ม
เล็ก เพ่ือท าการปรับปรุงบทเรียนให้มีประสิทธิภาพก่อนน ามาใช้จริงกับกลุ่มทดลอง โดยได้ด าเนินการ
อย่างเป็นขั้นตอนตามหลักวิชาการ ซึ่งสอดคล้องกับงานวิจัยของสามารถ  สิงห์มา (2555  :  64-65) 
พบว่า บทเรียนเว็บแบบผสมผสาน เรื่อง วิวัฒนาการของดาวฤกษ์ส าหรับนักศึกษาระดับปริญญาตรี  
ชั้นปีที่ 2 มหาวิทยาลัยขอนแก่น ที่ผู้ศึกษาพัฒนาขึ้นมีประสิทธิภาพเท่ากับ 81.69/80.63 และผล
การศึกษาของ นุชนภา อินธแสนิ (2555  :  107 - 112) พบว่า บทเรียนบนเครือข่ายแบบเว็บเควสท์ 
วิชา ทฤษฏีและการปฏิบัติด้านการเรียนรู้บนเครือข่าย มีประสิทธิภาพเท่ากับ 88.79/89.73 ซึ่งเป็นไป
ตามเกณฑ์ที่คาดหวังไว้ คือ 80/80 เช่นเดียวกันกับ วิสุทธิพงศ์ ยอดเสาดี (2553  :  84 - 85) พบว่า  
การพัฒนาบทเรียนออนไลน์กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี เรื่อง เทคโนโลยี
สารสนเทศและคอมพิวเตอร์  ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่1 มีประสิทธิภาพ เทา่กับ 
77.22/86.78 สูงกว่าเกณฑ์ 75/75 
   1.2  การออกแบบและพัฒนาโปรแกรมบทเรียนออนไลน์ ในระบบการจัดการเรียน 
การสอน ของ กานเย่เป็นอีกหนึ่งประเด็นที่ท าให้บทเรียนออนไลน์มีประสิทธิภาพ 84.14/81.22  
เพ่ือให้สอดคล้องกับกระบวนการเรียนรู้นั้น ผู้ศึกษาค้นคว้าได้ยึดกรอบแนวคิด กานเย่ ซึ่งมีระบบการ
สอน 9 ขั้น ดังนี้ ทิศนา แขมมณี (2555  :  72-76)  ขั้นที่ 1 สร้างความสนใจ ขั้นที่ 2 แจ้งจุดประสงค ์
ขั้นที่ 3 กระตุ้นให้ผู้เรียนระลึกถึงความรู้เดิมที่จ าเป็น ขั้นที่ 4 เสนอบทเรียนใหม่ ขั้นที่ 5 ให้แนวทางการ
เรียนรู้ ขั้นที ่6 ให้ลงมือปฏิบัติ ขั้นที่ 7 ให้ข้อมูลป้อนกลับ ขั้นที่ 8 ประเมินพฤติกรรมการเรียนรู้ 
ตามจุดประสงค์ ขั้นที่ 9 ส่งเสริมความแม่นย าและการถ่ายโอนการเรียนรู้  
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    จากการน าแนวคิดการพัฒนาโปรแกรมบทเรียนออนไลน์ กับกระบวนการจัดการ
เรียนการสอนตามหลักระบบของ กานเย่  ในครั้งนี้ ท าให้ผู้เรียนเกิดความสนใจและกระตือรือร้นที่จะ
เรียนเพราะผู้เรียนสามารถควบคุมการเรียนด้วยตนเองโดยเลือกเนื้อหาบทเรียนตามความต้องการเรียน
ตามเวลาที่สะดวกและเหมาะสมของแต่ละคน และมีการปฏิสัมพันธ์กับผู้สอนหรือผู้เรียนอ่ืน 
เพ่ือการเรียนรู้ โดยไม่จ าเป็นต้องอยู่ในเวลาหรือสถานที่เดียวกัน 
  2. การพัฒนาโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
นิสิตชั้นปีที่ 1 มีค่าดัชนีประสิทธิผล (Effectiveness Index : E.I.) เท่ากับ 0.574 แสดงว่านักเรียนมี
ความก้าวหน้าทางการเรียนโดยใช้โปรแกรมบทเรียนออนไลน์ที่พัฒนาขึ้น คิดเป็นร้อยละ 57.40 ทั้งนี้
เนื่องจากโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1  ได้ผ่านการ
ออกแบบกระบวนการเรียนการสอนตามหลักการจัดการเรียนการสอนของ กานเย่ แล้วผ่านการประเมิน
ของผู้เชี่ยวชาญด้านโปรแกรมคอมพิวเตอร์ ผู้เชี่ยวชาญด้านเนื้อหา และผู้เชี่ยวชาญด้านสื่อการสอน  
ซึ่งผู้วิจัยได้น าผลการประเมินประกอบกับ ข้อเสนอแนะมาปรับปรุง แก้ไขให้มีความสมบูรณ์ก่อน 
ที่จะน าไปทดลองใช้ จึงท าให้โปรแกรมบทเรียนออนไลน์ ช่วยให้นักเรียนมีความก้าวหน้าทางการเรียน
ดังกล่าว สอดคล้องกับผลการศึกษา ศิริพร  พลพุฒินันท์ (2555  :  111-117) พบว่า การเปรียบเทียบ
ผลการเรียนเรื่อง การสร้างผลงานการน าเสนอแบบมัลติมีเดีย ชั้นประถมศึกษาปีที่ 6 ระหว่างการเรียน
โดยใช้บทเรียนบนเว็บที่พัฒนาตามหลักการจัดกิจกรรม Synecticsd กับการเรียนปกติ พบว่า มีค่าดัชนี
ประสิทธิผลเท่ากับ 0.5897 แสดงว่านักเรียนมีความก้าวหน้าในการเรียนรู้ คิดเป็นร้อยละ 58.97 และ 
ผลการศึกษา ของ แสวง ชุมแวงวาปี (2555  :  82 - 83) พบว่า การพัฒนาบทเรียนบนเว็บ โดยใช้
กระบวนการเรียนแบบผสมผสาน เรื่องการใช้โปรมแกรมอ่านหน้าจอ ส าหรับนักเรียนชั้นมัธยมศึกษา
ตอนต้นที่มีความบกพร่องทางการเห็น พบว่า มีค่าดัชนีประสิทธิผล เท่ากับ 0.7043 แสดงว่านักเรียน 
มีความก้าวหน้าในการเรียนรู้ คิดเป็นร้อยละ 70.43 เช่นเดียวกับ ธีระศักดิ ์ เกียงขวา (2555  :  113 - 
115) พบว่า ผลการเรียนด้วยบทเรียนบนเว็บแบบผสมผสาน เรื่อง หลักการใช้สื่อการเรียนการสอน 
ที่มีต่อผลการเรียนของนิสิตระดับปริญญาตรีที่มีการรู้คอมพิวเตอร์และการน าการเรียนด้วยตนเองต่างกัน  

พบว่า  มีค่าดัชนีประสิทธิผลเท่ากับ 0.7066 ซึ่งแสดงว่านักศึกษามีความก้าวหน้าในการเรียน  
คิดเป็นร้อยละ 70.66 ทั้งนี้อาจเนื่องมาจาก  

   โปรแกรมบทเรียนออนไลน์มีรูปแบบการน าเสนอท่ีน่าสนใจ มีบทเรียนที่แบ่งเป็นหน่วย 

การเรียนรู้ และแบบทดสอบเพ่ือทบทวนความจ าของนักเรียนรวมทั้งยังมีตัวอักษร ภาพนิ่ง 
ภาพเคลื่อนไหว สีสันสวยงาม และเสียงประกอบ ท าให้นักเรียนสนุกสนานในการเรียนรู้ไม่รู้สึกเบื่อหน่าย 
นักเรียนสามารถดูและฟังทบทวนเนื้อหาโดยไม่จ ากัด ข้อมูลย้อยกลับเพ่ือการเสริมแรง ซึ่งจะช่วยเสริม
พฤติกรรมการตอบสนองของนักเรียน บทเรียนออนไลน์ได้ออกแบบให้มีกิจกรรมที่ท้าทายนักเรียนได้
เรียนรู้อย่างมีเป้าหมายที่ชัดเจน จากเหตุผลดังกล่าวจึงท าให้นักเรียนด้วยโปรแกรมบทเรียนมีความรู้ 
เพ่ิมมากข้ึน 

  3. ผลการวัดความพึงพอใจของนิสิตที่มีต่อโปรแกรมบทเรียนออนไลน์  เรื่อง การใช้
ซอฟต์แวร์ openoffice.org พบว่า มีความพึงพอใจในภาพรวมอยู่ในระดับมาก  (×  = 4.29)  และ  
(S.D. = 0.67) เมื่อพิจารณาเป็นรายข้อแล้วพบว่า ข้อ 3. เนื้อหาและบทเรียนมีความสอดคล้องกับ
วัตถุประสงค์ มีค่าเฉลี่ย 4.67 รองลงมาคือ ข้อ 1. อธิบายรายละเอียดและวัตถุประสงค์ ของบทเรียน
อย่างชัดเจน มีค่าเฉลี่ย  4.52 และ ข้อ 2. เนื้อหาและบทเรียนมีความน่าสนใจท าให้เข้าใจได้ง่าย  
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มีค่าเฉลี่ย 4.48  ซึ่งสอดคล้องกับงานวิจัยของวราดา ขันตี (2555  :  93 – 99) พบว่า นักเรียนระดับ
ประกาศนียบัตรวิชาชีพ ชั้นปีที่ 2 มีความพึงพอใจโดยรวมต่อการเรียนด้วยบทเรียนบนเครือข่ายแบบ 
PBL อยู่ในระดับมาก และมีความพึงพอใจโดยรวมต่อการเรียนด้วยบทเรียนบนเครือข่ายแบบ TAI  
อยู่ในระดับมาก และผลการศึกษาของ นุชนภา อินธแสนิ (2555  :  107 - 112) พบว่า นิสิตมีความพึง
พอใจต่อการเรียนรู้ด้วยบทเรียนบนเครือข่ายแบบเว็บเควสท์และบทเรียนบนเครือข่ายแบบปกติ   
โดยรวมและเป็นรายด้านอยู่ในระดับมาก เช่นเดียวกันกับ สวลี มูลวณิชย์ (2555  :  58 - 59) พบว่า 
นักศึกษามีความพึงพอใจต่อการเรียนด้วยบทเรียนโดยรวมอยู่ในระดับมาก  ทั้งนีอ้าจเนื่องมาจาก  
   การออกแบบกระบวนการเรียนในโปรแกรมบทเรียนออนไลน์ที่พัฒนาขึ้น  ได้เน้นที่ผู้  
เรียนเป็นส าคัญ โดยผู้เรียนมีอิสระในการเรียน การให้ผู้เรียนได้เลือกเรียนตามความสามารถ ตามความ
สนใจที่ อยากจะเรียนโดยการเลือกแสวงหาความรู้ตาม ตามความถนัดของตนเอง และสามารถค้นหา
ค าตอบได้ด้วยตนเองเป็นส่วนหนึ่งในการส่งเสริมความพอใจในการเรียนจากโปรแกรมบทเรียนออนไลน์  
นอกจากนี้ โปรแกรมบทเรียนออนไลน์ที่พัฒนาขึ้นยังประกอบไปด้วย ภาพและเสียง มีความเชื่อมโยง
เกี่ยวของโดยง่าย ท าให้ผู้เรียนสนุกสนาน และยังมีแบบทดสอบเพ่ือให้ผู้เรียนเกิดความท้าท้ายและส่งต่อ
ความพึงพอใจกับโปรแกรมบทเรียนออนไลน์มากยิ่งขึ้น โปรแกรมบทเรียนออนไลน์ให้ทั้งความรู้ และ
ความเพลิดเพลิน รวมทั้งช่วยให้รู้จักคิดและปฏิบัติอย่างเป็นขั้นตอน ทั้งนี้เนื่องจากนักเรียนได้เรียน 
ตามเนื้อหาที่ต้องการ ได้ลงมือปฏิบัติ มีผลแสดงความก้าวหน้าทางการเรียนเป็นระยะท้าทายให้ผู้เรียน
เกิดความพยายามจนถึงระดับหนึ่ง ก็จะได้รับความส าเร็จทันที โปรแกรมบทเรียนออนไลน์ยังให้
บรรยากาศในการเรียนที่เป็นกันเอง มีการสนองและเร้าความสนใจมีการโต้ตอบระยะๆ จึงท าให้มี 
การท้าทายนักเรียนเกิดความสนใจ ท าให้นักเรียนใช้ความพยายามจนได้รับความส าเร็จ 
 
ปัญหาและอุปสรรคการศึกษาค้นคว้า 
 
 1. ในการศึกษาค้นคว้าครั้งนี้พบปัญหาและอุปสรรค มีดังต่อไปนี้ 
  1.1 ผู้ศึกษาค้นคว้าไม่สามารถควบคุมวันหรือก าหนดเวลาได้เอง เนื่องจากผู้ศึกษาค้นคว้า
ไม่ได้เป็นอาจารย์ผู้สอนหรือพนักงานในหน่วยงานของมหาวิทยาลัย จึงต้องอาศัยขอความร่วมมือกับ
อาจารย์ผู้สอนเพื่อขอทดลองกลุ่มตัวอย่างในการศึกษาค้นคว้าครั้งนี้ จึงจ าเป็นต้องใช้วันและเวลา 
ในช่วงดังกล่าวซึ่งได้กล่าวไปในขอบเขตของการศึกษาค้นคว้า  
  1.2 การเก็บข้อมูลจากกลุ่มตัวอย่างค่อนข้างยากและช้า เพราะผู้รับการฝึกอบรม 
แต่ละคนอาจใช้เวลาในการศึกษาบทเรียนแตกต่างกัน ท าให้ควบคุมการฝึกอบรมให้ตรงตามแผนได้ยาก  
  1.3 บทเรียนออนไลน์ที่ผู้ศึกษาค้นคว้าได้พัฒนาขึ้นเป็นระบบออนไลน์ซึ่งต้องใช้
อินเตอร์เน็ตเป็นตัวส่งสัญญาณท าให้เครื่องคอมพิวเตอร์บางตัวไม่สามารถใช้งานอินเตอร์เน็ตได้  
จึงท าให้นิสิตบางคนไม่สามารถเข้าไปเรียนโปรแกรมบทเรียนออนไลน์ได้และมีผลท าให้การเรียนหรือ 
การเก็บรวบรวมคะแนนต่าง ๆ ล่าช้า 
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ข้อเสนอแนะ 
 
 1. ข้อเสนอแนะจากการศึกษาค้นคว้าครั้งนี้  
  1.1  ด้านการสร้างหรือพัฒนาโปรแกรมบทเรียนออนไลน์ ในการฝึกอบรมควรให้มีทาง 
เลือกหลายๆ ช่องทาง เพ่ือให้ผู้รับการอบรมได้เรียนตามรูปแบบที่ตัวเองต้องการได้ เช่น รูปแบบ 
มัลติมีเดียรูปแบบที่เน้นข้อความและรูปภาพประกอบ หรือระบบบรรยายสด เนื่องจากผู้รับการ 
อบรมในบางครั้งมีความแตกต่างกันซึ่งผู้รับการอบรมบางคนอ่านเอกสารแล้วสามารถตี ความใน 
เรื่องนั้น ๆ ได้ เนื่องจากมีความรู้พ้ืนฐานอยู่ บ้างแล้ว หรือบางคนไม่มี ความรู้พื้นฐาน เพ่ือให้ใช้งาน 
ได้กับบุคคลที่หลากหลาย  
  1.2 ในการศึกษาค้นคว้าครั้งนี้ผู้วิจัยเป็นเพียงผู้ควบคุมและชี้แจง  ส่วนผู้เรียนเรียนด้วย
ตนเองจากบทเรียนโปรแกรมบทเรียนออนไลน์ ที่ผู้ศึกษาค้นคว้าได้พัฒนาขึ้นโดยไม่มีผู้สอน  
เมื่อจบบทเรียนจึงไม่มีผู้สอนมากล่าวสรุปและตอบประเด่นปัญหาขอซักถามที่ผู้เรียนสงสัย 
ส าหรับการวิจัยในครั้งต่อไปอาจจะต้องค าถึงการกล่าวสรุปโดยผู้สอนเพ่ือให้เกิดปฏิสัมพันธ์ที่ดีระหว่าง
ผู้สอนและผู้เรียนให้มากกว่านี้ 
  1.3 ควรมีการสร้างเนื้อหาบทเรียนที่มีโครงสร้างเป็นแบบผสม เนื่องจากผู้รับการอบรม 
มีความรู้พ้ืนฐานที่มีความแตกต่างกันซึ่งจะท าให้ผู้รับการอบรมสามารถเลือกรูปแบบการเรียนที่มี 
ความเหมาะสมกับผู้รับการอบรมได้  
  1.4 แบบทดสอบเพ่ือหาประสิทธิภาพและผลสัมฤทธิ์ทางการเรียน ควรจะมีการสุ่มตัว 
เลือกของค าตอบด้วยเพราะเป็นการป้องกันในระดับหนึ่งของการลอกหรื อจดจ าค าตอบของค าถามนั้น ๆ 
 2. ข้อเสนอแนะการศึกษาค้นคว้าครั้งต่อไป 
  2.1 ผู้ศึกษาค้นคว้าจะต้องมีการศึกษากลุ่มประชากรและกลุ่มตัวอย่างให้อยู่ใน  
การควบคุมดูแลได้ง่ายและประสานกับบุคคลหรือหน่วยงานที่เกี่ยวข้องโดยเร็ว 
  2.2 ผู้ศึกษาค้นคว้าไม่จ าเป็นต้องก าหนดเงื่อนไขวันเวลาภายใน 1 หรือ 2 เท่านั้น  
เพราะโปรแกรมบทเรียนเป็นระบบออนไลน์ (อินเตอร์เน็ต) ที่สามารถเข้าใช้งานได้ตลอด 24 ชั่วโมง 
หรือตลอดเวลาที่ต้องการเข้าใช้ 
  2.3 ควรมีการศึกษาวิจัยเกี่ยวกับเจตคติ ของผู้รับการอบรม ที่มีผลต่อการอบรมด้วย 
โปรแกรมบทเรียนออนไลน์ในการฝึกอบรม เพ่ือเปรียบเทียบกับการฝึกอบรมด้วยวิธีการฝึกอบรม 
แบบปกติ  ว่ามีความคิดเห็นอย่างไร  
  2.4 การพัฒนาโปรแกรมบทเรียนนั้นต้องล าดับขั้นตอนการท างานให้ชัดเจน 
ควรมี ภาพเคลื่อนไหวแสดงขั้นตอนการปฏิบัติกิจกรรมต่าง ๆ อย่างละเอียด จะช่วยให้ผู้เรียนสามารถ
เรียนรู้ได้อย่างดียิ่งขึ้น 
  2.5 ควรมีการพัฒนาการผลิตโปรแกรมบทเรียนออนไลน์ ในเรื่องอ่ืน ๆ เพ่ือส่งเสริมให้มีสื่อ
การเรียนรู้ที่หลากหลายและเป็นประโยชน์ 
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ภาคผนวก ก 
แผนการจัดการเรียนรู้ แบบประเมินแผนจัดการเรียนรู้ ผลการประเมินความเหมาะสมของ 

แผนจัดการเรียนรู้โดยใช้โปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org   

นิสิตชั้นปีที่ 1 
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แผนจัดการเรียนรู้ด้วยโปรแกรมบทเรียนออนไลน์  
ระดับนิสิตชั้นปีที่ 1             ภาคเรียนที่ 3 ปีการศึกษา 2556 
เรื่อง การใช้ซอฟต์แวร์ openoffice.org    เวลาเรียนจ านวน 16 ชั่วโมง 
ผู้จัดท าแผน นายธนากร  ค าเกต ุ
อาจารย์ท่ีปรึกษา ผศ.ดร.สังคม  ภูมิพันธุ์ 

 
สาระส าคัญ 
 
 โปรแกรม Openoffice.org เป็นชุดโปรแกรมส าเร็จรูปด้านส านักงานที่มีความสามารถ
ครบถ้วน โดยประกอบไปด้วย Writer โปรแกรมด้านประมวลผลค า, Calc โปรแกรมด้านตารางที่
ค านวณ, Impress โปรณกรมด้านการน าเสนอ, Base โปรแกรมสร้างและจัดการฐานข้อมูล ซึ่งสามารถ
ท างานกับภาษาไทยได้อย่างสมบูรณ์ และใช้งานร่วมกับเอกสารไมโครซอฟท์ออฟฟิศได้เป็นอย่างดี  
 ข้อดีของโปรแกรม openoffice.org อีกประการหนึ่งก็คือเราสามารถดาวน์โหลดมาใช้งานได้
ฟรี และเป็นซอฟท์แวร์ประเภท OpenSource คือมีการแจกซอร์สโค้ดของโปรแกรมออกไปให้พัฒนาได้
อย่างอิสระ 

 
ผลการเรียนรู้ที่คาดหวัง 
 
 1. นิสิตมีความรู้และความเข้าใจเกี่ยวกับโปรแกรม Openoffice.org  
 2. นิสิตสามารถอธิบายการท างานของโปรแกรมต่าง ๆ ได้อย่างถูกต้อง 
 3. นิสิตสามารถน าโปแกรม Openoffice.org ไปใช้แทน โปแกรม Microsoft Office หรือ
โปรแกรมส านักงานทั่วไป 
 
สาระการเรียนรู้ 
 
 หน่วยที่ 1 เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0 
  หน่วยที่ 2 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer 
  หน่วยที่ 3 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Impress 
  หน่วยที่ 4 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc 
  หน่วยที่ 5 เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base 
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การบวนจัดการเรียนรู้ 
  

ตาราง 10 ด าเนินการจัดกระบวนการจัดการเรียนรู้ 
 

วัน เดือน ปี กิจกรรมการเรียนการสอน จ านวน
ชั่วโมง 

21 พฤษภาคม 
2557 

ให้นิสิตเข้า http://www.thanakorn-openoffice.com/ 
เริ่มท าการเข้าบทเรียนโดยการ Login 
ให้นิสิตท าแบบทดสอบก่อนเรียน 
หน่วยที่ 1  
บทเรียน เรื่อง  แนะน าและการติดตั้ง OpenOffice.org 2.0 
ท าแบบทดสอบย่อยหลังเรียน 
หน่วยที่ 2  
บทเรียนเรื่อง  การใช้งานโปรแกรม OpenOffice.org Writer  
ท าแบบทดสอบย่อยหลังเรียน 
หน่วยที่ 3  
บทเรียน เรื่อง การใช้งานโปรแกรม OpenOffice.org Impress 
ท าแบบทดสอบย่อยหลังเรียน 

 
 
 
1 
 
 
3 
 
 
4 

22 พฤษภาคม 
2557 

หน่วยที่ 4  
บทเรียน เรื่อง  การใช้งานโปรแกรม OpenOffice.org Calc 
ท าแบบทดสอบย่อยหลังเรียน 
หน่วยที่ 5  
บทเรียน เรื่อง  การใช้งานโปรแกรม OpenOffice.org Base 
ท าแบบทดสอบย่อยหลังเรียน 
พอนิสิตเรียนบทเรียนออนไลน์เสร็จครบทุกหน่วยตามขั้นตอน
แล้วให้นิสิต ท าแบบทดสอบหลังเรียน เสร็จแล้ว ให้ตอบ
แบบสอบถามความพึงพอใจให้ครบทุกข้อ 

4 
 
 
4 

 
ส่ือ/แหล่งการเรียนรู้ 
 
 1. โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  
 2. เครื่องคอมพิวเตอร์ที่เชื่อมต่อระบบเครือข่ายอินเตอร์เน็ต 
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การวัดผลและประเมินผล 
 1. วิธีการวัดผลและประเมินผลการเรียนรู้ 
  1.1 การเข้าร่วมกิจกรรมการเรียนการสอน 
  1.2 การท าแบบทดสอบย่อยท้ายบทเรียนตามที่ก าหนด 
 2. เครื่องมือการวัดผลและประเมินผล 
  2.1 แบบทดสอบก่อนเรียน 
  2.2 แบบทดสอบระหว่างเรียน 
  2.3 แบบทดสอบหลังเรียน 
 3. เกณฑ์การวัดผลและประเมินผล เกณฑ์การประเมินผลจากการท าแบบทดสอบก่อนเรียน , 
หลังเรียน, และระหว่างเรียนหากได้ 80% ขึ้นไปถือว่าผ่านเกณฑ์ 
 
 แบบประเมินความเหมาะสมของแผนจัดการเรียนรู้โดยใช้โปรแกรมบทเรียนออนไลน์ เรื่อง 
การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 ส าหรับผู้เชี่ยวชาญ 
ค าชี้แจง กรุณาใส่เครื่องหมาย (/) ลงในช่องที่ตรงกับความคิดเห็นของท่านซึ่งมี 5 ระดับ คือ  
  5 = มากที่สุด, 4 = มาก, 3 = ปานกลาง, 2 = น้อย, 1 = น้อยท่ีสุด 
 

รายการประเมิน 
ระดับความคิดเห็น 

5 4 3 2 1 

1. เป็นเนื้อหา / สาระที่เข้าใจง่ายเหมาะกับผู้เรียน 

2. เป็นเนื้อหาที่ใช้เป็นพื้นฐานในการเรียนเนื้อหาอื่น 

3. สามารถน าไปประยุกต์ใช้ในชีวิตประจ าวัน 

4. ส่งเสริมให้นักเรียนมีส่วนร่วมในกิจกรรม 

5. เวลาในการจัดกิจกรรมเหมาะสม 

6. โปรแกรมบทเรียนออนไลน์ที่ใช้ในการเรียนการสอนตรงกับ    
    เนื้อหา 

7. โปรแกรมบทเรียนออนไลน์ท าให้นักเรียนสรุปความรู้ได้ด้วย 
    ตนเอง 

8. โปรแกรมบทเรียนออนไลน์มีแหล่งค้นคว้าในการเรียน 
    หลากหลาย และเพียงพอ 

9. เครื่องมือที่ใช้มีความสอดคล้องกับกระบวนการวัดผล 

10. มีการประเมินผลระหว่างการจัดกิจกรรมการเรียนการสอน 

11. มีการประเมินผลก่อนและหลังการจัดกิจกรรม 

12. มีการประเมินผลตามสภาพจริงจากผลงานนักเรียน 
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ตาราง 11  ผลการประเมินความเหมาะสมของแผนจัดการเรียนรู้โดยใช้โปรแกรมบทเรียนออนไลน์   
   เรื่อง การใช้ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 

 

รายการประเมิน 
ระดับความคิดเห็น 

เฉลี่ย 
คนที่ 1 คนที่ 2 คนที่ 3 

1. เป็นเนื้อหา / สาระที่เข้าใจง่ายเหมาะกับผู้เรียน 
2. เป็นเนื้อหาที่ใช้เป็นพื้นฐานในการเรียนเนื้อหาอื่น 
3. สามารถน าไปประยุกต์ใช้ในชีวิตประจ าวัน 
4. ส่งเสริมให้นักเรียนมีส่วนร่วมในกิจกรรม 
5. เวลาในการจัดกิจกรรมเหมาะสม 
6. โปรแกรมบทเรียนออนไลน์ที่ใช้ในการเรียนการสอนตรงกับ 
    เนื้อหา 
7. โปรแกรมบทเรียนออนไลน์ท าให้นักเรียนสรุปความรู้ได้ด้วย 
    ตนเอง 
8. โปรแกรมบทเรียนออนไลน์มีแหล่งค้นคว้าในการเรียน 
    หลากหลาย และเพียงพอ 
9. เครื่องมือที่ใช้มีความสอดคล้องกับกระบวนการวัดผล 
10. มีการประเมินผลระหว่างการจัดกิจกรรมการเรียนการสอน 
11. มีการประเมินผลก่อนและหลังการจัดกิจกรรม 
12. มีการประเมินผลตามสภาพจริงจากผลงานนักเรียน 

4 
4 
5 
4 
4 
 
4 
 
4 
 
5 
 
4 
4 
4 
4 

5 
4 
5 
5 
4 
 
4 
 
4 
 
5 
 
5 
4 
4 
5 

5 
4 
4 
4 
4 
 
4 
 
5 
 
4 
 
4 
4 
5 
5 

4.67 
4 

4.67 
4.33 

4 
 
4 
 

4.67 
 

4.33 
 
4 

4.67 
4.33 
4.33 

คะแนนเฉลี่ย 4.25 4.5 4.25 4.33 
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ภาคผนวก ข  
ผังงาน (Flowchart) 
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ผังงาน (Flowchart) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

ศึกษาเนื้อหาและรวมรวมข้อมูลจากเอกสารต่าง ๆ 

วิเคราะห์เนื้อหาและก าหนดจุดประสงค์ 

เขียนแผนจัดการเรียนรู้ 

อาจารย์ที่ปรึกษาตรวจสอบ ปรับปรุงแก้ไข 

ไม่ผ่าน 

จัดท าสตรอรีบอร์ด 

อาจารย์ที่ปรึกษาประเมิน 

สร้างโปรแกรมบทเรียนออนไลน์ 

ผ่าน 

ปรับปรุงแก้ไข 

ไม่ผ่าน 

ผ่าน 

อาจารย์ที่ปรึกษาประเมิน 
 

ผู้เชี่ยวชาญประเมิน 

ปรับปรุงแก้ไข 

ไม่ผ่าน 

ผ่าน 

ปรับปรุงแก้ไข 
ไม่ผ่าน 

หาประสิทธิ์ภาพบทเรียน/ปรับปรุง 

ผ่าน 

โปรแกรมบทเรียนออนไลน์ 

ผ่าน 
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ภาคผนวก ค 
ตัวอย่างบัตรเรื่อง (Storyboard) ของโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 

openoffice.org  นิสิตชั้นปีที่ 1  
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ตาราง 12 บัตรเรื่อง (Storyboard) เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1 
 

 
Fame 

Display Resource and Effect 

F01  
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : ค าชี้แจงการเข้าเรียน
บทเรียนออนไลน์ 
Bottom : login, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 
 
 
 

F02  
 
 
 
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : ประมวลผลรายวิชา, 
หน่วยการเรียนที่ 1 – 5   
Bottom : ออกจากระบบ, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 

 
 
 
 
 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 
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ตาราง 12 (ต่อ) 
 

 
Fame 

Display Resource and Effect 

F03  
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : ข้อสอบก่อนเรียน – หลัง
เรียน 
Bottom : ออกจากระบบ, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 
 
 
 

F04  
 
 
 
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : แบบประเมินความพึงพอใจ 
Bottom : ออกจากระบบ, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 

 
 
 
 
 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 
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ตาราง 12 (ต่อ) 
 

 
Fame 

Display Resource and Effect 

F05  
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : สรุปผลการเรียน 
Bottom : ออกจากระบบ, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 
 
 
 

F06  
 
 
 
 
 
 
 
 
 
 
 
 

Background : ภาพพ้ืนหลัง 
สีน้ าเงิน 
Text : กระดานถาม – ตอบ 
Bottom : ออกจากระบบ, เมน,ู 
Link : เว็บไซต์ 
Chatroom : facebook 
Webboard : กระดานถาม – 
ตอบ, กระดานข่าวการศึกษา 
 

 
 
 
 
 
 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 

E - learning 
Bottom 

 

System 
administrator Text 

Bottom 

Link 

chatroom 
Webboard  

Webboard  

Background 
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ภาคผนวก ง  
ตัวอย่างเว็บไซต์ การพัฒนาโปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  

นิสิตชั้นปีที่ 1  เว็บไซต์  http://www.thanakorn-openoffice.com/ 
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ตัวอย่าง หน้าเว็บโปรแกรมบทเรียน 
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 ส่วนที่ 1  เป็นส่วนของ การลงทะเบียน บทเรียน ข้อสอบวัดผล แบบวัดความพึงพอใจ 
และกระดานถาม-ตอบ 
 

 
 
 ส่วนที่ 2  เป็นส่วนของ Link เว็บไซต์ต่าง ๆ และกระดานข่าว 
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 รายละเอียดในการเข้าใช้งาน 

 

 
 
  

 
 
 

เป็นส่วนของการ Login เข้า
สู่ระบบ บทเรียนออนไลน์  
สมัครสมาชิกก่อนเข้าใช้งาน 

เป็นส่วนของเมนูหลักของ
การใช้งาน 

เป็นส่วนของค าช้ีแจงรายวิชา
ที่จะเข้าไปใช้งานในระบบ 
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เป็นส่วนของการ
ลงทะเบียนสมาชิก และ
ตรวจสอบรายชื่อ 

เมื่อเข้าใช้งานในระบบแล้วจะ
ปรากฏดังภาพ 
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เลือก บทเรียนออนไลน์ (หน่วยการ
เรียน) ท าการสอบก่อนเรียนและหลัง
เรียน และท าตามล าดับขั้นตอนที่ ระบ ุ 
 

เมื่อเรียนเสร็จแล้วให้ คลิกที่
กล่องสีฟ้า  “ลงชื่อเข้าเรียน” 
ทุกครั้งเมื่อเรียนเสร็จ 
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เมื่อเรียนบทเรียนออนไลน์เสร็จ
หมดทุกบทเรียนแล้ว(ต้องเรียนให้
ครบทุกบทเรียน)ให้เข้าไปท า
ข้อสอบ Final  แล้วส่งค าตอบ 

เมื่อท าข้อสอบ Final เสร็จ
แล้ว ให้เข้าไปตอบ
แบบสอบถามความพึงพอใจ 
ให้ครบทุกข้อ แล้วส่งค าตอบ 
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เมื่อเรียนเสร็จแล้วให้ คลิกที่ สรุปผล
การเรียน บทเรียนจะสรุปคะแนน 
ต่าง ๆ ให้ได้รู้ว่าได้เท่าไร 

เป็นส่วนของกระดานถาม-ตอบ   
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ภาคผนวก จ  
แบบประเมินและผลการประเมิน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 

openoffice.org  นิสิตชั้นปีที่ 1 (ส าหรับผู้เชี่ยวชาญ) 
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 แบบประเมินแบบประเมิน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org นิสิตชั้นปีที่ 1 (ส าหรับผู้เชี่ยวชาญ) ด้านเนื้อหา 
ค าชี้แจง  กรุณาใส่เครื่องหมาย (/) ลงในช่องที่ตรงกับความคิดเห็นของท่านซึ่งมี 5 ระดับ 
            คือ  5 = ดีมาก,  4 = ดี, 3 = ปานกลาง,  2 = น้อย,  1 = น้อยท่ีสุด 
 

 
รายการประเมิน 

ระดับความเหมาะสม 
5 4 3 2 1 

1. ผลการเรียนรู้ที่คาดหวังมีความสมบูรณ์และชัดเจน  
2. เนื้อหาถูกต้องตามหลักวิชา    
3. เนื้อหาครอบคลุมตามผลการเรียนรู้ที่คาดหวัง    
4. ความชัดเจนในการอธิบายเนื้อหา    
5. เนื้อหามีความสัมพันธ์ต่อเนื่อง    
6. ภาษาท่ีใช้มีความเหมาะสมกับผู้เรียน    
7. เนื้อหาในแต่ละหน่วยการเรียนมีความครอบคลุม  
    ตามผลการเรียนรู้ที่คาดหวัง    
8. การน าเสนอเนื้อหาของบทเรียนมีความน่าสนใจ    
9. แบบทดสอบหลังเรียนช่วยให้ผู้เรียนเข้าใจเนื้อหา 
    ยิ่งขึ้น   
10. แหล่งอ้างอิง (รู้เรียน / หน่วยงาน) ของข้อมูลและ 
     เนื้อหา 

          

 

ความคิดเห็นและข้อเสนอแนะอื่น  ๆ

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................ 
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 ตาราง 13 แบบประเมิน โปรแกรมบทเรียนออนไลน์ (ส าหรับผู้เชี่ยวชาญ) ด้านเนื้อหา 
 

รายการประเมิน ×  S.D. ระดับการประเมิน 
1. ผลการเรียนรู้ที่คาดหวังมีความสมบูรณ์และชัดเจน  
2. เนื้อหาถูกต้องตามหลักวิชา    
3. เนื้อหาครอบคลุมตามผลการเรียนรู้ที่คาดหวัง    
4. ความชัดเจนในการอธิบายเนื้อหา    
5. เนื้อหามีความสัมพันธ์ต่อเนื่อง    
6. ภาษาท่ีใช้มีความเหมาะสมกับผู้เรียน    
7. เนื้อหาในแต่ละหน่วยการเรียนมีความครอบคลุมตาม 
    ผลการเรียนรู้ที่คาดหวัง    
8. การน าเสนอเนื้อหาของบทเรียนมีความน่าสนใจ    
9. แบบทดสอบหลังเรียนช่วยให้ผู้เรียนเข้าใจเนื้อหา 
   ยิ่งขึ้น   
10. แหล่งอ้างอิง (รู้เรียน / หน่วยงาน) ของข้อมูลและ 
     เนื้อหา 

4.67 
4.00 
3.67 
4.67 
4.67 
3.67 
4.67 

 
4.67 
4.33 

 
4.16 

 

0.58 
1.00 
0.58 
0.58 
0.58 
0.58 
0.58 

 
0.58 
0.58 

 
0.58 

 

เหมาะสมมากที่สุด 
เหมาะสมมาก 
เหมาะสมมาก 

เหมาะสมมากที่สุด 
เหมาะสมมาก 

เหมาะสมมากที่สุด 
เหมาะสมมากที่สุด 

 
เหมาะสมมาก 
เหมาะสมมาก 

 
เหมาะสมมาก 

 
ผลรวมคะแนน 4.16 0.59 เหมาะสมมาก 
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 แบบประเมินแบบประเมิน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org นิสิตชั้นปีที่ 1 (ส าหรับผู้เชี่ยวชาญ) ด้านสื่อการสอน 
ค าชี้แจง  กรุณาใส่เครื่องหมาย (/) ลงในช่องที่ตรงกับความคิดเห็นของท่านซึ่งมี 5 ระดับ 
            คือ  5 = ดีมาก,  4 = ดี, 3 = ปานกลาง,  2 = น้อย,  1 = น้อยท่ีสุด 

 
 

รายการประเมิน 
ระดับความเหมาะสม 

5 4 3 2 1 
1. การออกแบบหน้าเว็บ 
2. ค าแนะน าในการใช้บทเรียน 
3. ความง่ายในการใช้บทเรียน 
4. การน าเสนอเนื้อหา 
5. ความน่าสนใจในการใช้บทเรียน 
6. การใช้ภาพกราฟิกเหมาะสมกับเนื้อหา 
7. การใช้กราฟิกเหมาะสมกับสีพื้นหลัง 
8. ความเหมาะสมของสีกับการออกแบบจอภาพ 
9. การใช้สื่อตัวอักษรเหมาะสมกับสีพ้ืนหลัง 
10. การเลือกใช้รูปแบบของตัวอักษร 
11. ขนาดของตัวอักษรที่ใช้ 
12. ความสามารถในการเชื่อมโยงเอกสาร 
13. การเข้าถึงข้อมูลด้วยการเลือกจากเมนูสะดวกต่อ 
     การใช้งาน 
14. ความรวดเร็วในการแสดงข้อมูล 
15. การคลิกข้อความหรือปุ่มต่าง ๆ ในบทเรียนมี 
     ความสะดวก 

16. การเชื่อมโยง (Link) ภายในบทเรียน  

          

 

ความคิดเห็นและข้อเสนอแนะอื่น  ๆ

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................  

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................ 
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ตาราง 14  แบบประเมิน โปรแกรมบทเรียนออนไลน์ (ส าหรับผู้เชี่ยวชาญ) ด้านสื่อการสอน 
 

รายการประเมิน ×  S.D. ระดับการประเมิน 
1. การออกแบบหน้าเว็บ 
2. ค าแนะน าในการใช้บทเรียน 
3. ความง่ายในการใช้บทเรียน 
4. การน าเสนอเนื้อหา 
5. ความน่าสนใจในการใช้บทเรียน 
6. การใช้ภาพกราฟิกเหมาะสมกับเนื้อหา 
7. การใช้กราฟิกเหมาะสมกับสีพื้นหลัง 
8. ความเหมาะสมของสีกับการออกแบบจอภาพ 
9. การใช้สื่อตัวอักษรเหมาะสมกับสีพ้ืนหลัง 
10. การเลือกใช้รูปแบบของตัวอักษร 
11. ขนาดของตัวอักษรที่ใช้ 
12. ความสามารถในการเชื่อมโยงเอกสาร 
13. การเข้าถึงข้อมูลด้วยการเลือกจากเมนูสะดวกต่อ 
     การใช้งาน 
14. ความรวดเร็วในการแสดงข้อมูล 
15. การคลิกข้อความหรือปุ่มต่าง ๆ ในบทเรียนมีความ 
     สะดวก 
16. การเชื่อมโยง (Link) ภายในบทเรียน 

4.67 
4.00 
3.67 
4.67 
3.67 
4.67 
4.67 
3.67 
4.33 
3.67 
4.67 
4.67 

 
3.67 
4.33 

 
3.67 
4.00 

0.58 
1.00 
0.58 
0.58 
0.58 
0.58 
0.58 
0.58 
0.58 
0.58 
0.58 
0.58 

 
0.58 
0.58 

 
0.58 
0.58 

เหมาะสมมากที่สุด 
เหมาะสมมาก 
เหมาะสมมาก 

เหมาะสมมากที่สุด 
เหมาะสมมาก 

เหมาะสมมากที่สุด 
เหมาะสมมากที่สุด 

เหมาะสมมาก 
เหมาะสมมาก 
เหมาะสมมาก 

เหมาะสมมากที่สุด 
เหมาะสมมากที่สุด 

 
เหมาะสมมาก 
เหมาะสมมาก 

 
เหมาะสมมาก 
เหมาะสมมาก 

ผลรวมคะแนน 4.17 0.61 เหมาะสมมาก 
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 แบบประเมิน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org 
นิสิตชั้นปีที่ 1 (ส าหรับผู้เชี่ยวชาญ) ด้านโปรแกรมคอมพิวเตอร์ 
ค าชี้แจง  กรุณาใส่เครื่องหมาย (/) ลงในช่องที่ตรงกับความคิดเห็นของท่านซึ่งมี 5 ระดับ 
            คือ  5 = ดีมาก,  4 = ดี, 3 = ปานกลาง,  2 = น้อย,  1 = น้อยท่ีสุด 

 
 

รายการประเมิน 
ระดับความเหมาะสม 

5 4 3 2 1 
1. สื่อชี้น า (Navigational Aide : Icon Hypertext,   
    Button) ในการสืบค้นข้อมูลสะดวกต่อการใช้ 
2. การขยายล าดับการสืบค้นข้อมูล (Branching) 
3. การเข้าถึงข้อมูลด้วยการเลือกจากเมนู สะดวกต่อ 
   การใช้งาน 
4. ความรวดเร็วในการแสดงข้อมูล 
5. ค าแนะน าในการใช้บทเรียน 
6. การติดต่อสื่อสาร เช่น ห้องสนทนา (Chat Room)  
    ไปรษณีย์อิเลคทรอนิกส์ (E-mail) และกระดาน 
    ข่าว (Web Board) 
7. การคลิ้กข้อความหรือปุ่ม ต่าง ๆ ในบทเรียนมีความ 
    สะดวก 
8. การเชื่อมโยง (Link) ภายในบทเรียน 
9. การเชื่อมโยง (Link) ไปยังเว็บไซต์ที่เก่ียวข้อง 

10. แบบทดสอบก่อนเรียนและหลังเรียนสะดวกต่อ 

     การใช้งาน 

          

 

ความคิดเห็นและข้อเสนอแนะอื่น  ๆ

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................  

........................................................................................................................................................................................

........................................................................................................................................................................................

........................................................................................................................................................................................ 
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ตาราง 15 แบบประเมิน โปรแกรมบทเรียนออนไลน์ (ส าหรับผู้เชี่ยวชาญ) ด้านโปรแกรมคอมพิวเตอร์ 
 

รายการประเมิน ×  S.D. ระดับการประเมิน 
1. สื่อชี้น า (Navigational Aide : Icon Hypertext,   
    Button) ในการสืบค้นข้อมูลสะดวกต่อการใช้ 
2. การขยายล าดับการสืบค้นข้อมูล (Branching) 
3. การเข้าถึงข้อมูลด้วยการเลือกจากเมนู สะดวกต่อ 
   การใช้งาน 
4. ความรวดเร็วในการแสดงข้อมูล 
5. ค าแนะน าในการใช้บทเรียน 
6. การติดต่อสื่อสาร เช่น ห้องสนทนา (Chat Room)  
    ไปรษณีย์อิเลคทรอนิกส์ (E-mail) และกระดาน 
    ข่าว (Web Board) 
7. การคลิ้กข้อความหรือปุ่ม ต่าง ๆ ในบทเรียนมีความ 
    สะดวก 
8. การเชื่อมโยง (Link) ภายในบทเรียน 
9. การเชื่อมโยง (Link) ไปยังเว็บไซต์ที่เก่ียวข้อง 

10. แบบทดสอบก่อนเรียนและหลังเรียนสะดวกต่อ 

     การใช้งาน 

4.00 
 

4.00 
 

4.33 
4.67 
3.67 

 
 

4.67 
 

4.67 
3.67 
4.33 

 
3.67 

1.00 
 

1.00 
 

0.58 
0.58 
0.58 

 
 

0.58 
 

0.58 
0.58 
0.58 

 
0.58 

เหมาะสมมาก 
 

เหมาะสมมาก 
 

เหมาะสมมาก 
เหมาะสมมากที่สุด 

เหมาะสมมาก 
 
 

เหมาะสมมากที่สุด 
 

เหมาะสมมากที่สุด 
เหมาะสมมาก 
เหมาะสมมาก 

 
เหมาะสมมาก 

ผลรวมคะแนน 4.17 0.66 เหมาะสมมาก 
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ภาคผนวก ฉ  
แบบวัดผลสัมฤทธิ์ทางการเรียน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ 

openoffice.org  นิสิตชั้นปีที่ 1  
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แบบวัดผลสัมฤทธิ์ทางการเรียน  
โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1  

มีข้อสอบ 30 ข้อ  คะแนนเต็ม 30 คะแนน 
ค าชี้แจง  1. ให้นิสิต คลิกเลือกช่องที่อยู่หน้าตัวอักษร ก ข ค หรือ ง  ที่เห็นว่าถูกที่สุดข้อเดียว  
  2. ให้ท าในตัวโปรแกรมบทเรียนออนไลน์ตามขั้นตอนที่ระบุไว้ 
  3. ท าเสร็จแล้วให้ส่งค าตอบได้เลย 
   

 

1. โปรแกรม  OpenOffice.org Writer เป็นโปรแกรมเกี่ยวกับอะไร 
  ก.  การพิมพ์งานเอกสาร 
  ข.  การพิมพ์งานเกี่ยวกับตัวเลข 
  ค.  จัดการเกี่ยวกับรูปภาพ 
  ง.  จัดการเกี่ยวกับฐานข้อมูล 

2.  ถ้าต้องการบันทึกแฟ้มเปลี่ยนชื่อใหม่ต้องใช้ค าสั่งว่าอย่างไร 
  ก.  File>Save 
  ข.  File>Save as 
  ค.  File>Rename 
  ง.  File>Save>Rename 

3.  ถ้าต้องการบันทึกแฟ้มเพ่ือน าไปเปิดกับโปรแกรม  Microsoft Word  สั่งอย่างไร 
  ก.  File>Save as>Microsoft Office Word   
  ข.  File>Save as>Microsoft Office 
  ค.  File>Save as>Microsoft Word97/2000/XP   
  ง.  File>Save as>Microsoft Document 

4.  การปรับการแสดงผลหน้าจอ  ท าอย่างไร 
  ก.  View>Zoom 
  ข.  File>Zoom 
  ค.  Edit>Zoom 
  ง.  Format>Zoom 

5.  การจัดรูปแบบตัวอักษรให้เป็นตัวยก ตัวห้อย จัดที่ใด 
  ก.  Format>Character>Font 
  ข.  Format>Character>Position 
  ค.  Format>Character>Font Effects 
  ง.  Format>Character>Font Alignment 
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6.  ถ้าต้องการพิมพ์งานแนวนอน ควรท าอย่างไร 
  ก.  Format>Page>Orientation>Landscape 
  ข.  File>Page>Orientation>Landscape 
  ค.  File>Page Setup>Orientation>Landscape 
  ง.  Edit>Page>Orientation>Landscape 

7.  ถ้าต้องการใช้รูปโทรศัพท์ แทนค าว่า  โทร ในเอกสาร ต้องเลือกจากที่ใด 
  ก.  Format>Special Characters 
  ข.  Insert>Special Characters 
  ค.  Edit>Special Characters 
  ง.  View>Special Characters 

8.  การตั้งเลขหน้าใหม่ท าอย่างไร 
  ก.  คลิกเมนู มุมมอง เลือกเลขหน้า และแก้ไขเลขหน้าในส่วนของออฟเซ็ท 
  ข.  คลิกเมนู รูปแบบ เลือกเลขหน้า และแก้ไขเลขหน้าในส่วนของออฟเซ็ท 
  ค.  คลิกเมนู แก้ไข เลือกเลขหน้า และแก้ไขเลขหน้าในส่วนของออฟเซ็ท 
  ง.  ดับเบิ้ลคลิกที่เลขหน้า แก้ไขตัวเลขในส่วนของออฟเซ็ท 

9.  ถ้าต้องการแทรกภาพเข้ามาในเอกสารต้องท าอย่างไร 
  ก.  คลิกเมนู Insert>Picture 
  ข.  คลิกเมนู Format>Picture 
  ค.  คลิกเมนู View>Picture 
  ง.  คลิกเมนู File>Picture 

10.  การรวมกลุ่มรูปวาด ท าอย่างไร 
  ก.  เลือกภาพทั้งหมด คลิกเมนู รูปแบบ > รวมกลุ่ม 
  ข.  เลือกภาพทั้งหมด คลิกเมนู รูปแบบ > จัดกลุ่ม 
  ค.  เลือกภาพทั้งหมด คลิกเมนู รูปแบบ > จัดการกลุ่ม 
  ง.  เลือกภาพทั้งหมด คลิกเมนู รูปแบบ > จัดต าแหน่งกลุ่ม 

11.  ถ้าต้องการพิมพ์งานบางหน้าของแฟ้มข้อมูลสั่งที่ใด และสั่งอย่างไร  
  ก.  คลิกเลือกค าสั่ง หน้า และระบุเลขหน้าที่ต้องการพิมพ์  
  ข.  คลิกเลือกค าสั่ง ทั้งหมด แต่ให้ระบุเลขหน้าที่ต้องการพิมพ์ทั้งหมด 
  ค.  คลิกท่ีส าเนา และระบุจ านวนหน้าที่ต้องการ 
  ง.  ไม่มีข้อใดถูก 

12. โปรแกรม OpenOffice.org Calc เป็นโปรแกรมเก่ียวกับอะไร 
  ก.  จัดการตัวอักษร 
  ข.  จัดการเกี่ยวกับตัวเลข 
  ค.  จัดการเกี่ยวกับรูปภาพ 
  ง.  จัดการเกี่ยวกับฐานข้อมูล 
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13.  แถบสูตร มีไว้ใช้ท าอะไร 
  ก.  ป้อนสูตรเพื่อการค านวณ 
  ข.  แก้ไขข้อมูล 
  ค.  ดูสูตรการค านวณ 
  ง.  ถูกทุกข้อ 

14.  การสร้างแฟ้มตารางที่ค านวณใหม่ ท าอย่างไร 
  ก.  คลิกเมนู File>New>Spreadsheet 
  ข.  คลิกเมนู Edit>New>Spreadsheet 
  ค.  คลิกเมนู Format>New>Spreadsheet 
  ง.  คลิกเมนู View>New>Spreadsheet 

15.  ถ้าต้องการป้อนข้อมูลประเภทสูตรลงไปในเซลล์จะต้องใส่เครื่องหมายใดก่อนป้อนข้อมูล  
  ก.  = 
  ข.  + 
  ค.  @ 
  ง.  ฿ 

16.  การป้อนข้อมูลประเภทวันที่ มีหลักในการป้อนอย่างไร 
  ก.  การป้องต้องป้อนเป็น ในรูปของ วัน เดือน ปี เท่านั้น 
  ข.  ปีที่ป้อน ต้องป้อนเป็นปี  คศ.  เท่านั้น 
  ค.  ปี ควรป้อนเป็นเลข 4 หลัก 
  ง.  ถูกทุกข้อ 

17.  การน าเสนองานด้วยกราฟ มีประโยชน์อย่างไร 
  ก.  มีความสวยงามและสื่อความหมายได้ชัดเจน 
  ข.  สามารถเข้าใจได้ง่าย 
  ค.  ช่วยให้สามารถตัดสินใจได้อย่างมีประสิทธิภาพ 
  ง.  ถูกทุกข้อ 

18.  ถ้าต้องการเปลี่ยนสีแท่งกราฟ ท าอย่างไร 
  ก.  ดับเบิ้ลคลิกที่แท่งกราฟ เลือกพ้ืนที่ เลือกสี 
  ข.  ดับเบ้ิลคลิกท่ีแท่งกราฟ เลอืกเส้นขอบ เลอืกสี 
  ค.  ดับเบ้ิลคลิกท่ีแท่งกราฟ เลอืกป้ายช่ือ เลอืกสี 
  ง.  ดับเบ้ิลคลิกท่ีแท่งกราฟ เลอืกตัวอักขระ เลอืกสี 

19.  ถ้าต้องการเปลี่ยนประเภทกราฟ ท าอย่างไร 
  ก.  ดับเบ้ิลคลิกท่ีรูปกราฟ  คลิกเมนู รูปแบบ>เลือกชุดข้อมูล 
  ข.  ดับเบ้ิลคลิกท่ีรูปกราฟ  เลือกค าสั่ง รูปแบบ>เลือกพ้ืนที่แผนภูมิ 
  ค.  ดับเบ้ิลคลิกท่ีรูปกราฟ  เลือกค าสั่ง รูปแบบ>เลือกรูปแบบกราฟ   
  ง.  ดับเบิ้ลคลิกที่รูปกราฟ  เลือกค าสั่ง รูปแบบ>เลือกชนิดแผนภูมิ 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Mahasarakham University 



112 

 

20.  ถ้าต้องการท าเอกสารออกเป็น PDF File ท าอย่างไร 
  ก.  คลิกเมนูค าสั่ง File>Export As PDF 
  ข.  คลิกเมนูค าสั่ง File>Print Setting PDF  
  ค.  คลิกเมนูค าสั่ง File>Send As PDF 
  ง.  คลิกเมนูค าสั่ง File>Print As PDF  

21. โปรแกรม  OpenOffice.org Impress เป็นโปรแกรมเกี่ยวกับอะไร 
  ก.  การพิมพ์งานในส านักงาน 
  ข.  การน าเสนองาน 
  ค.  การตกแต่งรูปภาพ 
  ง.  การเก็บรวบรวมข้อมูล 

22. โปรแกรม OpenOffice.org Impress มีการท างานคล้ายโปรแกรมอะไร 
  ก.  Microsoft Word 
  ข.  Microsoft PowerPoint 
  ค.  Microsoft Paint 
  ง.  Microsoft Excel 

23. การสร้างแฟ้มงานน าเสนอเปล่าใหม่ท าอย่างไร 
  ก.  คลิกเมนู File>New>Presentation>empty presentation 
  ข.  คลิกเมนู File>Open>Presentation>empty presentation 
  ค.  คลิกเมนู File>Save>Presentation>empty presentation 
  ง.  คลิกเมนู File>Create>Presentation>empty presentation 

24. ถ้าต้องการเพิ่มสไลด์ใช้ค าสั่งอย่างไร 
  ก.  คลิกเมนู  Format>Insert>Slide 
  ข.  คลิกเมนู  Edit>Insert>Slide 
  ค.  คลิกเมนู  Insert>Slide 
  ง.  คลิกเมนู  View>Insert>Slide 

25. ถ้าต้องการแทรกภาพเข้ามาในสไลด์ต้องท าอย่างไร 
  ก.  คลิกเมนู  Insert>Picture 
  ข.  คลิกเมนู  Format>Picture 
  ค.  คลิกเมนู  View>Picture 
  ง.  คลิกเมนู  File>Picture 

26. การวาดรูปทรงมาตรฐาน เลือกจากเครื่องมืออะไร 
  ก.  Standard Toolbars 
  ข.  Formatting Toolbars 
  ค.  Presentation 
  ง.  Drawing 
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27. การใส่พ้ืนหลังรูปทรงท าอย่างไร 
  ก.  คลิกเมนู  Format>Area 
  ข.  คลิกเมนู  Format>Background 
  ค.  คลิกเมนู  Format>Area>Background 
  ง.  คลิกเมนู  Format>Position>Area 

28. ถ้าต้องการสร้างตารางที่สไลด์งานน าเสนอท าอย่างไร 
  ก.  แทรกสไลด์ใหม่ เลือก Layout Title Spreadsheet 
  ข.  แทรกสไลด์ใหม่ เลือก Layout Table 
  ค.  แทรกสไลด์ใหม่ เลือก Layout Title Chart 
  ง.  แทรกสไลด์ใหม่ เลือก Layout Title Picture 

29. การน าเข้าเสียงและวิดีโอต้องท าอย่างไร 
  ก.  คลิกเมนู Insert>Movie and Sound 
  ข.  คลิกเมนู Edit>Movie and Sound 
  ค.  คลิกเมนู Slide show>Custom Animation 
  ง.  คลิกเมนู Slide show>Movie and Sound 

30. ถ้าต้องการให้โปรแกรมจัดรูปแบบการพิมพ์แบบ 6 สไลด์ต่อ 1 แผ่นกระดาษ สั่งที่ใด 
  ก.  คลิกเลือกแท็บ Handout แล้วเลือกในช่อง Layouts หน้าต่างขวามือ 
  ข.  คลิกเลือกแท็บ Slide แล้วเลือกในช่อง Layouts หน้าต่างขวามือ 
  ค.  คลิกเลือกแท็บ Slide Sorter แล้วเลือกในช่อง Layouts หน้าต่างขวามือ 
  ง.  คลิกเลือกแท็บ Note แล้วเลือกในช่อง Layouts หน้าต่างขวามือ 
 

………………………………….. 
 

เฉลยแบบวัดผลสัมฤทธิ์ทางการเรียน 
 

ข้อ 1 2 3 4 5 6 7 8 9 10 
เฉลย ก ข ค ก ข ก ข ง ก ข 
ข้อ 11 12 13 14 15 16 17 18 19 20 

เฉลย ก ข ก ก ก ง ง ก ง ก 
ข้อ 21 22 23 24 25 26 27 28 29 30 

เฉลย ข ข ก ค ก ง ก ก ก ก 
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ภาคผนวก ช  
วิเคราะห์หาดัชนีความสอดคล้องระหว่างข้อสอบกับจุดประสงค์การเรียนรู้ของแบบวัดผลสัมฤทธิ์

ทางการเรียน โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์ openoffice.org   
นิสิตชั้นปีที่ 1  
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ตาราง 16  การวิเคราะห์ดัชนีความสอดคล้องระหว่างข้อสอบกับจุดประสงค์การเรียนรู้  
  (IOC : Index of Objective Congruence)  เรื่อง การใช้ซอฟต์แวร์   
  openoffice.org นิสิตชั้นปีที่ 1 
                 

ข้อที่ 
ความคิดเห็นผู้เชี่ยวชาญ 

รวม IOC สรุปผล 
1 2 3 

1 1 1 1 3 1 ใช้ได้ 
2 0 0 0 0 0 ใช้ไม่ได้ 
3 1 1 0 2 0.6 ใช้ได้ 
4 1 1 1 3 1 ใช้ได้ 
5 1 1 0 2 0.6 ใช้ได้ 
6 1 1 1 3 1 ใช้ได้ 
7 1 1 0 2 0.6 ใช้ได้ 
8 1 1 1 3 1 ใช้ได้ 
9 0 -1 0 -1 -0.3 ใช้ไม่ได้ 
10 0 1 1 2 0.6 ใช้ได้ 
11 1 1 1 3 1 ใช้ได้ 
12 -1 0 1 0 0 ใช้ไม่ได้ 
13 0 0 0 0 0 ใช้ไม่ได้ 
14 1 1 1 3 1 ใช้ได้ 
15 1 1 0 2 0.6 ใช้ได้ 
16 1 1 1 3 1 ใช้ได้ 
17 1 1 1 3 1 ใช้ได้ 
18 -1 -1 0 -2 -0.6 ใช้ไม่ได้ 
19 1 1 1 3 1 ใช้ได้ 
20 0 0 0 0 0 ใช้ไม่ได้ 
21 1 1 1 3 1 ใช้ได้ 
22 0 1 1 2 0.6 ใช้ได้ 
23 0 0 0 0 0 ใช้ไม่ได้ 
24 1 0 1 2 0.6 ใช้ได้ 
25 1 1 1 3 1 ใช้ได้ 
26 1 1 1 3 1 ใช้ได้ 
27 1 1 1 3 1 ใช้ได้ 
28 1 1 1 3 1 ใช้ได้ 
29 1 1 0 2 0.6 ใช้ได้ 
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 ตาราง 16  (ต่อ) 
 

ข้อที่ 
ความคิดเห็นผู้เชี่ยวชาญ 

รวม IOC สรุปผล 
1 2 3 

30 0 1 0 1 0.3 ใช้ไม่ได้ 
31 1 1 1 3 1 ใช้ได้ 
32 0 1 1 2 0.6 ใช้ได้ 
33 0 0 1 1 0.3 ใช้ไม่ได้ 
34 1 0 1 2 0.6 ใช้ได้ 
35 1 1 1 3 1 ใช้ได้ 
36 0 0 0 0 0 ใช้ไม่ได้ 
37 0 1 1 2 0.6 ใช้ได้ 
38 1 1 1 3 1 ใช้ได้ 
39 1 0 1 2 0.6 ใช้ได้ 
40 1 1 1 3 1 ใช้ได้ 
41 1 1 1 3 1 ใช้ได้ 
42 1 0 1 2 0.6 ใช้ได้ 
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ภาคผนวก ซ 
ค่าความยาก (P) และ ค่าอ านาจจ าแนก (B) ค่าความเชื่อม่ันทั้งฉบับ (𝑅∝)  

ของแบบวัดผลสัมฤทธิ์ทางการเรียน โปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1 
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 ตาราง 17 ค่าความยาก (P) และ ค่าอ านาจจ าแนก (B)  และค่าความเชื่อมั่นทั้งฉบับ    
     (R∝) ของแบบวัดผลสัมฤทธิ์ทางการเรียน  โปรแกรมบทเรียน เรื่อง การใช้ 
    ซอฟต์แวร์ openoffice.org นิสิตชั้นปีที่ 1 
 

ข้อที่ (B) (P) ข้อที่ (B) (P) ข้อที่ (B) (P) 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 

0.13 
0.33 
0.27 
0.27 
0.60 
0.27 
0.47 
0.47 
0.40 
0.73 

0.67 
0.70 
0.67 
0.73 
0.57 
0.53 
0.43 
0.63 
0.40 
0.50 

11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

0.40 
0.13 
0.13 
0.33 
0.33 
0.20 
0.60 
0.33 
0.67 
0.47 

0.67 
0.47 
0.67 
0.57 
0.57 
0.50 
0.57 
0.63 
0.53 
0.63 

21 
22 
23 
24 
25 
26 
27 
28 
29 
30 

0.33 
0.13 
0.53 
0.47 
0.53 
0.47 
0.53 
0.47 
0.80 
0.47 

0.63 
0.53 
0.40 
0.63 
0.60 
0.57 
0.60 
0.63 
0.47 
0.57 

 
ค่าความเชื่อม่ัน  (R∝) ทั้งฉบับเท่ากับ 0.868 
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ภาคผนวก ฌ  
ค่าดัชนีความสอดคล้อง (IOC) และ ค่าความเชื่อม่ัน ของแบบวัดความพึงพอใจของนิสิตที่มีต่อ 

โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
openoffice.org  นิสิตชั้นปีที่ 1 
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ตาราง 18 ค่าดัชนีความสอดคล้อง (IOC) และ ค่าความเชื่อม่ัน ของแบบวัดความพึง 
  พอใจของนิสิตที่มีต่อ โปรแกรมบทเรียนออนไลน์ เรื่อง การใช้ซอฟต์แวร์  
  openoffice.org  นิสิตชั้นปีที่ 1 
 

ข้อที่ 
ผลการประเมินผู้เชี่ยวชาญ 

รวม ค่าเฉลี่ย สรุปการประเมิน 
1 2 3 

1 1 1 1 3 1 ใช้ได้ 
2 1 1 1 3 1 ใช้ได้ 
3 1 1 1 3 1 ใช้ได้ 
4 1 0 1 2 0.67 ใช้ได้ 
5 1 0 1 2 0.67 ใช้ได้ 
6 1 1 0 2 0.67 ใช้ได้ 
7 0 1 1 2 0.67 ใช้ได้ 
8 1 1 1 3 1 ใช้ได้ 
9 1 1 1 3 1 ใช้ได้ 
10 1 1 1 3 1 ใช้ได้ 
11 1 1 1 3 1 ใช้ได้ 
12 1 0 1 2 0.67 ใช้ได้ 
13 1 1 0 2 0.67 ใช้ได้ 
14 1 1 1 3 1 ใช้ได้ 
15 1 1 1 3 1 ใช้ได้ 

 
 ค่าความเชื่อม่ันเท่ากับ  0.787 
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แบบวัดความพึงพอใจของผู้เรียนที่มีต่อโปรแกรมบทเรียนออนไลน์  
เรื่อง การใช้ซอฟต์แวร์ openoffice.org  นิสิตชั้นปีที่ 1 

ค าชี้แจง 
 1. แบบวัดความพึงพอใจนี้สร้างขึ้นมาเพ่ือวัดระดับความพึงพอใจของนิสิตที่มีต่อโปรแกรม
บทเรียนออนไลน์ ในด้านความพึงพอใจ   
 2. แบบวัดความพึงพอใจนี้มีทั้งหมด  15 ข้อ  
 3. ให้นิสิตอ่านข้อความแต่ละข้อให้ละเอียดและพิจารณาอย่างรอบคอบแล้วเลือกค าตอบตรง
กับความรู้สึกของนิสิต การตอบแบบวัดความพึงพอใจไม่มีค าตอบที่ถูกหรือผิด เพราะแต่ละคนย่องมี
ความคิดเห็นแตกต่างกันการเลือกตอบในแต่ละข้อจะไม่มีผลต่อคะแนนของนิสิตแต่อย่างใด  
 4. วิธีตอบแบบวัดความพึงพอใจ ให้นักเรียนอ่านข้อความแล้วพิจารณาว่ามีความรู้สึกตรงกับ
ค าถามใดก็ท าเครื่องหมาย / ลงในช่องนั้น 

5  หมายถึงมีความพึงพอใจ อยู่ในระดับมากท่ีสุด 
4  หมายถึงมีความพึงพอใจ อยู่ในระดับมาก 
3  หมายถึงมีความพึงพอใจ อยู่ในระดับปานกลาง 
2  หมายถึงมีความพึงพอใจ อยู่ในระดับน้อย 
1  หมายถึงมีความพึงพอใจ อยู่ในระดับน้อยที่สุด 
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ข้อความ 
ระดับความพึงพอใจ 

มากที่สุด มาก ปานกลาง น้อย น้อยที่สุด 
1. บทเรียนอธิบายรายละเอียดและวัตถุประสงค์     
    อย่างชัดเจน 
2. เนื้อหาและบทเรียนมีความน่าสนใจท าให้  
    เข้าใจได้ง่าย 
3. เนื้อหาและบทเรียนมีความสอดคล้องกับ 
    วัตถุประสงค์ 
4. บทเรียนมีปริมาณของเนื้อหาที่เหมาะสมในแต่ 
    ละบทเรียน 
5. บทเรียนมีความง่ายเหมาะสมกับผู้เรียน 
6. รูปภาพและวิดีโอประกอบสามารถสื่อ 
    ความหมายและมีความ สอดคล้องกับเนื้อหา 
7. การล าดับขั้นตอนในการน าเสนอเนื้อหาของ 
    บทเรียนมีความเหมาะสม 
8. เสียงบรรยายและเนื้อหามีความเหมาะสม   
    ชัดเจน 
9. เวลาที่ใช้ในการเรียนบทเรียน มีความ 
    เหมาะสม 
10. มีการเชื่อมโยงไปยังบทเรียนอ่ืน ๆ ที่ 
    เกี่ยวข้อง และง่ายต่อการท าความเข้าใจ 
11. ผู้เรียนสามารถติดต่อกับผู้สอนทางกระดาน 
    สนทนาเมื่อต้องการข้อมูลเพิ่มเติม 
12. บทเรียนท าให้ผู้เรียนเรียนสนุกสนานน่า 
    ตื่นเต้นไมน่่าเบื่อ 
13. ผู้เรียนสามารถเข้าถึงบทเรียนได้สะดวกและ 
    รวดเร็ว 
14. บทเรียนตรงกับความต้องการและความ 
    สนใจของผู้เรียน 
15. ความรู้จากการเรียนบทเรียนสามารถน าไป 
    ประยุกต์ใช้ให้เกิดประโยชน์ในชีวิตการท างาน 

     

 
ข้อเสนอแนะ / ความคิดเห็นเพ่ิมเติม 
....................................................................................................................................................................
....................................................................................................................................................................
.................................................................................................................................................................... 
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ภาคผนวก ญ  
หนังสือขอความอนุเคราะห์ 
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ประวัติย่อของผู้ศึกษาค้นคว้า 
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สถานที่เกิด     อ าเภอเมืองขอนแก่น  จังหวัดขอนแก่น 
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44000 
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